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Chapter 1

Getting Started

The Galil Communication Library (gclib) is a communication library for Galil motion controllers and PLCs. A number
of programming languages, operating systems, and hardware platforms are supported.

The library consists of a basic set of function calls (gclib.h), and an open-source extension library (gclibo.h). A
number of examples are provided to demonstrate how to use the library with various languages.

The gclib will import virtually anywhere a dll/so/dylib can be imported. See installation for details. Please contact
softwaresupport@galil.com if the language or platform required is not listed.
Contents

* List of all functions

* Installation and supported operating systems
+ Language Support

 Using gclib

Release Notes

See the update history of gclib in the release notes.
Galil maintains an RSS page to notify users of updates.

See the update history of gcaps inthe release notes.

Technical Support

For help please email softwaresupport@galil.com,orcallGalil Applications.


mailto:softwaresupport@galil.com
globals_func.html
http://www.galil.com/sw/pub/all/rn/gclib.html
http://www.galil.com/sw/pub/all/rss/gclib.xml
http://www.galil.com/sw/pub/all/rn/gcaps.html
mailto:softwaresupport@galil.com
http://www.galil.com/contact

Getting Started
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Chapter 2

Installation

gclib is available on the following operating systems.

* Microsoft Windows

10 x64 <>, x86
8.1 x64 <>, x86
8 x64 >, x86
7 x64 >, x86

» Ubuntu Linux

18.04 LTS x64 <)
16.04 LTS x64 < 1
14.04 LTS x64 F
12.04 LTS x64 F

« Fedora Linux

fc28 x64 &
fc27 x64 & T
fc26 x64 & T
fc25 x64 > T
fc24 x64 & T
fc23 x64 < T
fc22 x64 +
fc21 x64

* Red Hat and CentOS

— Red Hat 7 & CentOS 7 Linux

« RHEL 7 x64 $
+ CentOS 7 x64 <>

— Red Hat 6 & CentOS 6 Linux
» RHEL 6 x64
* CentOS 6 x64 F
+ Raspbian, Raspberry Pi

— Stretch, 9.1
— Jessie, 8.0 T



4 Installation

+ Apple OS X

— Yosemite 10.10 x64
— Mavericks 10.9 x64

» Other builds, contact Galil Applications for more info

— Nvidia Jetson TXI1 running Ubuntu 16.04 arm64

{> gcaps available on these operating systems.
1 Although no longer built on these older operating systems, previous versions of gclib are available.

Don't see your OS? Please email softwaresupport@galil.com,orcall Galil Applications.

2.1 Microsoft Windows

Tested versions

See the installation page for supported versions.

Installation
On Windows, gclib is distributed in the following formats.

» An executable installer which will install the library in the proper location to work with the included examples
and documentation. PCl users can optionally install the PCI driver from within this installer.

+ A zip file containing the same set of files as the executable but in a zip archive. PCI users can use the
stand-alone PCI driver installer.

— A stand-alone PCI driver installer for PCl users (DMC-1806, 1800, 1802, 1417).

Note

The PCI driver is compatible with GalilTools but is enhanced for gclib communications.

Download Installer

Recommended. All instructions and examples depend on the installation paths.

Download Zip

For custom deployment or non-default file locations. Downloads are available on the release notes page.

Required third-party DLLs
gclib is built using MSVC 2015 and requires run-time components available in the Microsoft Visual C++
Redistributable Packages for Visual Studio 2015.

The gclib installer will automatically install these prerequisites for both 32 bit (x86) and 64 bit (x64) builds. The
installer allows the user to opt out of this installation, if desired.

If using the zip installation, the binaries must be downloaded and installed manually.
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2.1 Microsoft Windows 5

Silent Installation
For developers wishing to bundle gclib within their own installers, execute the gclib installer with the /S switch to

run silently with defaults. If the Galil security certificate is not already trusted on the deployment target, a digital
signature dialog may be presented.

Uninstall gclib

* Rununinstall.exe in "C:\Program Files (x86)\Galil\gclib"

Installed Files

Installation from the executable installer looks like the following.

C:\Program Files (x86)\Galillgclib>tree /a
Folder PATH listing for volume OS
Volume serial number is AE3F-6836

C:.
+-——d11
| +-—-x64
\ \---x86
+-—-doc
| \---html
\ \---search
+-——examples
| +-——cpp
\ +-—-cs
| | \---2013_12.0
\ | \---gclib_example
| | \--—-gclib_example
| | \-—--Properties
| +-——gcc
| +-—-mingw
\ +-——msvc
| | \---2013_12.0
| | \---gclib_example
| | \---gclib_example
\ \-—-vb
| \---2013_12.0
| \---gclib_example
| \---gclib_example
| \--—-My Project
+--—-include
+-—-1ib
| \--—dynamic
| +-—--x64
\ \---x86
\---source
+---gclibo
\-—-—wrappers
+-—-cs
+---gcl
\-—-vb
dil

The dll directory contains the binary dynamic link libraries (DLLs) for both x86 and x64 architectures. Dynamically
linked executables must have the correct dlls in their path at runtime.

doc

The doc directory contains this documentation and a printable, pdf version.
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6 Installation

examples

The examples directory contains example projects for various compilers. The cpp directory contains x_examples.h
and the implementation of the example files documented in this manual.

Warning

Before using the examples, copy the files to a user location such as C:\Users\user\Documents. Failing to do
so0 may cause source files to be deleted upon gclib uninstallation.

include

The include directory contains header files needed for compiling code. The compiler will need to know where these
files are at compile time.
See the compiler-specific directions for more information, e.g. gclib using MinGW.

lib

The lib directory contains linker files (gclib.lib and gclibo.lib) for both x86 and x64 architectures. The linker should
include gclib.lib and gclibo.lib.

source

The source directory contains source files such as gclibo.c.

2.2 Ubuntu Linux

Tested versions

This version of Linux has x64/AMD64 Support Only. Contact Galil if another version is required for an application.

See the installation page for supported versions.

Installation

Install Galil's public certificate

$ wget http://www.galil.com/sw/pub/ubuntu/$ (lsb_release -r -s)/GALIL-PUB-KEY

# apt-key add GALIL-PUB-KEY

Get Galil's apt sources list

# wget http://www.galil.com/sw/pub/ubuntu/$ (lsb_release -r -s)/galil.list -0 /etc/apt/sources.list.d/galil.lis

# apt-get update

Install Package

Install gclib

# apt-get install gclib
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2.2 Ubuntu Linux 7

Install gcaps on 16.04 and better (optional)

Following Linux's daemon naming conventions, gcaps is called gcapsd on Ubuntu. See the gcaps documentation
for more information.

# apt-get install gcapsd
Verify that the systemd unit is running.

$ systemctl is—-active gcapsd
active

Uninstall Package

If the packages need to be removed from the system, the following commands may be used.

Uninstall gclib

# apt-get remove gclib

Uninstall gcaps

# apt—-get remove gcapsd

Serial Ports and USB

If access to the serial ports or USB (e.g. DMC-4103) is desired through gclib, the following will provide steps to
join the correct access group. If using USB, be sure the controller is powered and the usb is plugged in before
beginning.

Determine group with access

$ 1s -1 /dev/ttyUSB* /dev/ttyS«*

crw-rw—-—--—. 1 root dialout 4, 64 Mar 3 16:39 /dev/ttysoO
crw-rw—-——-—. 1 root dialout 4, 65 Mar 3 16:39 /dev/ttySl
crw-rw—-——-. 1 root dialout 4, 66 Mar 3 16:39 /dev/ttyS2
crw-rw-———. 1 root dialout 4, 67 Mar 3 16:39 /dev/ttyS3
crw-rw-—--. 1 root dialout 188, 0 Mar 6 11:08 /dev/ttyUSBO

In the above listing, dialout is the group that needs to be joined. uucp is another common group that may be listed.

Add the desired username to the group.

$ sudo gpasswd —a username dialout
[sudo] password for username:
Adding user username to group dialout

Log out and back in for change to take effect.

$ groups
username wheel dialout

gclib can now connect to serial and usb devices from user username.

PCI Controllers

If using a Galil PCI controller, the PCI driver must be installed.

gclib 423



8 Installation

Extract source and build driver

$ tar -xf /usr/share/doc/gclib/src/gclib_pci.tar.gz
$ make

Copy module and add to kernel

$ sudo cp galilpci.ko /lib/modules/$ (uname -r)
$ sudo depmod
$ sudo modprobe galilpci

Add galil group for access to PCI

sudo groupadd -f -K GID_MIN=100 -K GID_MAX=499 galil

sudo cp 90-galilpci.rules /etc/udev/rules.d/

sudo udevadm control --reload-rules

sudo udevadm trigger

sudo usermod -a -G galil username #exchange "username" with actual user’s name

Uy A A

Logout and back in. The PCI hardware is now available for access.

$ 1s -1 /dev/galilx

crw-rw-—-- 1 root galil 10, 56 Jun 9 11:07 /dev/galilpciO
$ echo -e "\x12\xlé6\r" > /dev/galilpciO

$ cat /dev/galilpciO

DMC1846 Rev 1l.la

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

 http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline html
The following allows viewing of the html docs from the installation.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz html
$ firefox html/index.html

Offline pdf
There may be a pdf shipped in the package. The following allows viewing of the pdf docs from the installation.
$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz gclib_132.pdf

$ evince gclib.pdf

2.3 Fedora Linux

Tested versions

This version of Linux has x64/AMD64 Support Only. Contact Galil if another version is required for an application.

See the installation page for supported versions.
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2.3 Fedora Linux 9

Installation

On Fedora, gclib and gcaps are distributed in RPM repositories. The following steps can be performed to install.

Download Galil's repository information

Point a browser at http://www.galil.com/sw/pub/fedora/galilrpm-3-1.noarch.rpm and in-
stall the rpm. This installs Galil's RPM repositories and can be done from the terminal with the following.

$ wget http://www.galil.com/sw/pub/fedora/galilrpm-3-1.noarch.rpm
# rpm -Uvh galilrpm-3-1.noarch.rpm

Install Packages

Install gclib
# yum install gclib
Approve "Installed size" and "Importing GPG key", if prompted.

Install gcaps (optional)

Following Linux's daemon naming conventions, gcaps is called gcapsd on Fedora. See the gcaps documentation
for more information.

# yum install gcapsd
Verify that the systemd unit is running.

$ systemctl is-active gcapsd
active

Uninstall Packages

If the packages need to be removed from the system, the following commands may be used.
Uninstall gclib

# yum remove gclib

Uninstall gcaps

# yum remove gcaps

Serial Ports and USB

If access to the serial ports or USB (e.g. DMC-4103) is desired through gclib, the following will provide steps to
join the correct access group. If using USB, be sure the controller is powered and the usb is plugged in before
beginning.

Determine group with access

$ 1s -1 /dev/ttyUSBx /dev/ttySx

crw-rw-——-—. 1 root dialout 4, 64 Mar 3 16:39 /dev/ttySO
crw-rw—-——-. 1 root dialout 4, 65 Mar 3 16:39 /dev/ttySl
crw-rw-——-—. 1 root dialout 4, 66 Mar 3 16:39 /dev/ttyS2
crw—-rw————. 1 root dialout 4, 67 Mar 3 16:39 /dev/ttyS3
crw-rw-—-—. 1 root dialout 188, 0 Mar 6 11:08 /dev/ttyUSBO

In the above listing, dialout is the group that needs to be joined. uucp is another common group that may be listed.
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Add the desired username to the group.

$ sudo gpasswd —a username dialout
[sudo] password for username:
Adding user username to group dialout

Log out and back in for change to take effect.

$ groups
username wheel dialout

gclib can now connect to serial and usb devices from user username.

PCI Controllers

If using a Galil PCI controller, the PCI driver must be installed.

Install prerequisites

$ sudo yum install kernel-devel-$ (uname -r)
$ sudo yum install kernel-headers-$ (uname -r)
$ sudo yum install gcc

Extract source and build driver

$ tar -xf /usr/share/doc/gclib/src/gclib_pci.tar.gz
$ make

Copy module and add to kernel

$ sudo cp galilpci.ko /lib/modules/$ (uname -r)
$ sudo depmod
$ sudo modprobe galilpci

Add galil group for access to PCI

sudo groupadd —-f -K GID_MIN=100 -K GID_MAX=499 galil

sudo cp 90-galilpci.rules /etc/udev/rules.d/

sudo udevadm control --reload-rules

sudo udevadm trigger

sudo usermod -a -G galil username #exchange "username" with actual user’s name

U A

Logout and back in. The PCI hardware is now available for access.

$ 1s -1 /dev/galil«

crw-rw----— 1 root galil 10, 56 Jun 9 11:07 /dev/galilpciO
$ echo -e "\x12\x1l6\r" > /dev/galilpciO

$ cat /dev/galilpciO

DMC1846 Rev 1l.la

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

e http://www.galil.com/sw/pub/all/doc/gclib/html/
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2.4 Red Hat 7 & CentOS 7 Linux 11

Offline pdf
The following allows viewing of the pdf docs from the installation.

$ tar —-xzf /usr/share/doc/gclib/gclib_doc.tar.gz gclib.pdf
$ evince gclib.pdf

Offline html
The following allows viewing of the html docs from the installation.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz html
$ firefox html/index.html

2.4 Red Hat 7 & CentOS 7 Linux

Tested versions

This version of Linux has x64/AMD64 Support Only. Contact Galil if another version is required for an application.

See the installation page for supported versions.

Installation

On Red Hat, gclib and gcaps are distributed in RPM repositories. The following steps can be performed to install.

Download Galil's repository information

Point a browser at http://www.galil.com/sw/pub/rhel/7/galilrpm-4-1.noarch.rpm and in-
stall the rpm. This installs Galil's RPM repositories and can be done from the terminal with the following.

$ wget http://www.galil.com/sw/pub/rhel/7/galilrpm-4-1.noarch.rpm
# rpm -Uvh galilrpm-4-1.noarch.rpm

Install Packages

Install gclib
# yum install gclib
Approve "Installed size" and "Importing GPG key", if prompted.

Install gcaps (optional)

Following Linux's daemon naming conventions, gcaps is called gcapsd on Red Hat. See the gcaps documentation
for more information.

# yum install gcapsd
Verify that the systemd unit is running.

$ systemctl is-active gcapsd
active

Uninstall Packages

If the packages need to be removed from the system, the following commands may be used.
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Installation

Uninstall gclib

# yum remove gclib

Uninstall gcaps

# yum remove gcaps

Serial Ports and USB

If access to the serial ports or USB (e.g. DMC-4103) is desired through gclib, the following will provide steps to
join the correct access group. If using USB, be sure the controller is powered and the usb is plugged in before

beginning.

Determine group with access

$ 1s -1 /dev/ttyUSB* /dev/ttyS«*

crw-rw—-—-—. 1 root dialout 4, 64 Mar 3 16:39 /dev/ttyS0
crw-rw-———. 1 root dialout 4, 65 Mar 3 16:39 /dev/ttySl
crw-rw———-. 1 root dialout 4, 66 Mar 3 16:39 /dev/ttyS2
crw-rw-——-. 1 root dialout 4, 67 Mar 3 16:39 /dev/ttyS3
crw-rw-—--. 1 root dialout 188, 0 Mar 6 11:08 /dev/ttyUSBO

In the above listing, dialout is the group that needs to be joined. uucp is another common group that may be listed.

Add the desired username to the group.

$ sudo gpasswd —a username dialout
[sudo] password for username:
Adding user username to group dialout

Log out and back in for change to take effect.

$ groups
username wheel dialout

gclib can now connect to serial and usb devices from user username.

PCI Controllers

If using a Galil PCI controller, the PCI driver must be installed.

Install prerequisites

# yum update kernel

Reboot

# yum install kernel-devel-$ (uname -r)
# yum install kernel-headers-$ (uname -r)
# yum install gcc

Extract source and build driver

$ tar -xf /usr/share/doc/gclib/src/gclib_pci.tar.gz
$ make
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2.5 Red Hat 6 & CentOS 6 Linux 13

Copy module and add to kernel

# cp galilpci.ko /lib/modules/$ (uname -r)
# depmod
# modprobe galilpci

Add galil group for access to PCI

groupadd -f -K GID_MIN=100 -K GID_MAX=499 galil

cp 90-galilpci.rules /etc/udev/rules.d/

udevadm control --reload-rules

udevadm trigger

usermod -a -G galil username #exchange "username" with actual user’s name

HH= H H

Logout and back in. The PCI hardware is now available for access.

$ 1s -1 /dev/galilx

crw-rw-——- 1 root galil 10, 56 Jun 9 11:07 /dev/galilpciO
$ echo -e "\x12\x1l6\r" > /dev/galilpciO

$ cat /dev/galilpciO

DMC1846 Rev 1l.la

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

* http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline html
The following allows viewing of the html docs from the installation.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz html
$ firefox html/index.html

Offline pdf
There may be a pdf shipped in the package. The following allows viewing of the pdf docs from the installation.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz gclib_132.pdf
$ evince gclib.pdf

2.5 Red Hat 6 & CentOS 6 Linux

Tested versions

This version of Linux has x64/AMD64 Support Only. Contact Galil if another version is required for an application.

See the installation page for supported versions.

Installation

On Red Hat, gclib is distributed in an RPM repository. The following steps can be performed to install gclib.
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Download Galil's repository information

This step installs Galil's RPM repositories and only needs to be done once.

Point a browser at http://www.galil.com/sw/pub/rhel/6/galilrpm-2-1.noarch.rpm and in-
stall the rpm.

Install Package
Install gclib package, approve "Installed size" and "Importing GPG key", if prompted.

# yum install gclib

Uninstall Package
To uninstall gclib.

# yum remove gclib

Serial Ports and USB

If access to the serial ports or USB (e.g. DMC-4103) is desired through gclib, the following will provide steps to
join the correct access group. If using USB, be sure the controller is powered and the usb is plugged in before
beginning.

Determine group with access

$ 1s -1 /dev/ttyUSBx /dev/ttySx

crw—-rw————. 1 root dialout 4, 64 Mar 3 16:39 /dev/ttyS0
crw-rw———-. 1 root dialout 4, 65 Mar 3 16:39 /dev/ttySl
crw-rw—-—-—. 1 root dialout 4, 66 Mar 3 16:39 /dev/ttyS2
crw-rw-—---—. 1 root dialout 4, 67 Mar 3 16:39 /dev/ttyS3
crw-rw-———-—. 1 root dialout 188, 0 Mar 6 11:08 /dev/ttyUSBO

In the above listing, dialout is the group that needs to be joined. uucp is another common group that may be listed.

Add the desired username to the group.

$ sudo gpasswd —a username dialout
[sudo] password for username:
Adding user username to group dialout

Log out and back in for change to take effect.

$ groups
username wheel dialout

gclib can now connect to serial and usb devices from user username.

PCI Controllers

If using a Galil PCI controller, the PCI driver must be installed.

Install prerequisites

# yum update kernel
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Reboot

# yum install kernel-devel-$ (uname -r)
# yum install kernel-headers-$ (uname -r)
# yum install gcc

Extract source and build driver

$ tar -xf /usr/share/doc/gclib/src/gclib_pci.tar.gz
$ make

Copy module and add to kernel

# cp galilpci.ko /lib/modules/$ (uname -r)
# depmod
# modprobe galilpci

Add galil group for access to PCI

groupadd -f -K GID_MIN=100 -K GID_MAX=499 galil

cp 90-galilpci.rules /etc/udev/rules.d/

udevadm control --reload-rules

udevadm trigger

usermod -a -G galil username #exchange "username" with actual user’s name

H H H I

Logout and back in. The PCI hardware is now available for access.

$ 1s -1 /dev/galilx

crw-rw-——- 1 root galil 10, 56 Jun 9 11:07 /dev/galilpciO
$ echo -e "\x12\x16\r" > /dev/galilpciO

$ cat /dev/galilpciO

DMC1846 Rev 1l.la

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

* http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline html

The following allows viewing of the html docs from the installation.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz html
$ firefox html/index.html

Offline pdf

There may be a pdf shipped in the package. The following allows viewing of the pdf docs from the installation.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz gclib_132.pdf
$ evince gclib.pdf
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2.6 Raspberry Pi

Tested versions

» Raspberry Pi 3 Model B

* Hardware Raspberry Pi 2 Model B

See the installation page for supported versions.

Installation

Create a temporary variable for Raspbian version

uver=$ (1lsb_release -r | cut -f 2); echo $Suver
8.0

Install Galil's public certificate

$ wget http://www.galil.com/sw/pub/raspbian/$uver/GALIL-PUB-KEY
$ sudo apt-key add GALIL-PUB-KEY

Get Galil's apt sources list

Ssudo wget http://www.galil.com/sw/pub/raspbian/S$uver/galil.list -O /etc/apt/sources.list.d/galil.list
$sudo apt-get update

Install Package

$sudo apt-get install gclib

Uninstall Package
To uninstall gclib.

$sudo apt-get remove gclib

Serial Ports and USB

If access to the serial ports or USB (e.g. DMC-4103) is desired through gclib, the following will provide steps to
join the correct access group. If using USB, be sure the controller is powered and the usb is plugged in before
beginning.

Determine group with access

$ 1s -1 /dev/ttyUSB* /dev/ttyS*

crw-rw-——-—. 1 root dialout 4, 64 Mar 3 16:39 /dev/ttySO
crw-rw—-——-. 1 root dialout 4, 65 Mar 3 16:39 /dev/ttySl
crw-rw-——-—. 1 root dialout 4, 66 Mar 3 16:39 /dev/ttyS2
crw—-rw————. 1 root dialout 4, 67 Mar 3 16:39 /dev/ttyS3
crw-rw-———-—. 1 root dialout 188, 0 Mar 6 11:08 /dev/ttyUSBO

In the above listing, dialout is the group that needs to be joined. uucp is another common group that may be listed.
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Check the user's group

The default pi username is already a member of dialout.

$ groups
pi adm dialout cdrom sudo audio video plugdev games users input netdev gpio i2c spi

If needed, add the desired username to the group.

$ sudo gpasswd —a username dialout
[sudo] password for username:
Adding user username to group dialout

Log out and back in for change to take effect.

$ groups
username wheel dialout

gclib can now connect to serial and usb devices from user username.

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

* http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline html
The following allows viewing of the html docs from the installation, in the GUI mode.

$ tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz html
$ epiphany html/index.html

Offline pdf
There may be a pdf shipped in the package. The following allows viewing of the pdf docs from the installation.

sudo apt-get update

sudo apt-get install evince

tar -xzf /usr/share/doc/gclib/gclib_doc.tar.gz gclib_132.pdf
evince gclib.pdf

v U

2.7 Apple OS X

Tested versions

See the installation page for supported versions.

Installation

On OS X, gclib is distributed in a dmg image. The following steps can be performed to install gclib.
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Download the gclib dmg

» Open the dmg file and drag the gclib directory to the Applications alias or another installation location.

Create Environment Variable (Optional)

» To provide maximum functionality, e.g. usage of the Python wrapper, add to the DYLD_LIBRARY_PATH by
typing the following at a Terminal prompt.

$ echo "export DYLD_LIBRARY_ PATH=/Applications/gclib/dylib/:\$DYLD_LIBRARY_PATH" >> ~/.profile

» Log Out and back in to set the environment variable.

Make links for usb devices

If using the DMC4103 or another Galil USB product, symbolic links may be created so GAddresses() can list the
controllers.

Make a link from the Terminal.

user-mac:~ user$ #plug in DMC4103 usb cable

user-mac:~ user$ ls /dev/tty.usb=*

/dev/tty.usbserial-A402L6KG

user-mac:~ user$ #make a symbolic link so gclib can list it

user-mac:~ user$ sudo ln -s /dev/tty.usbserial-A402L6KG /dev/tty.usbseriall
user-mac:~ user$ #gclib searches start at 0

user-mac:~ user$ #GAddresses () will now list this device

Demonstrating with Python.

user-mac:~ user$ python

Python 2.7.10 (default, Jul 14 2015, 19:46:27)

[GCC 4.2.1 Compatible Apple LLVM 6.0 (clang-600.0.39)] on darwin
Type "help", "copyright", "credits" or "license" for more information.
>>> import gclib

>>> g = gclib.py ()

>>> g.GAddresses ()

{"/dev/tty.usbseriall’: '’}

>>> g.GOpen ("/dev/tty.usbseriall -d")

>>> print (g.GInfo())

/dev/tty.usbserialO, DMC4143 Rev 1.2b, 9998

>>> g.GClose ()

>>> exit ()
user-mac:~ users$
Installed files

» The gclib shared object files
— /Applications/gclib/dylib/gclib.0.dylib
— /Applications/gclib/dylib/gclibo.0.dylib
» The gclib header files
— /Applications/gclib/include/gclib_errors.h

— /Applications/gclib/include/gclibo.h
— /Applications/gclib/include/gclib.h
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— /Applications/gclib/include/gclib_record.h
« gclib documentation tarball
— /Applications/gclib/doc/gclib_doc.tar.gz
» Example source tarball
— /Applications/gclib/examples/gclib_examples.tar.gz
+ Source files to modify/rebuild libgclibo.so
— /Applications/gclib/source/gclibo_229_src.tar.gz
+ GalilTools Communication Library (gcl) wrapper

— /Applications/gclib/source/gclib_gcl.tar.gz

Documentation

The documentation is left as a tarball to minimize disk usage. The latest release version of the user manual is
available at the following link.

* http://www.galil.com/sw/pub/all/doc/gclib/html/

Offline pdf

The following allows viewing of the pdf docs from the installation.

» Browse in the Finder to Applications/gclib/doc.

Double-click the tar.gz file to extact it.
+ Open the resultant directory.

* Open the pdf.

Offline html

The following allows viewing of the html docs from the installation.

» Browse in the Finder to Applications/gclib/doc.
» Double-click the tar.gz file to extact it.

+ Open the resultant directory.

+ Open the html directory.

» Double-click index.html to open the help.
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Chapter 3

Language Support

Below are a number of examples demonstrating how to use the library with various languages and on various
platforms.

* C/C++
+ Python
* Net

« Java

Can't find what you need? Please email softwaresupport@galil.com,orcall Galil Applications.

3.1 C/C++

» Microsoft Visual Studio 2015 (14.0)
» Microsoft Visual Studio 2013 (12.0)
* MinGW

+ Borland C++

* gcc (Linux)

+ clang (OS X)

3.1.1 Microsoft Visual Studio 2015 (14.0)

For brevity, these instructions assume the default installation location of C:\Program Files (x86)\Galil\gclib.

x_simple.c from VS2015 x64 Native Tools Command Prompt

Open V52015 x64 Native Tools Command Prompt.

Copy files

Navigate to a convenient, empty, writable location.


mailto:softwaresupport@galil.com
http://www.galil.com/contact
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Set an environment variable for the base path.

>set base=C:\Program Files (x86)\Galil\gclib

Copy simple example

>copy "%base%\examples\cpp\x_simple.c" .

Edit GOpen() call as necessary

In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hardware.
See the documentation for GOpen() for address formatting options.

Compile

>cl x_simple.c "%$base%\lib\dynamic\x64\x.1lib" -I "%base%\include"

Set Path to DLL

>set PATH=%base%\d1l1\x64\; $PATHS

Execute

>x_simple.exe

version: 211.211.211 1.0.0.128

info: 192.168.0.42, DMCC640 Rev 1.0g, 9999
response: 3757802.0000

Using the pre-configured MSVC project (x_examples.cpp)

The directory gcliblexamples\msvc has fully functional MSVC examples. These instructions detail how to use the
2013 version.

» Copy gcliblexamples\msvc\2015_14.0\gclib_example to a convenient, writable location.

» Run gclib_example\gclib_example\copy _source.bat to copy the files.

» Open gclib_example\gclib_example.sin in Visual Studio 2015.

* In the Solution Explorer, expand the gclib_example and expand Source Files to show a listing of source.
» Open x_examples.cpp.

» Find the GOpen() call and update the address to match the desired hardware. See the documentation for
GOpen() for address formatting options.

» Find the #1f 0 preprocessor block enclosing the example calls. Change to #1f 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions

are compatible with all Galil products.

+ Hit F5to build and run the example.
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Create Project with MSVC 2015 (x_examples.cpp)

The instructions below allow building a project from scratch.

The following instructions were performed on Visual Studio Professional 2015 and can be extended to other Vi-
sual Studio versions. For brevity, the instructions assume the default installation location of C:\Program Files
(x86)\Galil\gclib and a build type of x64.

 Launch Visual Studio 2015.

» Choose File->New->Project.

* In the New Project dialog, choose Visual C++->Empty Project.

» Choose a Name, e.g. gclib_example.

+ Choose a Location, e.g. C:\Users\user\Desktop.

» Check Create directory for solution.

« Click OK.

* In the Solution Explorer, right-click on Source Files and choose Add->Existing Item.

— Navigate to the gclib installation directory, then to examples\cpp in the installation directory.
— In File Name type x_x.cpp and click Add, this will filter out the files needed

— Select all files in the file chooser and click Add.
* In the Solution Explorer right-click on gclib_example, choose Properties.

— Click the Configuration Manager... button.

= Under Active solution platform: choose x64.
= Click Close.
— Highlight Configuration Properties in the side bar, and set the following project properties.
= At the top of the window, change Configuration: to All Configurations and ensure Platform lists
Active(x64).

= Configuration Properties -> C/C++ -> Additional Include Directories add C:\Program Files
(x86)\Galil\gclib\include

= Configuration Properties -> Linker -> General -> Additional Library Directories add C:\Program
Files (x86)\Galil\gclib\lib\dynamic\x64

= Configuration Properties -> Linker -> Input -> Additional Dependencies add gclib.lib;gclibo.«
lib;{rest of text} where {rest of text} isthe original string that was in the cell. Note
the semicolons between library files.

= Configuration Properties -> Debugging -> Environment add PATH=C:\Program Files
(x86)\Galil\gclib\dII\x86;%PATH%

= Click OK.

* In the Solution Explorer open x_examples.cpp. Find the GOpen() call and update the address to match the
desired hardware. See the documentation for GOpen() for address formatting options.

» Find the #1f 0 preprocessor blocks enclosing the example calls. Change to #1f 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

+ Hit F5to build and run the example.

3.1.2 Microsoft Visual Studio 2013 (12.0)

For brevity, these instructions assume the default installation location of C:\Program Files (x86)\Galil\gclib.
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x_simple.c from VS2013 x64 Native Tools Command Prompt

Open VS§2013 x64 Native Tools Command Prompt.

Copy files

Navigate to a convenient, empty, writable location, e.g. C:\temp.

Set an environment variable for the base path.

C:\temp>set base=C:\Program Files (x86)\Galil\gclib

Copy simple example

C:\temp>copy "%$base%\examples\cpp\x_simple.c" .

Edit GOpen() call as necessary

In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hardware.

See the documentation for GOpen() for address formatting options.

Compile

C:\temp>cl x_simple.c "%base%\lib\dynamic\x64\*.1ib" —-I "%base%\include"

Set Path to DLL

C:\temp>set PATH=%base%\d11\x64\; $PATH%

Execute

C:\temp>x_simple.exe

rc: O

version: 85.60.138

rc: O

rc: O

info: 10.1.3.17, DMC4020 Rev 1.2b, 291
rc: O

response: 357247808.0000

Using the pre-configured MSVC project (x_examples.cpp)

The directory gcliblexamples\msvc has fully functional MSVC examples. These instructions detail how to use the

2013 version.

» Copy gcliblexamples\msvc\2013_12.0\gclib_example to a convenient, writable location, e.g. C:\temp.

* Run gclib_example\gclib_example\copy source.bat to copy the files.

» Open gclib_example\gclib_example.sin in Visual Studio 2013.

+ In the Solution Explorer, expand the gclib_example and expand Source Files to show a listing of source.

» Open x_examples.cpp

+ Find the GOpen() call and update the address to match the desired hardware. See the documentation for

GOpen() for address formatting options.
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Find the #1f 0O preprocessor block enclosing the example calls. Change to #1f 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

Hit F5 to build and run the example.

Create Project with MSVC 2013 (x_examples.cpp)

The instructions below allow building a project from scratch.

The following instructions were performed on Visual Studio Professional 2013 and can be extended to other Vi-
sual Studio versions. For brevity, the instructions assume the default installation location of C:\Program Files
(x86)\Galil\gclib and a build type of x86 (win32).

Launch Visual Studio 2013

Choose File->New->Project

In the New Project dialog, choose Visual C++->Empty Project

Choose a Name, e.g. gclib_example

Choose a Location, e.g. C:\Users\user\Desktop

Check Create directory for solution

Click OK

In the Solution Explorer, right-click on Source Files and choose Add-> Existing ltem

— Navigate to the gclib installation directory, then to examples\cpp in the installation directory
— In File Name type x_x.cpp and click Add, this will filter out the files needed
— Select all files in the file chooser and click Add

In the Solution Explorer right-click on gclib_example, choose Properties, highlight Configuration Properties,
and set the following project properties

— At the top of the window, change Configuration: to All Configurations and ensure Platform lists Active(«
Win32)

— Configuration Properties -> C/C++ -> Additional Include Directories add C:\Program Files
(x86)\Galil\gclib\include

— Configuration Properties -> Linker -> General -> Additional Library Directories add C:\Program Files
(x86)\Galil\gclib\lib\dynamic\x86

— Configuration Properties -> Linker -> Input -> Additional Dependencies add gclib.lib;gclibo.«
lib;{rest of text} where {rest of text} is the original string that was in the cell. Note
the semicolons between library files.

— Configuration Properties -> Debugging -> Environment add PATH=C:\Program Files (x86)\Galil\gclib\dIl\x86;%P«
ATH%

In the Solution Explorer open x_examples.cop. Find the GOpen() call and update the address to match the
desired hardware. See the documentation for GOpen() for address formatting options.

Find the #1f 0 preprocessor block enclosing the example calls. Change to #1f 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

Hit F5 to build and run the example.
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3.1.3 MinGW

The following instructions were performed with x86 Minimalist GNU for Windows (MinGW) installed from http«
://mingw-w64.sourceforge.net/download.php#mingw-builds

For brevity, these instructions assume the default installation location of "C:\Program Files (x86)\Galil\gclib".

Copy Files

Copy "gclib\examples\mingw" to a convenient, writable location, e.g. "C:\temp". Run C: \temp\mingw\copy+
_source.bat to copy all files.

x_simple.c

Edit GOpen() call as necessary

In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hardware.
See the documentation for GOpen() for address formatting options.

Compile

+ Launch the MinGW terminal, e.g. Start -> All Programs -> MinGW-W64 project -> i686-4.9.1-posix-dwarf-
rt_v3-rev3 -> Run Terminal.

» Navigate to the directory with the files above.

» Compile the code.

C:\temp\mingw\>gcc x_simple.c -L. -lgclibo -lgclib -o simple.exe

Execute

C:\temp\mingw>simple.exe

rc: O

version: 85.60.138

rc: O

rc: O

info: 10.1.3.17, DMC4020 Rev 1.2b, 291
rc: O

response: 1584328.0000

x_examples.cpp

Review and Modify source

* In a text editor, open x_examples.cpp. Find the GOpen() call and update the address to match the desired
hardware. See the documentation for GOpen() for address formatting options.

» Find the #if O preprocessor block enclosing the example calls. Change to #if 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

gclib 423


http://mingw-w64.sourceforge.net/download.php#mingw-builds
http://mingw-w64.sourceforge.net/download.php#mingw-builds

3.1 C/C++ 27

Compile

* Launch the MinGW terminal, e.g. Start -> All Programs -> MinGW-W&64 project -> i686-4.9.1-posix-dwarf-
rt v3-rev3 -> Run Terminal.

» Navigate to the directory with the files above.

» Compile the code.

C:\temp\mingw>g++ *.cpp -L. —-lgclibo -lgclib -o examples.exe

Execute

C:\temp\mingw>examples.exe
Library version: 41.35.34

192.168.0.43, DMC4020 Rev 1.2b, 291

B R R e S R R R

Example GRead() and GWrite() usage

B R R S R R

Read 155 QR bytes.

AR EEE SRS S S S S ESEE RS EEE SR SRR REEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S
Example GCommand () usage

KA KKK KRR R A A A A A A A A A A A A A A A A A A A A AR AR AR A A A A A A A A A A A A A A A A A AR A AR AR AR A A Ak hh kK%
Revision report, "R"V

DMC4020 Rev 1.2b

Command Values
val is 10

val is 11

val is 3.1415
val is 9.869

Command Trimming
> 95653016.0000
1<

> 95653016.0000<
>95653016.0000<

Receiving Binary Data
QR read 155 bytes

Error handling
QD correctly trapped, not allowed, try GArrayDownload ()
DL correctly trapped, not allowed, try GProgramDownload ()

Modifying timeout
Burning program...OK

R R I R R I I Rk R Rk 2 I I S S S
Example GProgramDownload() and GProgramUpload() usage

Ak khkhhkhhkhk kA hhhhhhhhkhhkhhhkhhbhrhhkh b hhhkh bk hkhhkhhhkh bk hk bk hk kA h bk hkhkhkdhhkhkhk bk hkhkr kA dhkhhx*k
GProgrambDownload () correctly errored. Can’t fit with level 3 compression
Program Downloaded with compression level 4

Uploading program:
#A;1=0;1i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;1
i=i+1l;i=i+1;i=i+1;1i=1i4+1;1i=i+1;i=i+1;i=i+1;i=1i+1;EN

Program executed as expected

AR EEE SRS S E S SESEREEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEREEEEEEEEEEEEEE S
Example GArrayDownload() and GArrayUpload() usage

R R R R R R I R R b b I b b S
2.0000, 4.0000, 6.0000, 8.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.000
0000
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2.0000, 1.0000, 3.0000, 5.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.000
0000

3.0000, 5.0000, 10.0000

B R R R R R e R R

Example GRecord() usage

B R R T S R R R

QR-based data record
38564
393216000

DR-based data record
38670
38772
38874
38976
39078
39180
39282
39384
39486
39588
39690

OR-based data record with offsets
39692
39692

Ak hkkhkhkhkhkhk kA hhhhhhh bk hhkhkh bk kb hrhh b h bk hhk kA bbbk h bk hk Ak hk kA h bk hk Ak bk dhhkhk bk hkhkhkhkrkhk Ak hkhkkhx*k

Example GMessage () usage

Fhhkhkhkhkhkhkhkhkhkhkhkhhkhhkhk bk bk bk bk bk dAr b b rrrhkhkhkhkhkhkhkhkhkhkhhhkhkhkhkhkhk kA bk kA Ak rrhkhkhkhkhkhkhhhhkhkhkk*k
0.0000

1.0000

.0000

.0000

.0000

.0000

.0000

.0000

.0000

.0000

W 00 ~J oy U W N

B R R R R R kR R R R

Example GInterrupt () usage
Ak hkkhkhkhkhkhkkhkhkhkhhhhhhkh bk hhkhh bk kb hhhkh b hkhk bk hhkhkh bk hhhkhhkhk bk hk kA h b hk Ak bk hhkhkhkhkhkhkhkhkhkhk Ak hkhkhkhx*k

"UI 8" executed.

R i R R R R Rk R Rk i I S S S
Example GMotionComplete () usage

kA hkhkhhkhkhkkhk kA hhhhhAhhkdAhhhkhhAhhhrhkh b h kA bk hkhhkhhhkh bk hk bk hk kA h bk dkhhkdhrkhkhkhkhkhkhkhkrhkhdhkrhx*k
Position: 0, O

Beginning independent motion... Motion Complete on A

Position: 8000, O

Position: 0, O

Beginning vector motion... Motion Complete on vector plane S
Position: 6000, O

examples.cpp executed OK
main() is finished. Press Enter to exit:

3.1.4 Borland C++

The following instructions were performed on:

Embarcadero C++ 7.10 for Win32 Copyright (c) 1993-2015 Embarcadero Technologies, Inc.
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For brevity, these instructions assume the default installation location of "C:\Program Files (x86)\Galil\gclib".

Copy Files

Copy "gclib\examples\borland” to a convenient, writable location, e.g. "C:\temp”". Run C: \temp\borland\copy+«
_source.bat to copy all files.

C:\temp>cd borland

C:\temp\borland>copy_source.bat
\Program Files (x86)\Galil\gclib\examples\cpp\x_arrays.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_examples.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_examples.h
\Program Files (x86)\Galil\gclib\examples\cpp\x_gcommand.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_ginterrupt.cpp
\Program Files (x86)\Galill\gclib\examples\cpp\x_gmessage.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_gmotioncomplete.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_gread_gwrite.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_grecord.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_nonblocking.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_programs.cpp
\Program Files (x86)\Galil\gclib\examples\cpp\x_simple.c

12 file(s) copied.
\Program Files (x86)\Galil\gclib\include\gclib.h
\Program Files (x86)\Galil\gclib\include\gclibo.h
\Program Files (x86)\Galil\gclib\include\gclib_errors.h
\Program Files (x86)\Galil\gclib\include\gclib_record.h

4 file(s) copied.
\Program Files (x86)\Galil\gclib\lib\dynamic\x86\gclib.lib
\Program Files (x86)\Galillgclib\lib\dynamic\x86\gclibo.lib

2 file(s) copied.
\Program Files (x86)\Galil\gclib\dl1\x86\gclib.dll
\Program Files (x86)\Galil\gclib\d1l1l\x86\gclibo.dll

2 file(s) copied.

C:\temp\borland>

Modify Path

» Add Borland's compiler to the PATH variable.

C:\temp\borland>set PATH=c:\Program Files (x86)\Embarcadero\Studio\17.0\bin;%$PATH%

Convert lib files

C:\temp\borland>move gclib.lib _gclib.lib
1 file(s) moved.

C:\temp\borland>move gclibo.lib _gclibo.lib
1 file(s) moved.

C:\temp\borland>coff2omf.exe _gclib.lib gclib.lib
COFF to OMF Converter Version 1.2.0 Copyright (c) 1999-2009 Embarcadero Technologies, Inc.
All rights reserved.

C:\temp\borland>coff2omf.exe _gclibo.lib gclibo.lib

COFF to OMF Converter Version 1.2.0 Copyright (c) 1999-2009 Embarcadero Technologies, Inc.
All rights reserved.

x_simple.c
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Edit GOpen() call as necessary

In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hardware.
See the documentation for GOpen() for address formatting options.

Compile

C:\temp\borland>bcc32 gclib.lib gclibo.lib x_simple.c

Embarcadero C++ 7.10 for Win32 Copyright (c) 1993-2015 Embarcadero Technologies, Inc.
X_simple.c:

Turbo Incremental Link 6.72 Copyright (c) 1997-2015 Embarcadero Technologies, Inc.

Execute

C:\temp\borland>x_simple.exe

version: 130.115.279

info: 192.168.0.43, DMC4143 Rev 1.2b, 9998
response: 61016.0000

x_examples.cpp
Review and Modify source

* In a text editor, open x_examples.cpp. Find the GOpen() call and update the address to match the desired
hardware. See the documentation for GOpen() for address formatting options.

» Find the #1f 0 preprocessor block enclosing the example calls. Change to #if 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

Compile

C:\temp\borland>bcc32 -c *.cpp

Link

C:\temp\borland>bcc32 -o examples.exe *.0bj gclib.lib gclibo.lib

Execute

C:\temp\borland>examples.exe
Library version: 130.115.279

192.168.0.43, DMC4020 Rev 1.2b, 291

EEEEEEEEEEEEE SRR R R R R R R R R R R EEEEEEEEEEEEEEE R R R EEEEEEEEEEEEEEEEEEEE SIS
Example GRead() and GWrite () usage

Ak hkhkhkhkhkhkhkhhkhhhhhhkhkhkhkhkhkhhkhkrhhhkhhhkhkhkhk bk hkhhhkhhkhkhkhkhkhkhkhkhkhdkhkhdhrhkhkhkhkhkhkhkrkhkhhhxkx*x
Read 155 QR bytes.

Ak hkhhkhkhkhkhhhhhhhhhkdAhhhhhkhrhdhhkh b hhkhkh bk hkhhAhhhh bk hk bk hk kA hhhkh bk hrhkhkhkhkhkhkhkrhkhdhkhkhx*k
Example GCommand () usage
khkhkkhkhkhkhkhkhkhkhkhhhhhhhhkhhkhh bk kb hhhkhhh kb kb hk Ak bk dh b bk hhkhkhkhk kb h bk hkhhdhhkhkhk bk hkhkhkhkrkhkhkdhkhhx*k
Revision report, "R"V

DMC4020 Rev 1.2b
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Command Values
val is 10

val is 11

val is 3.1415
val is 9.869

Command Trimming
> 95653016.0000
1<

> 95653016.0000<
>95653016.0000<

Receiving Binary Data
OR read 155 bytes

Error handling
QD correctly trapped, not allowed, try GArrayDownload()
DL correctly trapped, not allowed, try GProgramDownload()

Modifying timeout
Burning program...OK

EEEEEEEEEEEEE SRR R R R R R R R R R EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE SIS
Example GProgramDownload() and GProgramUpload() usage

R R R R R R R I R R R R Rk b b b I 2 b S S
GProgramDownload () correctly errored. Can’t fit with level 3 compression
Program Downloaded with compression level 4

Uploading program:
#A;1=0;i=i4+1;i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=1i+1;i=1i+1;1i
i=i+1;i=i+1;i=i+1;i=1i+1;i=1i+1;i=1i+1;i=i+1;1i=1i+1;EN

Program executed as expected

KAk hkhhkhkhhkhhkhhhkhhkhh bk hhkhkhhkhkrhkh kA hkhkhhkhk bk hk bk hkhkrkhkhhkhkhkhkhhkhkhhkhkrdhrhkhhrhkhkhkhkrkhkhhhxk*x*
Example GArrayDownload() and GArrayUpload() usage
Frhhkkhkhkhkhkhkhkhkhkhkhhhhkhkhk bk bk bk bk hAhrrrrrrkhkhkhkhkhkhkhkhkhkhkhhhkhkhk bk bk bk bk bk bk kA rrrrhkhkhkhkhkhkhkhkhhkhkk*k
2.0000, 4.0000, 6.0000, 8.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.000
0000

2.0000, 1.0000, 3.0000, 5.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.000
0000

3.0000, 5.0000, 10.0000

Khhkkhkhkhkhkhkhkhkhhkhhhhkhkhk bk bk kA A A A rrrrrhkhkhkhkhkhkhkhkhhkhhhkhkhkhkhkhkhk kA kA A v rrkhkhkhkhkhkhkhhhkhkkhkkx*k

Example GRecord() usage

EEEEEEEEEEEE S SRR R R R R R R R R EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S

QOR-based data record
38564
393216000

DR-based data record
38670
38772
38874
38976
39078
39180
39282
39384
39486
39588
39690

QR-based data record with offsets
39692
39692

EEEEEEE S S EEEEEE R EEEE R EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE SIS
Example GMessage () usage
R R R R R I R R Rk b b b i 2 b S S
0.0000
1.0000
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.0000
.0000
.0000
.0000
.0000
.0000
.0000
.0000

O O J o U b W

kA hkhkhhkhkhkhkhhkhhhkhhkhhhkhhkhhhkhkrhhhkhhkhhhkhhkhk bk bk rhkh bk hkhhkhhkhkhhkhkrdrkhkhhkhkhkhkhkrkhkhhkhxk*x*x
Example GInterrupt () usage
Ak hkhkhkhkhkhhkhhkhhhkhhkhkhhkhhkhkhhkhkrdhhhkhhhkhhkhkh kb bk hkrhkhhkhkhkhkhkhkhkhhkhkrhrhkhkhrhkhkhkhkrkhhhkhxkx*x

"UI 8" executed.

R R I I I I I I I R i b I S I I R I S I b b I b S I I S k2 b b b b b I S S
Example GMotionComplete () usage

B R R S R R R

Position: 0, O
Beginning independent motion... Motion Complete on A
Position: 8000, O

Position: 0, O

Beginning vector motion... Motion Complete on vector plane S
Position: 6000, O

examples.cpp executed OK
main() is finished. Press Enter to exit:

3.1.5 gcc (Linux)
The following instructions were performed on

$ uname -a

Linux localhost.localdomain 3.17.4-301.fc21.x86_64 #1 SMP Thu Nov 27 19:09:10 UTC 2014 x86_64 x86_64
$ g++ —-version

g++ (GCC) 4.9.2 20150212 (Red Hat 4.9.2-6)

Copy Files

$ mkdir test
$ cd test
$ tar -xzf /usr/share/doc/gclib/src/gclib_examples.tar.gz
S 1s
X_arrays.cpp x_gcommand.cpp x_gmotioncomplete.cpp x_programs.cpp
x_examples.cpp x_ginterrupt.cpp x_gread_gwrite.cpp x_simple.c
x_examples.h X_gmessage.cpp x_grecord.cpp
x_simple.c

* In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hard-

ware. See the documentation for GOpen() for address formatting options.

Compile

$ gcc -Wall -Werror x_simple.c -1lgclib -lgclibo -o simple

Run
$ ./simple
rc: O

version: 85.60.131
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rc: O
rc: O
info: 10.1.3.17, DMC4020 Rev 1.2b, 291
rc: O

response: 179340166.0000

x_examples.cpp

* In a text editor, open x_examples.cpp. Find the GOpen() call and update the address to match the desired
hardware. See the documentation for GOpen() for address formatting options. Don't forget —s ALL if data
records, interrupts, and messages are to be tested.

» Find the #1f 0 preprocessor block enclosing the example calls. Change to #1f 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions
are compatible with all Galil products.

Compile

$ gt++ x_x.cpp -lgclib -lgclibo -o example

Run
$./example Library version: 85.60.131

10.1.3.17, DMC4020 Rev 1.2b, 291

R R kR I I I I Rk Rk R Rk ki 2 S S S

Example GRead() and GWrite () usage

B R R R e S R R R

Read 155 QR bytes.

Fhrkhkhkhkhkhkhkhkhkhkhkhkhhhkhkhkhkhkhk bk hAhA b b rrrhkhkhkhkhkhkhkhkhkhkhhhkhkhkhkhkhk bk bk kA bk rrrrkhkhkhkhkhkhkhhhkkkk*
Example GCommand() usage
Krhrkkhkhkhkhkhkhkhkhkhhkhhkhkhkhk bk kA kA A A rrrrhkhkhkhkhkhkhkhkhkhkhkhhkhkhkhkhk bk bk hk kA kA v rrrhkhkhkhkhkhkhkhhkkhkk*k
Revision report, "“R"V

DMC4020 Rev 1.2b

Command Values
val is 10

val is 11

val is 3.1415
val is 9.869

Command Trimming

> 179798738.0000

1<

> 179798738.0000<
>179798738.0000<

Receiving Binary Data
OR read 155 bytes

Error handling
QD correctly trapped, not allowed, try GArrayDownload()
DL correctly trapped, not allowed, try GProgramDownload ()

Modifying timeout
Burning program...OK

R R R R R R I R R R R i b b b b S S
Example GProgramDownload() and GProgramUpload() usage
R R R R I R R Rk b 2k i I S S S

GProgramDownload () correctly errored. Can’t fit with level 3 compression
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Program Downloaded with compression level 4

Uploading program:
#2;1=0;1i=1+1;i=1i+1;i=i+1;i=i+1;i=1i+1;i=1+1;i=1i+1;i=1i+1;i=i+1;i=i+1;i=i+1;i=1i+1
i=i+1l;i=i+1;i=1i+1;1i=1i4+1;1i=i+1;i=i+1;i=i+1;i=1i+1;EN

Program executed as expected

EEEEEEEE S S E S EESE R EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S
Example GArrayDownload (), GArrayUploadFile ()

GArrayDownloadFile (), and GArrayUpload usage

Fhhkhkhkhkhkhkhkhkhkhkhkhhhkhkhk bk bk bk bk bk hA bbb rrrhkhkhkhkhkhkhkhkhkhkhkhhkhkhkhkhkhk kA kA bk rrrrrhkhkhkhkhkhhhhkhkhkkk

2.0000, 4.0000, 6.0000, 8.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.0000, 20.0000
2.0000, 1.0000, 3.0000, 5.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.0000, 20.0000

3.0000, 5.0000, 10.0000
2.0000, 1.0000, 3.0000, 5.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.0000, 20.0000

Frhhkhkhkhkhkhkhkhkhkhkhkhkhhkhkhkhkhk bk bk bk bbb b rrrhkhkhkhkhkhkhkhkhkhkhkhhhkhkhkhk bk bk bk bk bk rrrrrkhkhkhkhkhkhkhhhkkkkk

Example GRecord() usage

KAk hkhkhkhkhkhkhkhkhhkhkhkhkhkhk kA kA A A A A Ak rrkhkhkhkhkhkhkhkhkhhhhkhkhkhkhkhkhk bk hkhk kA A v rrhkhkhkhkhkhkhhhkhkhkkx*k

QOR-based data record
36100
6000

DR-based data record
36204
36306
36408
36510
36612
36714
36816
36918
37020
37122
37224

QR-based data record with offsets
37224
37224

Ak hkhkhkhkhkhkhkhkhhhhkhhhkhkhkhkhkhkhhkhkrhkhhkhhhkhhkhkhkhkhhhkrhkhhkhkhkhkhkhkhkhkhkhkrdhrhkhkhkhkhkhkhkrkhkhhhxkxx

Example GMessage () usage

Ak hkhkhkhkhkhkhkhkhhkhhhhhkhkhkhkhkhkhhkhkrhhhkhhhkhkhkhkhkhkhkhhrhhkhkhkhkhkhkhkhkhdhkhkhrdrhkhk ok hkhkhkrkhkhdkhxkxx
0.0000
1.0000

.0000

.0000

.0000

.0000

.0000

.0000

.0000

.0000

W O J o U b W

Ak hkhkhkhkhkhhkhkhkhhhkhhkhkhhkhhkhkhhkhkrhhhkhhdhhhkhkhhkhhkhkrhkhhkhkhhkhhkhkhhkhkrdrhkhkrhkhkhkhkrkhhhhxk*x*x
Example GInterrupt () usage
Ahkhkhkhkhkhkhkhkhkhkhkhhkhhrhkhkhkhkhkhkhhkhkrhhhkhhkhkhkhkhkhkkhkhkhhkrdhhhkhkhhkhkhkhkhkkhkhkrdrhkhkhhkhkhkhkrkhkhdxkhxkxx

"UI 8" executed.

B R R R

Example GMotionComplete () usage

B R R R T

Position: 0, O
Beginning independent motion... Motion Complete on A
Position: 8000, O

Position: 0, O
Beginning vector motion... Motion Complete on vector plane S
Position: 6000, O
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examples.cpp executed OK
main() is finished. Press Enter to exit:

3.1.6 clang (OS X)

The following instructions were performed on

$ sw_vers

ProductName: Mac 0OS X

ProductVersion: 10.10.5

BuildVersion: 14F27

$ gcc —-version

Configured with: —--prefix=/Library/Developer/CommandLineTools/usr —--with-gxx—-include-dir=/usr/include/c++/4.2.
Apple LLVM version 6.1.0 (clang-602.0.53) (based on LLVM 3.6.0svn)

Target: x86_64-apple-darwinl4.5.0

Thread model: posix

Copy Files

$ cd ~

$ mkdir test

$ cd test

$ tar -xzf /Applications/gclib/examples/gclib_examples.tar.gz
$ cp /Applications/gclib/include/*

$ cp /Applications/gclib/dylib/«

$ 1s

gclib.0.dylib x_arrays.cpp x_gmotioncomplete.cpp
gclib.h x_examples.cpp x_gread_gwrite.cpp
gclib_errors.h x_examples.h x_grecord.cpp
gclib_record.h x_gcommand. cpp x_nonblocking.cpp
gclibo.0.dylib X_ginterrupt.cpp x_programs.cpp
gclibo.h X_gmessage.cpp x_simple.c

x_simple.c

* In a text editor, open x_simple.c. Find the GOpen() call and update the address to match the desired hard-
ware. See the documentation for GOpen() for address formatting options.

Compile

$ gcc -Wall -Werror x_simple.c gclib.0.dylib gclibo.0.dylib -o simple

Run

$ ./simple

rc: 0

version: 126.108.229

rc: O

rc: O

info: 10.1.3.142, DMC4020 Rev 1.2a-BH, 291
rc: O

response: 206676.0000
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x_examples.cpp

* In a text editor, open x_examples.cpp. Find the GOpen() call and update the address to match the desired
hardware. See the documentation for GOpen() for address formatting options. Don't forget —s ALL if data

records, interrupts, and messages are to be tested.

» Find the #if 0 preprocessor block enclosing the example calls. Change to #if 1 to run the examples.
Comment out the function calls to be avoided. Note some calls attempt to move motors and not all functions

are compatible with all Galil products.

Compile

$ g++ x_*.cpp gclib.0.dylib gclibo.0.dylib -o example

Run

$ ./example
Library version: 126.108.229

10.1.3.142, DMC4020 Rev 1.2a-BH, 291

Fhhkhkhkhkhkhkhkhkhkhkhkhkhhkhkhk bk bk bk bk hkhAhA b b rrrrkhkhkhkhkhkhkhkhkhhhhhkhkhkhkhk bk bk bk hk kA v v rrhkhkhkhkhkhkhkhhhkhkk*k

Example GRead() and GWrite () usage

EEEEE SRS EE RS EE R RS EREEREREEEEEEEEEEEEEEEEEEEEEREEEEEEEEEEEEEE S
Read 1 byte(s)
Program test OK.

Ak Ak hkhhkhkhkkhk kA hhhhhAdhhkdhhhkhhkhrhhhkh b dhhkhkh bk hkhhkhhkhh bk hk bk hkhkhkhhdkhhkdhrhhkhkhkhkhkhkrhhdhrxkhx*x
Example GCommand () usage

kA A Ak hhhk kA hAdhhhhhkhk kA Ak hkhhk kA A hhhhhkhkhkhkhkhkhkhhk kA dhkhhhkhkhkhk kb hhk kA rhhkhkkhkhkhkdrhhkhkhkhkxxx
Revision report, "R"V

DMC4020 Rev 1.2a-BH

Command Values
val is 10

val is 11

val is 3.1415
val is 9.869

Command Trimming
> 408978.0000

1<

> 408978.0000<
>408978.0000<

Receiving Binary Data
QR read 155 bytes

Error handling
QD correctly trapped, not allowed, try GArrayDownload()
DL correctly trapped, not allowed, try GProgramDownload ()

Modifying timeout
Burning program...OK

Frhhkhkhkhkhkhkhkhkhkhkhkhkhhhhkhkhk bk bk bk b r bk rrrhkhkhkhkhkhkhkhkhkhkhhhkhkhkhkhkhk bk bk bk hk bk rrrrrkhkhkhkhkhkhkhhhkkhkkk
Example GProgramDownload() and GProgramUpload() usage
Fhhkkhkhkhkhkhkhkhkhkhhhhkhkhkhk bk bk bk bk A rrrrrrhkhkhkhkhkhkhkhkhkhkhkhhhkhkhkhkhkhkhk bk kA rrr vk hkhkhkhkhkhhkkkk*k
GProgramDownload () correctly errored. Can’t fit with level 3 compression
Program Downloaded with compression level 4

Uploading program:

#R;i=0;i=1i+1;i=1+1;i=i+1;i=1+1;i=i+1;i=i+1;i=1+1;i=i+1;i=1+1;i=i+1;i=i+1;i=1+1

i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;1i=1i+1;1i=i+1;i=i+1;EN

Program executed as expected
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khkhkkhkhkhkhkhkkhkhkhkhhhhhhhhkhhhh bk kb hhhkhhhk bk hhhkhhhhhkhhkhk kb kb h b hkhhkhhkhk bk hkhkhkhkhkhk Ak hkhhx*k
Example GArrayDownload(), GArrayUploadFile ()
GArrayDownloadFile (), and GArrayUpload usage
R i R R R R I R Rk Rk R Rk ki S S S

2.0000, 4.0000, 6.0000, 8.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.0000, 20.0000
2.0000, 1.0000, 3.0000, 5.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.0000, 20.0000

3.0000, 5.0000, 10.0000
2.0000, 1.0000, 3.0000, 5.0000, 10.0000, 12.0000, 14.0000, 16.0000, 18.0000, 20.0000

R R I I I Rk ik kR R I I Rk Rk R Rk k2 I 2 S S S

Example GRecord() usage

B T R e S R R R

QR-based data record
18358
0

DR-based data record
18462
18564
18666
18768
18870
18972
19074
19176
19278
19380
19482

OR-based data record with offsets
19482
19482

R R R R R I I I I I I I i I i I S I R S b b b I S S I I I b 2 b b b b b S

Example GMessage () usage
khkhkkhkhkhkhkhkkhkhhkhhhkhhhhhkhhkhkhhkhhhhhkhhhk bbbk hkhhkh b bk hhkhkhhkhkhkh bk h b hhkhk bk hkhk bk kA kA khkkhx*k
0.0000
1.0000

.0000

.0000

.0000

.0000

.0000

.0000

.0000

.0000

W 00 ~J oy U b W

Ak Ak hhkhkhkkhk kA hhhh A dhhhhhhhhkhhhrhh b dhhkhkh bk hkhhkhhhkh bk hk Ak hk kA h bk dkhhkdhrhkhkhkhkhkhkhkrhkhdhkhxkhx*k
Example GInterrupt () usage

Ak Ak Ak hhhkhkhAkhhhhhh bk bk Ak hhhk kA A d bk hhkhkhkhkhkhkhkhkhkhkhkdkhhkhkhkhkhkhkhkhhhkhkhkhAhrhkhkhkkhhkhkhrhhkhkhkkxxx
"UI 8" executed.

R R R R R R R Rk b 2 I I S S S
Example GMotionComplete () usage

R R I kR R I I Rk Rk R Rk 2 I I S S S

Position: 0, O
Beginning independent motion... Motion Complete on A
Position: 8000, O

Position: 0, O
Beginning vector motion... Motion Complete on vector plane S
Position: 6000, O

EEEEEEEEESEEE S ERE R R EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S
Example GMessage non-blocking usage
R R R R I I R R Rk b b i 2 b S S

422902.0000
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R R R R R R S I R R R Rk b b b i b b S S
Example GInterrupt non-blocking usage
R i R R R R I R Rk Rk R Rk ki S S S

Fl

EEEEEEEEEEEES S SSEREEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S
Example GRecord non-blocking usage
R R R R R R R I R R R b b I b b S S S

33786

examples.cpp executed OK

main() is finished. Press Enter to exit:
3.2 Python
Install gclib

The gclib Python wrapper assumes the default gclib installation location.

Install Python

* See https://www.python.org/ if Python is not already installed on the system. The gclib Python
wrapper supports Python versions 2 and 3.

» On Windows, choose to add Python to the environment variable during installation. This allows Python to be
invoked from the command line.

Install the gclib Python module
Windows

» Type the following commands into a command prompt.

:\Users\username>cd Desktop

:\Users\username\Desktop>mkdir python_temp

:\Users\username\Desktop>cd python_temp

:\Users\username\Desktop\python_temp>copy "c:\Program Files (x86)\Galillgclib\source\wrappers\python\*"
:\Users\username\Desktop\python_temp>copy "c:\Program Files (x86)\Galil\gclib\examples\python\x*"
:\Users\username\Desktop\python_temp>python setup.py install

running install

running build

running build_py

creating build

creating build\1lib

copying gclib.py -> build\1lib

running install_1lib

copying build\lib\gclib.py —-> C:\Python34\Lib\site-packages

byte-compiling C:\Python34\Lib\site-packages\gclib.py to gclib.cpython-34.pyc

running install_egg_info

Writing C:\Python34\Lib\site-packages\gclib-1.0-py3.4.egg-info

[N ONONeNeONe!

+ The gclib Python wrapper is now installed. Go to the next section, Using gclib from the Python Interpreter.

Linux

+ Type the following commands into a Terminal prompt.
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$ mkdir ~/python_temp

$ cd ~/python_temp/

$ tar -xvf /usr/share/doc/gclib/src/gclib_python.tar.gz

gclib.py

setup.py

$ tar -xvf /usr/share/doc/gclib/src/gclib_python_examples.tar.gz
example.py

$ sudo python setup.py install

[sudo] password for user:

running install

running build

running build_py

creating build

creating build/lib

copying gclib.py -> build/lib

running install_lib

copying build/lib/gclib.py -> /usr/lib/python2.7/site-packages
byte-compiling /usr/lib/python2.7/site-packages/gclib.py to gclib.pyc
running install_egg_info

Writing /usr/lib/python2.7/site-packages/gclib-1.0-py2.7.egg-info

« The gclib Python wrapper is now installed. Go to the next section, Using gclib from the Python Interpreter.

0sX

» Be sure that the Create Environment Variable step has been followed in the OS X installation instructions.

+ Type the following commands into a Terminal prompt.

mkdir ~/python_temp

cd ~/python_temp/

tar -xvf /Applications/gclib/source/gclib_python.tar.gz

gclib.py

setup.py

tar —-xvf /Applications/gclib/examples/gclib_python_examples.tar.gz
example.py

sudo python setup.py install

running install

running build

running build_py

creating build

creating build/lib

copying gclib.py -> build/lib

running install_1lib

copying build/lib/gclib.py —-> /Library/Python/2.7/site-packages
byte-compiling /Library/Python/2.7/site-packages/gclib.py to gclib.pyc
running install_egg_info

Writing /Library/Python/2.7/site-packages/gclib-1.0-py2.7.egg-info

Ur X X X W iy

» The gclib Python wrapper is now installed. Go to the next section, Using gclib from the Python Interpreter.

Using gclib from the Python Interpreter

* Invoke the Python Interpreter.

+ Type the following into the Python prompt.

>>> import gclib

>>> g = gclib.py ()

>>> g.GOpen(’192.168.0.42 -—-direct’)
>>> print (g.GInfo())

192.168.0.42, DMC4080 Rev 1.2c, 783
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Running Python scripts

» Navigate the terminal to the location from Install the gclib Python module where example.py was copied.
» Open example.py in a text editor.
 Set the address in the g.GOpen() call to match an avaiable connection.

» Execute the following command at the Terminal.

$ python example.py
gclib version: py.127.110.250
192.168.0.42, DMC4080 Rev 1.2c, 783

« Experiment with the example by uncommenting sections, between the triple quotes, "'

$ python example.py
gclib version: py.127.110.250
192.168.0.42, DMC4080 Rev 1.2c, 783
GProgramDownload () correctly errored. Can’t fit with level 3 compression
Uploaded program:
#A;1=0;1i=1i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=1i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;i=1i+1
i=i+1;i=i+1;i=i+1;i=i+1;i=i+1;1i=1i+1;i=i+1;i=i+1;EN
Downloaded program verified
Array element verified

187942.0000

Starting move...
done.

Getting help

>>> help (g.GOpen)
Help on method GOpen in module gclib:

GOpen (address) method of gclib.py instance
Opens a connection a galil controller.
See the gclib docs for address string formatting.

See Link GOpen () <http://www.galil.com/sw/pub/all/doc/gclib/html/gclib_8h_aefdaec8a85630eed029b7adbaeca7dbt

>>> help (g.GCommand)
Help on method GCommand in module gclib:

GCommand (command) method of gclib.py instance
Performs a command-and-response transaction on the connection.
Trims the response.

See Link GCommand () <http://www.galil.com/sw/pub/all/doc/gclib/html/gclib_8h_abac03le76efc965affdd73albec(

>>> ’for a full listing, try help(g)’

3.3 .Net

* VB.NET

« C#.NET

3.3.1 VB.NET

gclib ships with gclib.vb, a Visual Basic class which exposes the functionality of the gclib. In addition, a VB forms
example is included which demonstrates how to use gclib.vb. The following instructions were performed on Visual
Studio Professional 2013 and can be extended to other Visual Studio versions.
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Running the included Visual Basic Example

For brevity, these instructions assume the default installation location of C:\Program Files (x86)\Galil\gclib.

Copy files

» Navigate to a convenient, empty, writable location, e.g. C:\temp.

» Copy the contents of C:\Program Files (x86)\Galil\gclib\examples\vb\2013_12.0\gclib_example to this loca-
tion.

Open in Microsoft Visual Studio 2013

» Open gclib_example.sin in Visual Studio. This demo was tested on MSVS 2013.

Add existing item, gclib.vb

+ In the Solution Explorer, right-click on gclib_example and choose Add->Existing ltem...

» Choose C:\Program Files (x86)\Galil\gclib\source\wrappers\vb\gclib.vb

Run Demo

» Type F5to run the program.

» Type a valid GOpen() address in the text box and click Go.

Create Project from scratch with MSVC 2013

For brevity, these instructions assume the default installation location of C:\Program Files (x86)\Galil\gclib.

Configure Project

 Launch Visual Studio 2013

» Choose File->New->Project

* In the New Project dialog, choose Visual Basic -> Windows Forms Application
» Type gclib_example for the Name

» Choose a Location, e.g. C:\Users\user\Desktop

» Check Create directory for solution

+ Click OK, the project will configure itself

« In the Solution Explorer, right click on Solution 'gclib_example' (1 project) and choose Configuration Man-
ager...

— In the gclib_example project row, click in the Platform column and choose <New...>

= Choose x86 from Type or select the new platform:
» Choose Any CPU from Copy settings from:

= Check Create new solutions platform

« Click OK.

— If x64 support is also desired, repeat the <New...> procedure for x64
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— In the Active solution platform combobox at the top of the Configuration Manager dialog, choose
<Edit...>

= Select Any CPU and click the Remove button
= Click Close

— Close the Configuration Manager dialog
« In the Solution Explorer, right-click on gclib_example and choose Add->Existing ltem

— Navigate to the installation location C:\Program Files (x86)\Galil\gclib\source\wrappers\vb

— Choose gclib.vb
* In the Solution Explorer double-click on gclib.vb

— Note that there is a preprocessor definition starting with #1f PLATFORM = "x86" Then and #+«
ElseIf PLATFORM = "x64" Then

— Note that these sections of code enable/disable with the choice of the Solution Platform x86/x64, usually
found in the Visual Studio toolbar

— If a non-default gclib installation location is used, the paths in these sections of code must be updated
to reflect the dll locations

Add some simple code

« In the Solution Explorer right-click on Form1.vb and choose View Code

* Replace the text in Form1.vb with the following code

Public Class Forml
Dim gclib As New Gclib ()
Private Sub Forml_Load(sender As Object, e As EventArgs) Handles MyBase.Load
Me.Text = "gclib simple example"
Dim tb As New TextBox
With tb
.Multiline = True
.Dock = DockStyle.Fill
.Parent = Me

Try
"calls to gclib should be in a try-catch
.AppendText ("GVersion: " & gclib.GVersion() & vbCrLf)
gclib.GOpen ("192.168.0.42 —-d") ’'Set an appropriate IP address here
.AppendText ("GInfo: " & gclib.GInfo() & vbCrLf)
.AppendText ("GCommand: " & gclib.GCommand ("MG TIME") & vbCrLf)
Catch ex As Exception
.AppendText ("ERROR: " & ex.Message)
Finally
gclib.GClose () ’ Don’t forget to close!
End Try
End With
End Sub

End Class

+ Hit F5to run the project

3.3.2 C#NET

gclib ships with gclib.cs, a C# class which exposes the functionality of the gclib. In addition, a C# forms example is
included which demonstrates how to use gclib.cs.

For brevity, these instructions assume the default installation location of C:\Program Files (x86)\Galil\gclib.
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Running the C# Example

Copy files

» Navigate to a convenient, empty, writable location, e.g. C:\temp.

» Copy the contents of C:\Program Files (x86)\Galil\gcliblexamples\cs\2013_12.0\gclib_example to this loca-
tion.

Open in Microsoft Visual Studio 2013

» Open gclib_example.sin in Visual Studio. This demo was tested on MSVS 20183.

Add existing item, gclib.cs

* In the Solution Explorer, right-click on gclib_example and choose Add-> Existing Item...

» Choose C:\Program Files (x86)\Galil\gclib\source\wrappers\cs\gclib.cs

Run Demo

» Type F5to run the program.

» Type a valid GOpen() address in the text box and click Go.

Create Project from scratch with MSVC 2013

For brevity, these instructions assume the default installation location of C:\Program Files (x86)\Galil\gclib.

Configure Project

 Launch Visual Studio 2013

» Choose File->New->Project

* In the New Project dialog, choose Visual C# -> Windows Forms Application
» Type gclib_example for the Name

» Choose a Location, e.g. C:\Users\user\Desktop

» Check Create directory for solution

+ Click OK, the project will configure itself

« In the Solution Explorer, right click on Solution 'gclib_example' (1 project) and choose Configuration Man-
ager...

— In the gclib_example project row, click in the Platform column and choose <New...>
= Choose x86 from Type or select the new platform:
» Choose Any CPU from Copy settings from:
= Check Create new solutions platform
= Click OK.

— If x64 support is also desired, repeat the <New...>> procedure for x64

— In the Active solution platform combobox at the top of the Configuration Manager dialog, choose
<Edit...>

= Select Any CPU and click the Remove button
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= Click Close
— Close the Configuration Manager dialog

« In the Solution Explorer, right-click on gclib_example and choose Properties

— Choose the Build item on the left

= In the Configuration: combobox, choose All Configurations
» Choose x86 from the Platform combobox
= In Conditional compilation symbols type x86

— If x64 is to be used also, add an x64 token as well to the x64 Platform
— Save and close the Properties window

+ In the Solution Explorer, right-click on gclib_example and choose Add->Existing Item

— Navigate to the installation location C:\Program Files (x86)\Galil\gclib\source\wrappers\cs
— Choose gclib.cs

* In the Solution Explorer double-click on gclib.cs

— Note that there is a preprocessor definition starting with #1f x86 and #elif x64

— Note that these sections of code enable/disable with the choice of the Solution Platform x86/x64, usually
found in the Visual Studio toolbar

— If a non-default gclib installation location is used, the paths in these sections of code must be updated
to reflect the dll locations

Add some simple code

* In the Solution Explorer right-click on Form1.cs and choose View Code

* Replace the text in Form1.vb with the following code

using
using
using
using
using
using
using
using
using

System;
System.Collections.Generic;
System.ComponentModel;
System.Data;
System.Drawing;
System.Ling;

System.Text;
System.Threading.Tasks;
System.Windows.Forms;

namespace gclib_example

{

public partial class Forml : Form

{

gclib gclib = new gclib();
public Forml ()
{

InitializeComponent () ;
this.Text = "gclib simple example";
TextBox tb = new TextBox();
tb.Multiline = true;
tb.Dock = DockStyle.Fill;
tb.Parent = this;
try
{
//calls to gclib should be in a try-catch

tb.AppendText ("GVersion: " + gclib.GVersion() + "\n");
gclib.GOpen("192.168.0.42 -d"); //Set an appropriate IP address here
tb.AppendText ("GInfo: " + gclib.GInfo () + "\n");

tb.AppendText ("GCommand: " + gclib.GCommand ("MG TIME") + "\n");

}

catch (Exception ex)
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tb.AppendText ("ERROR: " + ex.Message);
}
finally
{
gclib.GClose(); //Don’t forget to close!

}

» Hit F51to run the project

3.4 Java

gclib uses the venerable
Java Native Access (JNA) library to simplify integration into the Java Native Interface (JNI).

Attention

This is the initial version of the the gclib Java wrapper. As such, GclibJava ships as source files, not the
compiled jar files. All functions are subject to change in future releases of gclib. Java hackers with recom-
mendations on how to make this library better are encouraged to email softwaresupport@galil.com.
Somebody has to teach those Galil Java noobs what's what.

Windows

The following instructions were performed with 64 bit Windows 7 on Oracle NetBeans IDE 8.2 and
Java 1.8.0_131.

For brevity, these instructions assume the default gclib installation location of "C:\Program Files (x86)\Galil\gclib".

Step-by-Step

1. Install gc1ib with 64 bit binaries (default install).

2. Install 64 bit NetBeans and Java, jdk-8ul31-nb-8_2-windows-x64.exe.
3. Launch NetBeans.

4. Create a new application.

(a
(b
(

(¢

File | New Project...

Under Categories, select Java.

Under Projects, select Java Application.
Click Next.

Type GeclibTest for the Project Name.

d
e
(f
g
(h

(
(
Note the location of the Project Folder.

Uncheck Create Main Class
Click Finish

—

)
)
)
)
)
)
)
)

5. Open the Project Folder as noted above.
6. Open the srcdirectory in the Project Folder location.

7. Copy the whole directory C:\Program Files (x86)\Galil\gclib\examples\java\gclibtest to this directory.
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10.

11.
12.
13.
14.
15.
16.
17.
18.
19.
20.

21.

Copy the whole directory C:\Program Files (x86)\Galil\gclib\source\wrappers\java\gclibjava to this directory.
Create a directory at c: \ jna\.

» Another directory may be chosen. The purpose of this directory is to hold jna's jar binary for the Java
classpath.

Download a copy of jna.jar to the new directory.

e https://github.com/java-native—access/jna#download

» This example uses jna-4.4.0.jar.
In the NetBeans Projects tab, expand GclibTest.
Right-click on Libraries and choose Add JAR/Folder....
Navigate to the jna.jar saved above. Click Open to add jna.jar to the classpath.
In the NetBeans Projects tab, right-click on GclibTest and choose Properties.
Choose the Run item out of the Categories options tree.
In the Main Class text box, type gclibtest.GclibTest. Click OK.
In the NetBeans Projects tab, expand GclibTest | Source Packages | gclibtest.
Double click GclibTest.java, and find the line containing gclib.GOpen.
Update the address for the desired hardware.
Choose Run | Run Project (GclibTest) or hit the F6 key to run the application.

The appplication output will print in the NetBeans Output window.

Documentation

The GclibJava class has helpful documentation for developing a Java application. Use the following instructions to
create the Javadoc.

1.

2.

In the NetBeans Projects tab, right-click GclibTest.

Choose Generate Javadoc to create the documentation and open it in the system's default browser.
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41 gcaps

gcaps is a communication server natively supported by gclib to multiplex Galil hardware communication features. It
runs in the background on the host computer, as a service or daemon.

Incidentally, the name gcaps is an acronym for the improbable name Galil Controller Asynchronous Proxy Server.
Yet another tidbit to impress friends at parties.

gclib & gcaps

gclib will attempt to use gcaps whenever GOpen() is called without the ——direct or —d switch. Other than this
small difference, gclib function calls through gcaps operate as if the connetion was direct. The first version of gclib
supporting gcaps is 299.

At this time, gcaps must be running on the same host as gclib (localhost). Contact Galil if connection to a remote
host is desired.

Other gcaps Usage

The following functions will attempt to use gcaps first to gather data. If gcaps is not found, the functions will fall back
to user space calls to populate information.

gclib Function | Usage If gcaps unavailable
GVersion() Provide the version of gclib and gcaps (if | No gcaps version.
available).

GlpRequests() Provide a list of all Galil controllers request- | Must be root.
ing IP addresses via BOOT-P or DHCP.
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gclib Function | Usage If gcaps unavailable

GAssign() Assigns an IP address over the Ethernetto a | Must be root.
controller at a given MAC address.

GAddresses() Provides a listing of all available connection | Must be root, or user must be in device
addresses. group.

Because gcaps runs as a service on Windows, and as a system daemon on Linux, gcaps runs with root privileges.
See If gcaps unavailable column in the above table when running without gcaps.

If gcaps is unavailable when these functions are run, a ~1 second delay will be incurred while gclib searches for
the absent server. In order to prevent gcaps usage in these functions, comment out the symbol G_USE_GCAPS in
gclibo.h and rebuild gclibo. See Rebuilding gclibo.

gcaps Benefits

» Connections through gcaps multiplex a single connection resource. This means that single-channel connec-
tion protocols like USB, RS232, or PCI can be shared with as many simultaneous connections as needed.
Furthermore, Ethernet-based connections with gcaps leave plenty of Ethernet handles available for other
communications, such as MODBUS.

» All communications features are available to all connecting clients. This means that a software application
can be running simultaneosly with Galil's diagnostic software (Galil Design Kit). This significantly simplifies
support and aides in debugging.

» Data Records, Messages, and Interrupts everywhere. No longer does one connection steal data streams
from another.

* gcaps runs as a service providing more capabilities than a user space application. This allows functions like
GlpRequests() and GAssign() to operate from a gclib application without root privileges.
gcaps Installation

See the installation page to see if gcaps is available on your OS. Support is marked with a diamond ().

If gcaps is needed on a different OS, please email softwaresupport@galil.com, or call Galil
Applications.

Windows

gcaps is bundled in the gclib and GDK installer packages. Install with defaults to get the gcaps service included.
gcaps is also available as a standalone installer. Downloads are available on the release notes page.

gcaps is currently available only on 64 bit Windows.

Linux

Instructions to install gcaps are listed with the instructions to install gclib. Follow the link for your OS on the
installation page.

gcaps is currently available only on 64 bit versions of Linux.

Changes and updates to gcaps

See the release notes page.
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4.2 Program Preprocessor

gclib's program downloader provides a preprocessor for DMC code. The preprocessor modifies the program prior
to download providing a number of language features not present in native DMC code.

The preprocessor is invoked in the following two ways.

1. With both GProgramDownload() and GProgramDownloadFile() via the preprocessor argument. Down-
loading code with null for the preprocessor argument uses defaults.

2. From within DMC code via in-band preprocessor directives.

The preprocessor argument

GProgramDownload() and GProgramDownloadFile() can be called with a string passed to the preprocessor
argument. The program will be modified based on this string prior to download. See Preprocessor Options below
for syntax.

In-band Operation

DMC code can be written with special markup to signal the preprocessor to take actions prior to download.

For example, the following program will invoke the in-band preprocessor. The specifics are described below.

## Author: Zaphod Beeblebrox

## Project: Total Perspective Vortex

//the above 4 hashmarks enable the preprocessor

##option "--min 4" //use a minimum of level four compression
REM REM-style comments are supported at all times

PRA=1000

BGA

AMA

EN

The REM Comment

Lines beginning with the string REM are removed prior to download. REM comments are always removed regardless
of whether the other preprocessor options are enabled or not.

Double Hash

Most preprocessor statements begin with a double hash, ##. When proceeded by a space, the double hash acts
like a REM comment.

When proceeded by a character other than space, ## is interpreted as a preprocessor directive. For example, see
##option below.

Note

Double hash lines are removed from the program only when the preprocessor is enabled with a quad hash.

Quad Hash to enable
In order to enable the in-band preprocessor, the first two lines of the DMC program must start with a double hash.
This syntax of using two lines with double hashmarks is called a quad hash.

Content may follow the hash marks. For example, a good code writing style is to use double hash comments as a
comment header showing author, project name, etc.
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C-style comments

With the preprocessor enabled, C-style comments may be used with the // prefix. These comments are very
similar to REM comments. The primary advantage of using this comment over REM is that // comments may occur
anywhere in a line. This is helpful for line comments such as the following.

SIA= 1,25,25,0<4>1 //SSI 25 bits total, all single turn, no status

Strings containing / / are not interpreted as comments.

Note

// comments are removed from the program only when the preprocessor is enabled with a quad hash.

Preprocessor Directives
Note

Directives are only followed when the preprocessor is enabled with a quad hash.
##option

The option directive allows passing switches directly to the preprocessor with the same syntax as the
preprocessor argument in GProgramDownload() and GProgramDownloadFile(). The syntax of the option
directive is the following.

##option "{preprocessor switches}"

For example, the following line will disable compression in the program.

##option "--max 0"

See Preprocessor Options below for other switches.
##include

The include directive provides a way to include the contents of another DMC file in the current program. This is
useful for reusing code such as automatic subroutines, homing operations, or controller initilization routines.

The contents of the file will be inserted in place of the include line. The insertion occurs prior to code compres-
sion.

The syntax of the include directive is the following.

##include "{filename}"

For example,

##include "c:\galillinitialize.dmc"
##include "homing.dmc"

To write more portable code, use the include directive with just the file name, no absolute path. The path to find
the file on the system is set depending on usage.

1. Inthe Galil Design Kit, specify the include path in GDK's settings with the ——search or -1
switch as defined below.

2. When downloading code via GProgramDownload() or GProgramDownloadFile(), use the ——search or —-T
switch in the preprocessor argument.

3. Finally, if the file is in the executable search path, the file will be found. However, one of the previous two
options is more reliable.

gclib 423


http://galil.com/downloads/software/gdk
http://galil.com/sw/pub/all/doc/gdk/man/settings.html

4.2 Program Preprocessor 51

In-band Support

In addition to gclib, Galil Design Kit supports the preprocessor. Proper preprocessor usage will be colored
in the Editor's syntax highlighter. If the quad hash is not present, preprocessor syntax will be colored differently to
indicate improper usage.

The preprocessor is not supported in software prior to GDK/gclib. DMC code downloads using the in-band prepro-
cessor in prior generation software (e.g. GalilTools or SmartTerm) will fail with a TC code of 61, Duplicate or bad
label.

Preprocessor Options

Compression, ——min, ——max

+ Default uses minimum compression needed to fit the program.

* ——max n provides compression up to and including level n. Only the necessary compression will be per-
formed up to level n.

+ ——min nwill compress at least up to and including n. n defined as with ——-max.

Compression Levels, n

» Level 0 (mandatory)

—_

. Remove lines beginning with REM.

Remove trailing semicolons.

Comment blank lines with '.

Remove white space (space/tab) in front of # (label declarations).
Remove white space after commands.

Line ends changed to carriage return.

Replace leading tabs with double space.

Replace non-leading tabs with single space.

© © N o o ~ O D

A backslash (\) character on a line other than a preprocessor line will result in an error.
* Level 1

1. Remove unnecessary spaces. Strings, comments ('), and no-ops (NO) are not changed.
* Level 2

1. Remove comments (') but not no-ops (NO).
* Level 3

1. Remove no-ops (NO).
* Level 4

1. Break apart compound lines that are too long.
2. Compact lines of code to maximize line usage.

3. Use backtick to support long lines where applicable.
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Code insertion, ——insert

 Default begins at line zero and overwrites anything present.
+ ——insert arginvokes the insert option of the firmware's DL command. arg can be one of the following.

1. Line number, e.g. 100. Program insertion will occur on the line after the line specified.

2. Variable name, e.g. myvar. Program insertion will occur on the line after the line equal to the value of
the variable.

3. Label callout, e.g. #mylabel. Program insertion will occur on the line after the label.

4. Alone # symbol. Program insertion will occur on the line after the last line in the program buffer.
» Compression directives ——max and ——min are followed.
« All original code following the point of insertion is cleared.

* Not all products support the ——insert operation, e.g. DMC-30010. See the DI. command for support.

Warning

It is the user's responsibility to ensure that the code will fit in the inserted location. The preprocessor will not
check line numbers when executing the ——insert option.

Include Search Paths, ——search, -T

» The ##include directive will attempt to open its string argument directly. The open will succeed if the
argument is the absolute path, or if the argument is in the executable's path, e.g. in the same directory.

+ ——search path allows the user to specify a directory or directories to be searched for the include file in
case the first open fails.

— For historical reasons, —I is shorthand for ——search.
» Multiple directories may be specified with multiple —I directives.
» For in-band code, —I must be specified prior to the include.

» A common use for — T is to specify only the filename in the DMC source code and use the preprocessor
argument during download to specify the path to the files. This allows the files to be moved without a change
to source code.

» Search order

1. The ##include argument is checked first as-is.
2. Then each —I argument in the preprocessor argument, in the order specified.

3. Then ##option directives in the DMC file, in the order specified.

« If the search path contains spaces, enclose the path in double quotes, escaped with a backslash. See
example below.

In-band Example

##option "-I /code/dmc/homing"

##option "-I \"/code/dmc/other code\""
##include "auto.dmc"

//executable’s directory will be checked
//then c:\code\dmc\homing

//then c:\code\dmc\other code
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Macro Definition, ——define, -D

+ ——define provides a way to substitute one token for another. This is useful for writing code that is generic
until program download. Wherever the token is found in code, it is substituted by the replacement. The
replacement occurs right before code compression.

e —D is shorthand for -——define.

» The token should consist of a starting backslash character, followed by upper or lower case alphanumeric
characters, underscores, and an ending backslash.

» The common usage for this feature is to write code with a token, and then call the program download with the
-D switch.

In this example, an axis is defined at download time. Specifying the following for the preprocessor argument
--define \ax\:A
would cause the following code

SH\ax\
JG\ax\=1000
BG\ax\

to be downloaded as

SHA
JGA=1000
BGA

This causes the A axis to be addressed.
Note

The macro \pid\ is reserved for exclusive use by GDK.

Conditional Directives, ——1 fdef, ——ifndef

To specify a preprocessor directive should be executed only if a macro is defined, use ——ifdef.

##option "--ifdef \minify\ --min 4" //maximally compress code if minify macro set

To specify a preprocessor directive should be executed only if a macro is NOT defined, use ——ifndef.

##option "-—ifndef \axis\ -D \axis\:A" //Default to axis A

GDK Support

» See the preprocessor text box in the Editor settings page to set the desired preprocessor setting for
developing in GDK's editor.

4.3 Thread Safety

The Basics

» The easiest way to multithread, and/or to use multiple applications to access the same hardware, is to com-
municate through gcaps.

* Just leave out —d and ——direct in your GOpen() address and gcaps will be used.

+ Each thread, and each application, should use their own GCon handle. In the higher-level Language Support,
each thread or application should manage their own gclib object. Don't pass the connection handle between
threads.
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The Formalism

gclib supports multi-threaded operation with the following operational definitions.

gclib is "reentrant”

Reentrant means that a given gclib function call may be invoked in multiple threads when passed distinct arguments.
For example, GCommand() may be called simultaneously in different threads so long as the following arguments
have unique values, indicating they point to uniqgue memory.

+ GCon g, the connection must be unique.
+ GBufOut buf fer, the writable buffer must be unique.

» GSize * bytes_returned, the writable value must be unique.

gclib is not "thread-safe"

Thread safety would imply that a given gclib function call could be invoked in multiple threads when passed the same
arguments. This mode of operation is not supported by gclib. In other words, it is not safe to call GCommand()
simultaneously in different threads if any mutable arguments point to the same memory.

In short, it is not safe to call GCommand() in multiple threads to the same physical connection.

If such operation is required, it is the user's responsibility to use a mutual exclusion (mutex) or other mechanism to
protect memory.

Multi-threaded access to the same connection with gcaps

gcaps provides a multiplexing capability to Galil hardware. When using gcaps, it is therefore safe to call
GCommand() in multiple threads to the same physical connection (though not the same GCon value). gclib can
connect multiple times to the same Galil connection through gcaps. Because the GCon variable is unique, the
reentrant capability of gclib can be used to communicate to the same physical connection through gcaps.

4.4 Galil Widgets

Note

gclib provides the communications foundation for the Galil Widgets project. Galil Widgets are a collection of
.Net WinForms User Controls that provide quick development of custom graphical user interfaces (GUIs) that
communicate with Galil Motion Controllers and PLCs.

Galil Widgets has been designed to support three general user needs
The software novice, or the hurried prototyper
Within minutes, a full Ul can be laid out. All controls can be configured with menus and mouse clicks for an absolute

minimum requirement for writing code. The quick start guide, and Microsoft Visual Studio Express is all that is
needed to make a free application GUI with minimal effort.

The .Net developer, adding to pre-existing code.

In addition to the point-and-click configuration of the tools, each tool has a set of public function calls and properties
which allows the C# or VB.Net user the ability to integrate the Galil Widgets into a .Net application with ease.
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The power user

The entire Galil Widgets source code is available in the installation package. This allows users to tweak, extend,
and add Widgets to the library with ease. The "GalilWidget" interface defines a number of function calls that new
Widgets should implement to function correctly.

The following widgets are currently available

* GWComs: Communications to Galil hardware including event-driven handling of asynchronous traffic.
* GWTerm: A terminal for direct user interaction with the hardware.
* GWPol1l: A polling tool to display important data on screen.

*+ GWSettings A tool for displaying, editing, backing up, and restoring controller parameters and mission-
critical variables. Program backup and loading, and firmware upgrades are also supported.

* GWDhatRec: A data record visualization tool. Used to display controller status through user-configurable
labels, "soft LEDs", and analog sliders.

For more information, get the free Galil Widgets package

Seethe Galil Widgets release notes for changes.

Screen shots of an example motion controller configuration (left), and a similar RIO configuration (right)

4.5 Rebuilding gclibo

gclib ships with a compiled version of the open source portion, gclibo. However, if a source modification is desired,
the following instructions will help with recompiling this portion of the library.

Windows

For brevity, these instructions assume the default installation location of C:\Program Files (x86)\Galil\gclib and a
build type of x86 (win32). The following instructions were performed on Visual Studio Professional 2015 and can
be extended to other Visual Studio versions.

Preparation
Create a working directory. A convenient, empty, writable location, e.g.

C:\>mkdir %$homepath%\Desktop\temp

Note

In this documentation, a single greater-than character (>) will indicate a command prompt at this working
directory.

Recompiling gclibo requires the source code for the open source compression library zlib. This can be downloaded
from the zlib website: https://www.zlib.net/. Extract the downloaded zlib source files to the working
directory.

Open V52015 x86 Native Tools Command Prompt and navigate to the working directory.
C:\Program Files (x86)\Microsoft Visual Studio 14.0\VC>cd %homepath%\Desktop\temp

C:\Users\user\Desktop\temp>dir /b
z1lib-1.2.11
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Copy files

Set an environment variable for the base path.

>set base="C:\Program Files (x86)\Galil\gclib"

Set an environment variable for the zlib base path.

>set zlib="%CD%\zlib-1.2.11"

Copy the gclibo source files.

>copy %base%\source\gclibo\x.c

C:\Program Files (x86)\Galil\gclib\source\gclibo\arrays.c

C:\Program Files (x86)\Galil\gclib\source\gclibo\gclibo.c
2 file(s) copied.

Modify source
Make any necessary changes. For this example, the Glinfo() function was changed from

GReturn GCALL GInfo (GCon g, GCStringOut info,
GSize info_len)
{
~turn GUtility (g, G_UTIL_INFO, info, &info_len);
}

to

GReturn GCALL GInfo (GCon g, GCStringOut info,
GSize info_len)
{
strncpy (info, "My controller", info_len);
return G_NO_ERROR;
//return GUtility (g, G_UTIL_INFO, info, &info_len);
}

Compile and copy

Compile the source code.

>cl -c *.c %z1lib%\*x.c -I %base%\include -I %z1lib% -DBUILDING_GCLIB

Link the binaries.

>link /DLL *.obj %base%\lib\dynamic\x86\gclib.lib /OUT:gclibo.dll

Copy

Copy back to the installation location from the file explorer. This will require administrator privileges.

» Copy gclibo.lib to "C:\Program Files (x86)\Galil\gclib\lib\dynamic\x86"

» Copy gclibo.dll to "C:\Program Files (x86)\Galil\gclib\dI\x86"

Test

Copy simple example

>copy %$base%\examples\cpp\x_simple.c
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Edit GOpen() call as necessary.
Compile

>cl x_simple.c %base$\lib\dynamic\x86\x.1lib -I %base%\include

Set Path to DLL

>set PATH=%base%\dl1l\x86\; $PATH%

Execute

>x_simple.exe

rc: O

version: 85.60.138
rc: O

rc: O

info: My controller
rc: O

response: 355000958.0000

Linux

Recompiling gclibo requires the source code for the open source compression library zlib. This can be dowloaded
from the zlib website: https://www.zlib.net /. Extract the downloaded zlib source files to a known folder,
e.g. ~/Downloads/zlib-1.2.11.

Copy files

$ mkdir test

$ cd test

$ tar -xvf /usr/share/doc/gclib/src/gclibo_src.tar.gz
gclibo.h

gclibo.c

arrays.c

makefile_gclibo

$ cp /usr/include/gclibx.h

$ 1s

arrays.c gclib.h gclibo.h makefile_gclibo
gclib_errors.h gclibo.c gclib_record.h

$ cp ~/Downloads/zlib-1.2.11/x.h

$ cp ~/Downloads/zlib-1.2.11/%.c

Modify source
Make any necessary changes. For this example, the Ginfo() function was changed from

GReturn GCALL GInfo (GCon g, GCStringOut info,
GSize info_len)
{
»turn GUtility(g, G_UTIL_INFO, info, &info_len);
}

to

GReturn GCALL GInfo (GCon g, GCStringOut info,
GSize info_len)
{
strncpy (info, "My controller", info_len);
urn G_NO_ERROR;
//return GUtility(g, G_UTIL_INFO, info, &info_len);
}
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Make and install

$ make —-f makefile gclibo
Open source component, libgclibo.so.0.0
Compiling open source component.

gcc -c -Wall -Werror —-fPIC -fvisibility=hidden -DBUILDING_GCLIB -DHAVE_VISIBILITY *.cC

Linking open source component into shared library.
gcc -shared -o libgclibo.so0.0.0 *.o -Wl,-soname=libgclibo.so.0
strip --strip-unneeded libgclibo.so0.0.0
Cleaning up.
$ sudo make install -f makefile_gclibo
Installing libgclibo.so.0.0
install -m 755 libgclibo.so.0.0 /usr/lib
ldconfig
$ make clean -f makefile_gclibo
Cleaning project...

Test

Extract simple example

$ tar -xzf /usr/share/doc/gclib/src/gclib_examples.tar.gz x_simple.c

Edit GOpen() call as necessary.
Compile

$ gcc x_simple.c -Wall -Werror -lgclib -lgclibo -o simple

Execute

$ ./simple

rc: O

version: 85.60.131

rc: O

rc: 0

info: My controller

rc: O

response: 182879322.0000

0SX

Copy files

mkdir test

cd test

tar -xvf /Applications/gclib/source/gclibo_src.tar.gz x gclibo.h
gclibo.c

arrays.c

makefile_gclibo

cp /Applications/gclib/include/*

cp /Applications/gclib/dylib/gclib.0.dylib

1s

arrays.c gclib.h gclib_record.h gclibo.h
gclib.0.dylib gclib_errors.h gclibo.c makefile_gclibo

L XX X W

Modify source
Make any necessary changes. For this example, the Ginfo() function was changed from

GReturn GCALL GInfo (GCon g, GCStringOut info,
GSize info_len)

{
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return GUtility (g, G_UTIL_INFO, info, &info_len);

to

GReturn GCALL GInfo (GCon g, GCStringOut info,
GSize info_len)
{
strncpy (info, "My controller", info_len);
>turn G_NO_ERROR;
//return GUtility (g, G_UTIL_INFO, info, &info_len);
}

Make and install

$ make —-f makefile_gclibo
Open source component, gclibo.0.dylib
Compiling open source component.
gcc -c -Wall -Werror —-fPIC -fvisibility=hidden -DBUILDING_GCLIB -DHAVE_VISIBILITY «*.cC
Linking open source component into shared library.
gcc —-dynamiclib -o gclibo.0.dylib *.o0 gclib.0.dylib
strip -u -r gclibo.0.dylib
Cleaning up.
$ make install —-f makefile_gclibo
Installing gclibo.0.dylib
cp gclibo.0.dylib /Applications/gclib/dylib
$ make clean -f makefile_gclibo
Cleaning project...

Test

Extract simple example

$ tar —-xzf /Applications/gclib/examples/gclib_examples.tar.gz x_simple.c

Edit GOpen() call as necessary.
Compile

$ gcc x_simple.c -Wall -Werror gclib.0.dylib gclibo.0.dylib -o simple

Execute

$ ./simple

rc: 0

version: 127.110.253

rc: O

rc: 0

info: My controller

rc: 0

response: 182879322.0000

4.6 Software Licenses
For purposes of licensing, gclib is broken into two categories.

1. The closed source portion is covered under the Closed Source License. This covers the binaries created for
the gclib.h interface.

2. The open source portion and all examples and wrappers are covered under the Open Source License.
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The informal software licenses are provided to describe the user's responsibilities in a format that is easy to read
and understand. If more legal verbiage is required or if any questions arise regarding the following details, please
contact Galil for clarification.

4.6.1 Closed Source License

Copyright (c) 2016, Galil Motion Control

Galil C Library (gclib) Closed Source Software License - January 4, 2016

This informal software license is provided to describe the user's responsibilities in a format that is easy to read
and understand. If more legal verbiage is required or if any questions arise regarding the following details, please
contact Galil for clarification.

This license includes the closed source portion of the gclib, defined by the header file gclib.h as outlined in the
accompanying documentation (the docs).

Galil hereby grants the following:

The closed source portion may be freely copied and used for any Galil application, commercial and non-commercial
in an unmodified format, unless such modifications are detailed in the docs.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, IN«
CLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANY+«
ONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN

CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Galil Motion Control
270 Technology Way
Rocklin, CA 95765, USA
support@galilmc.com

1 (800) 377-6329

1 (916) 626-0102
www.galil.com

4.6.2 Open Source License

Copyright (c) 2016, Galil Motion Control

Galil C Library (gclib) Open Source Software License - January 4, 2016

This informal software license is provided to describe the user's responsibilities in a format that is easy to read
and understand. If more legal verbiage is required or if any questions arise regarding the following details, please
contact Galil for clarification.

This license includes the open source portions of the gclib, as well as examples and wrappers as outlined in the
accompanying documentation (the docs).

Galil hereby grants the following:

The open source portions, examples, and wrappers may be freely copied, used, and modified for any Galil applica-
tion, commercial and non-commercial provided that:

(1) This license appears with all copies, including modifications, of the software source code.

(2) Modified files must be commented at the top of the file with the original Galil version number and the author of
the modifications.
(3) This license NEED NOT appear with binaries or executables if the source code is not included.

THE SOFTWARE IS PROVIDED "AS 1S", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, IN«
CLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
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PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANY:-
ONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE
OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Galil Motion Control
270 Technology Way
Rocklin, CA 95765, USA
support@galilmc.com

1 (800) 377-6329

1 (916) 626-0102
www.galil.com

4.7 Legacy Compatibility

+ GalilTools included the GCL (GalilTools Communication Library). gclib ships with an open source wrapper
implementation of the GCL.

+ DMC32 OSU is intended for existing applications that used software based on the legacy DMCWIN32 library
for Windows XP and earlier.

4,71 GalilTools

To provide maximum compatibility, gclib ships with an open source wrapper implementation of the GCL (GalilTools
Communication Library). Users wanting to upgrade to gclib that have source built on Galil.h can use this wrapper to
minimize source changes. This wrapper is also indicated for users that want the same function calls as Galil.h, but
don't want the usage of OT as in galil1.dll.

This wrapper is intended for existing applications already using the library distributed with GalilTools
(galil1.dll) or the previous STL library (galil2.dll). New applications should be written with gclib.

Windows

Compile galil2.dll with MSVC 2013

The following instructions were performed on Visual Studio Professional 2013 and can be extended to other Vi-
sual Studio versions. For brevity, the instructions assume the default installation location of C:\Program Files
(x86)\Galil\gclib and a build type of x86 (win32).

Launch the compiler command prompt

* Open V52013 x86 Native Tools Command Prompt.

» Navigate to a convenient, writable location, e.g. C:\temp.

Set an environment variable for the base path

C:\temp>set base=C:\Program Files (x86)\Galil\gclib

Compile the source code

Note the quotes.

C:\temp>cl -c "%$base%\source\wrappers\gcl\x.cpp" -I "%base%\include" -EHsc -MD
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Link the source code

Note the quotes.

C:\temp>link /DLL gcl_datarecord.obj gcl_galil.obj "%$base%\lib\dynamic\x86\gclib.lib" "%$base%$\lib\dynamic\x86\

The output files galil2.dll and galil2.lib can now be used in a project using the GCL.

Test

Help the loader find the right dlls.

C:\temp>set PATH=%PATHS;%BASE3\d11\x86

Link the simple example.

C:\temp>link gcl_simple.obj "$base%\lib\dynamic\x86\gclib.lib" "$base%\lib\dynamic\x86\gclibo.lib" galil2.lib
Run the example.

C:\temp>simple.exe
Galil2.dll wrapper, gclib 106.75.180
10.1.3.169, DMC4020 Rev 1.2c, 291

Linux

Copy files

$ tar -xzf /usr/share/doc/gclib/src/gclib_gcl.tar.gz
$ 1s

Galil.h gcl_galil.cpp gcl_simple.cpp

gcl_datarecord.cpp gcl_galil.h makefile

Make and install

$ make
gcl open source wrapper for gclib
Compiling wrapper, libgalil.so.2.0
gt+ —-c —fPIC -std=c++11 gcl_datarecord.cpp gcl_galil.cpp
Linking wrapper into shared library.
gt++ -shared -o libgalil.so.2.0 x.o -Wl,-soname=libgalil.so.2
strip --strip-unneeded libgalil.so.2.0
Cleaning up.
$ sudo make install
Installing libgalil.so.2.0
install -m 755 libgalil.so.2.0 /usr/lib
install -m 644 Galil.h /usr/lib
ldconfig
In -s /usr/lib/libgalil.so.2 /usr/lib/libgalil.so
$ make clean
Cleaning project...

Test

$ g++ gcl_simple.cpp -lgalil -lgclib -lgclibo -o simple
$ ./simple

Galil2.dll wrapper, gclib 95.71.164

10.1.3.169, DMC4020 Rev 1.2c, 291
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4.7.2 DMC32 OSU

Note

gclib provides the communications foundation for the DMC32 Operating System Upgrade (OSU) project.

DMC32 OSU is intended for existing applications that used software based on the legacy DMCWIN32 library for
Windows XP and earlier. If such an application must be upgraded to Windows 7, 8, or 8.1, DMC32 OSU may be
used on these O.S. upgrades.

Galil's Windows XP support statement, ht tp://www.galil.com/about/xp—-support

» For more information refer to the documentation, http: //www.galil.com/sw/pub/all/doc/dmc320su/html/ir
html

+ See the release notes for changes, http://www.galil.com/sw/pub/all/rn/dmc32o0su.html

» The installer is available for download from Galil's website, http://www.galil.com/sw/pub/win/dmc320su/gali’
_dmc32_osu_exe.html
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Chapter 5

Data Structure Index

5.1

Data Structures

Here are the data structures with brief descriptions:

GDataRecord

Data record union, containing all structs and a generic byte array accessor . . . . . . ... .. 69
GDataRecord1802 . . . . . . . e e e 70
GDataRecord1806

Data record struct for DMC-1806 controller . . . . . . . . . . . . . . .. .. ... . .. ... 73
GDataRecord2103

Data record struct for DMC-2103 controllers . . . . . . . . . . . . . .. .. ... ... .. .. 80
GDataRecord30000

Data record struct for DMC-30010 controllers . . . . . . . . . . . .. . . ... 85
GDataRecord4000

Data record struct for DMC-4000 controllers, including 4000, 4200, 4103, and 500x0 . . . . . . 86
GDataRecord47000 _ENC

Data record struct for RIO-471xx and RIO-472xx PLCs. Includes encoder fields . . . . . . .. 93
GDataRecord47300_24EX

Data record struct for RIO-47300 with 24EX I/O daughterboard . . . . . . . . . . .. ... .. 94
GDataRecord47300_ENC

Data record struct for RIO-47300. Includes encoderfields . . . . . . ... ... ... ... .. 96
GDataRecord52000

Data record struct for DMC-52000 controller. Same as DMC-4000, with bank indicator added at

byte 40 . . . L e e e 98

H_ArrayData
Structure to create a linked listforarraydata . . . . . . .. ... .. ... ... .. 104
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Chapter 6

File Index

6.1 File List

Here is a list of all documented files with brief descriptions:

AITAYS.C . v v o e e e e e e e e e e e e 107
gelib.h o e 111
gelib_errors.h . L L e 125
gelib_record.h . . . L 127
gelibo.C . L e 128

gelibo.h o 137
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Data Structure Documentation

7.1 GDataRecord Union Reference

Data record union, containing all structs and a generic byte array accessor.

#include <gclib_record.h>

Data Fields

 struct GDataRecord4000 dmc4000

The DMC-4000 data record.
 struct GDataRecord4000 dmc4103

The DMC-4103 data record.
 struct GDataRecord4000 dmc50000

The DMC-50000 data record.
» struct GDataRecord52000 dmc52000

The DMC-52000 data record.
» struct GDataRecord30000 dmc30000

The DMC-30000 data record.
« struct GDataRecord2103 dmc2103

The DMC-21x3 data record.
 struct GDataRecord1806 dmc1806

The DMC-1806 data record.
» struct GDataRecord1802 dmc1802

The DMC-1802 data record.
 struct GDataRecord47000_ ENC rio47000

The RIO-471xx & 472xx data record, including encoder support.
 struct GDataRecord47300 ENC rio47300

The RIO 473xx data record, including encoder support.
» struct GDataRecord47300_24EX rio47300_24ex

The RIO 473xx data record, with 24EXOUT/24EXIN support.
+ unsigned char byte_array [GALILDATARECORDMAXLENGTH]

Generic byte array for offsets.
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7.1.1 Detailed Description

Data record union, containing all structs and a generic byte array accessor.

Named structs can be used to access typed data by name. Offsets into the data record can also be used by
referencing the member byte_array.

//Getting the sample counter for the DMC-4000.
cout << data_record->dmc4000.sample_number << ’\n’; //access by 4000 product
cout << *x ((unsigned short x) (data_record->byte_array + 4)) << ’\rx’; //access by pointer arithmetic

Definition at line 1029 of file gclib_record.h.

The documentation for this union was generated from the following file:

* gclib_record.h

7.2 GDataRecord1802 Struct Reference

#include <gclib_record.h>

Data Fields

* UW sample_number

sample number.
+ UB input_bank_0

general input bank 0 (inputs 1-8).
+ UB input_bank_1

general input bank 1 (inputs 9-16).
+ UB input_bank_2

general input bank 2 (inputs 17-24).
« UB input_bank_3

general input bank 3 (inputs 25-32).
* UBinput_bank_4

general input bank 4 (inputs 33-40).
* UBinput_bank_5

general input bank 5 (inputs 41-48).
+ UB input_bank_6

general input bank 6 (inputs 49-56).
* UBinput_bank_7

general input bank 7 (inputs 57-64).
+ UB input_bank_8

general input bank 8 (inputs 65-72).
+ UB input_bank_9

general input bank 9 (inputs 73-80).
» UB output_bank_0

general output bank 0 (outputs 1-8).
» UB output_bank_1

general output bank 1 (outputs 9-16).
+ UB output_bank_2

general output bank 2 (outputs 17-24).
* UB output_bank_3

general output bank 3 (outputs 25-32).
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» UB output_bank_4

general output bank 4 (outputs 33-40).
« UB output_bank_5

general output bank 5 (outputs 41-48).
* UB output_bank_6

general output bank 6 (outputs 49-56).
» UB output_bank_7

general output bank 7 (outputs 57-64).
* UB output_bank_8

general output bank 8 (outputs 65-72).
* UB output_bank_9

general output bank 9 (outputs 73-80).
» UB error_code

error code.
+ UB general_status

general status
+ UW s_plane_segment_count

segment count of coordinated move for S plane.
« UW s_plane_move_status

coordinated move status for S plane.
« SL s distance

distance traveled in coordinated move for S plane.

+ UWt_plane_segment_count

segment count of coordinated move for T plane.
+ UWt_plane_move_status

Coordinated move status for T plane.
« SLt distance

distance traveled in coordinated move for T plane.

 UW axis_a_status
A axis status.

* UB axis_a_switches
A axis switches.

+ UB axis_a_stop_code
A axis stop code.

» SL axis_a_reference_position
A axis reference position.

» SL axis_a_motor_position
A axis motor position.

» SL axis_a_position_error
A axis position error.

» SL axis_a_aux_position
A axis auxiliary position.

» SL axis_a_velocity
A axis velocity.

* SW axis_a_torque
A axis torque.

* UB axis_a_reserved 0
Reserved.

* UB axis_a_reserved_1
Reserved.

« UW axis_b_status
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B axis status.
UB axis_b_switches

B axis switches.
UB axis_b_stop_code

B axis stop code.
SL axis_b_reference_position

B axis reference position.
SL axis_b_motor_position

B axis motor position.
SL axis_b_position_error
B axis position error.

SL axis_b_aux_position

B axis auxiliary position.
SL axis_b_velocity
B axis velocity.
SW axis_b_torque
B axis torque.
UB axis_b_reserved 0
Reserved.
UB axis_b_reserved_1

Reserved.
UW axis_c_status

C axis status.
UB axis_c_switches

C axis switches.
UB axis_c_stop_code

C axis stop code.
SL axis_c_reference_position
C axis reference position.
SL axis_c_motor_position
C axis motor position.
SL axis_c_position_error
C axis position error.
SL axis_c_aux_position
C axis auxiliary position.
SL axis_c_velocity
C axis velocity.
SW axis_c_torque
C axis torque.
UB axis_c_reserved_0

Reserved.
UB axis_c _reserved 1

Reserved.
UW axis_d_status

D axis status.
UB axis_d_switches

D axis switches.
UB axis_d_stop_code

D axis stop code.
SL axis_d_reference_position

D axis reference position.
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» SL axis_d_motor_position
D axis motor position.

» SL axis_d_position_error
D axis position error.

» SL axis_d_aux_position
D axis auxiliary position.

» SL axis_d_velocity
D axis velocity.

* SW axis_d_torque
D axis torque.

* UB axis_d reserved 0

Reserved.
* UB axis_d reserved 1

Reserved.

7.2.1 Detailed Description

Data record struct for DMC-1802 controllers.

The 18x2 Data record is the Same as 2103 except the following.

1. No header bytes. Software removes it from QR.

2. No analog in axis data.

Definition at line 726 of file gclib_record.h.

The documentation for this struct was generated from the following file:

* gclib_record.h

7.3 GDataRecord1806 Struct Reference

Data record struct for DMC-1806 controller.

#include <gclib_record.h>

Data Fields

* UW sample_number

sample number.
+ UB input_bank_0

general input bank 0 (inputs 1-8).
» UB input_bank_1

general input bank 1 (inputs 9-16).
« UB input_bank_2

general input bank 2 (inputs 17-24).
« UB input_bank_3

general input bank 3 (inputs 25-32).
* UBinput_bank_4

general input bank 4 (inputs 33-40).
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UB input_bank_5

general input bank 5 (inputs 41-48).
UB input_bank_6

general input bank 6 (inputs 49-56).
UB input_bank_7

general input bank 7 (inputs 57-64).
UB input_bank_8

general input bank 8 (inputs 65-72).
UB input_bank_9

general input bank 9 (inputs 73-80).
UB output_bank_0

general output bank 0 (outputs 1-8).
UB output_bank_1

general output bank 1 (outputs 9-16).
UB output_bank_2

general output bank 2 (outputs 17-24).

UB output_bank_3

general output bank 3 (outputs 25-32).

UB output_bank_4

general output bank 4 (outputs 33-40).

UB output_bank_5

general output bank 5 (outputs 41-48).

UB output_bank_6

general output bank 6 (outputs 49-56).

UB output_bank_7

general output bank 7 (outputs 57-64).

UB output_bank_8

general output bank 8 (outputs 65-72).

UB output_bank_9

general output bank 9 (outputs 73-80).

SW reserved_0
Reserved.

SW reserved_2
Reserved.

SW reserved 4
Reserved.

SW reserved_6
Reserved.

SW reserved_8
Reserved.

SW reserved_10
Reserved.

SW reserved_12
Reserved.

SW reserved_14
Reserved.

UB reserved_16
Reserved.

UB reserved_17

Reserved.
UB reserved_18
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Reserved.
* UBreserved 19

Reserved.
* UBreserved 20

Reserved.
» UBreserved_ 21

Reserved.
» UBreserved 22

Reserved.
* UBreserved 23

Reserved.
* UB error_code

error code.
* UB thread_status

thread status.
* UL reserved 24

Reserved.
» UL contour_segment_count

Segment Count for Contour Mode.
* UW contour_buffer_available

Buffer space remaining, Contour Mode.
+ UW s_plane_segment_count

segment count of coordinated move for S plane.
* UW s_plane_move_status

coordinated move status for S plane.
« SL s _distance

distance traveled in coordinated move for S plane.
+ UW s_plane_buffer_available

Buffer space remaining, S Plane.
+ UWt_plane_segment_count

segment count of coordinated move for T plane.
+ UWt_plane_move_status

Coordinated move status for T plane.
« SLt distance

distance traveled in coordinated move for T plane.
+ UWt_plane_buffer_available

Buffer space remaining, T Plane.
« UW axis_a_status

A axis status.
« UB axis_a_switches

A axis switches.
+ UB axis_a_stop_code

A axis stop code.
» SL axis_a_reference_position

A axis reference position.
» SL axis_a_motor_position

A axis motor position.
» SL axis_a_position_error

A axis position error.
» SL axis_a_aux_position

A axis auxiliary position.
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SL axis_a_velocity
A axis velocity.
SL axis_a_torque
A axis torque.
UW axis_a_analog_in
A axis analog input.
UB axis_a_reserved_0
Reserved.
UB axis_a_reserved_1
Reserved.
SL axis_a_variable
A User-defined variable (ZA).
UW axis_b_status
B axis status.
UB axis_b_switches
B axis switches.
UB axis_b_stop_code
B axis stop code.
SL axis_b_reference_position
B axis reference position.
SL axis_b_motor_position
B axis motor position.
SL axis_b_position_error
B axis position error.
SL axis_b_aux_position
B axis auxiliary position.
SL axis_b_velocity
B axis velocity.
SL axis_b_torque
B axis torque.
UW axis_b_analog_in
B axis analog input.
UB axis_b_reserved 0
Reserved.
UB axis_b_reserved_1
Reserved.
SL axis_b_variable
B User-defined variable (ZA).
UW axis_c_status
C axis status.
UB axis_c_switches
C axis switches.
UB axis_c_stop_code
C axis stop code.
SL axis_c_reference_position
C axis reference position.
SL axis_c_motor_position
C axis motor position.
SL axis_c_position_error
C axis position error.
SL axis_c_aux_position
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C axis auxiliary position.
» SL axis_c_velocity
C axis velocity.
» Sl axis_c_torque
C axis torque.
+ UW axis_c_analog_in
C axis analog input.
» UB axis_c_reserved_0
Reserved.
» UB axis_c_reserved_1
Reserved.
» SL axis_c_variable
C User-defined variable (ZA).
* UW axis_d_status
D axis status.
* UB axis_d_switches
D axis switches.
+ UB axis_d_stop_code
D axis stop code.
» SL axis_d_reference_position
D axis reference position.
» SL axis_d_motor_position
D axis motor position.
» SL axis_d_position_error
D axis position error.
» SL axis_d_aux_position
D axis auxiliary position.
» SL axis_d_velocity
D axis velocity.
» SL axis_d_torque
D axis torque.
+ UW axis_d_analog_in
D axis analog input.
* UB axis_d reserved 0
Reserved.
» UB axis_d_reserved_1
Reserved.
« SL axis_d_variable
D User-defined variable (ZA).
+ UW axis_e_status
E axis status.
« UB axis_e switches
E axis switches.
» UB axis_e_stop_code
E axis stop code.
» SL axis_e_reference_position
E axis reference position.
» SL axis_e_motor_position
E axis motor position.
» SL axis_e_position_error

E axis position error.
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SL axis_e_aux_position
E axis auxiliary position.
SL axis_e_velocity
E axis velocity.
SL axis_e_torque
E axis torque.
UW axis_e_analog_in
E axis analog input.
UB axis_e reserved 0
Reserved.
UB axis_e reserved_1
Reserved.
SL axis_e_variable
E User-defined variable (ZA).
UW axis_f_status
F axis status.
UB axis_f switches
F axis switches.
UB axis_f stop_code
F axis stop code.
SL axis_f_reference_position
F axis reference position.
SL axis_f_motor_position
F axis motor position.
SL axis_f_position_error
F axis position error.
SL axis_f_aux_position
F axis auxiliary position.
SL axis_f_velocity
F axis velocity.
SL axis_f_torque
F axis torque.
UW axis_f _analog_in
F axis analog input.
UB axis_f reserved 0
Reserved.
UB axis_f reserved 1
Reserved.
SL axis_f variable
F User-defined variable (ZA).
UW axis_g_status
G axis status.
UB axis_g_switches
G axis switches.
UB axis_g_stop_code
G axis stop code.
SL axis_g_reference_position
G axis reference position.
SL axis_g_motor_position
G axis motor position.
SL axis_g_position_error
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G axis position error.
» SL axis_g_aux_position

G axis auxiliary position.
+ SL axis_g_velocity

G axis velocity.
» SL axis_g_torque

G axis torque.
+ UW axis_g_analog_in

G axis analog input.
+ UB axis_g_reserved_0

Reserved.
+ UB axis_g_reserved_1

Reserved.
» SL axis_g_variable

G User-defined variable (ZA).
« UW axis_h_status

H axis status.
« UB axis_h_switches

H axis switches.
» UB axis_h_stop_code

H axis stop code.
» SL axis_h_reference_position

H axis reference position.
» SL axis_h_motor_position

H axis motor position.
» SL axis_h_position_error
H axis position error.
» SL axis_h_aux_position
H axis auxiliary position.
» SL axis_h_velocity
H axis velocity.
» SL axis_h_torque
H axis torque.
+ UW axis_h_analog_in
H axis analog input.
* UB axis_h reserved 0

Reserved.
* UB axis_h reserved 1

Reserved.
» SL axis_h_variable

H User-defined variable (ZA).
7.3.1 Detailed Description

Data record struct for DMC-1806 controller.

The 18x6 Data record is the same as 4000 except the following.

1. No header bytes. Firmware strips it in DR. Software removes it from QR.

2. No Ethernet status (bytes 42-49).
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3. No amplfifier status (bytes 52-55).

4. No axis-specific hall input status.

Definition at line 408 of file gclib_record.h.

The documentation for this struct was generated from the following file:

* gclib_record.h

7.4 GDataRecord2103 Struct Reference

Data record struct for DMC-2103 controllers.

#include <gclib_record.h>

Data Fields

* UB header 0

1st Byte of Header.
« UB header_1

2nd Byte of Header.
* UB header 2

3rd Byte of Header.
* UB header_3

4th Byte of Header.
* UW sample_number

sample number.
« UB input_bank_0

general input bank 0 (inputs 1-8).
+ UB input_bank_1

general input bank 1 (inputs 9-16).
+ UBinput_bank_2

general input bank 2 (inputs 17-24).
+ UB input_bank_3

general input bank 3 (inputs 25-32).
* UB input_bank_4

general input bank 4 (inputs 33-40).
* UB input_bank_5

general input bank 5 (inputs 41-48).
+ UB input_bank_6

general input bank 6 (inputs 49-56).
+ UB input_bank_7

general input bank 7 (inputs 57-64).
« UB input_bank_8

general input bank 8 (inputs 65-72).
« UB input_bank_9

general input bank 9 (inputs 73-80).
* UB output_bank_0

general output bank 0 (outputs 1-8).
+ UB output_bank_1

general output bank 1 (outputs 9-16).
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» UB output_bank_2

general output bank 2 (outputs 17-24).
« UB output_bank_3

general output bank 3 (outputs 25-32).
* UB output_bank_4

general output bank 4 (outputs 33-40).
* UB output_bank_5

general output bank 5 (outputs 41-48).
* UB output_bank_6

general output bank 6 (outputs 49-56).
» UB output_bank_7

general output bank 7 (outputs 57-64).
* UB output_bank_8

general output bank 8 (outputs 65-72).
* UB output_bank_9

general output bank 9 (outputs 73-80).
* UB error_code

error code.
+ UB general_status

general status
+ UW s_plane_segment_count

segment count of coordinated move for S plane.
+ UW s_plane_move_status

coordinated move status for S plane.
« SL s distance

distance traveled in coordinated move for S plane.

+ UW t_plane_segment_count

segment count of coordinated move for T plane.
« UWt_plane_move_status

Coordinated move status for T plane.
« SLt distance

distance traveled in coordinated move for T plane.

 UW axis_a_status
A axis status.

* UB axis_a_switches
A axis switches.

+ UB axis_a_stop_code
A axis stop code.

» SL axis_a_reference_position
A axis reference position.

+ SL axis_a_motor_position
A axis motor position.

» SL axis_a_position_error
A axis position error.

» SL axis_a_aux_position
A axis auxiliary position.

» SL axis_a_velocity
A axis velocity.

» SW axis_a_torque
A axis torque.

+ UW axis_a_analog_in
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A axis analog input.
UW axis_b_status

B axis status.
UB axis_b_switches

B axis switches.
UB axis_b_stop_code

B axis stop code.
SL axis_b_reference_position

B axis reference position.
SL axis_b_motor_position
B axis motor position.

SL axis_b_position_error
B axis position error.
SL axis_b_aux_position
B axis auxiliary position.
SL axis_b_velocity
B axis velocity.
SW axis_b_torque
B axis torque.
UW axis_b_analog_in
B axis analog input.
UW axis_c_status

C axis status.
UB axis_c_switches

C axis switches.
UB axis_c_stop_code

C axis stop code.
SL axis_c_reference_position
C axis reference position.
SL axis_c_motor_position
C axis motor position.
SL axis_c_position_error
C axis position error.
SL axis_c_aux_position
C axis auxiliary position.
SL axis_c_velocity
C axis velocity.
SW axis_c_torque
C axis torque.
UW axis_c_analog_in
C axis analog input.
UW axis_d_status

D axis status.
UB axis_d_switches

D axis switches.
UB axis_d_stop_code

D axis stop code.
SL axis_d_reference_position

D axis reference position.
SL axis_d_motor_position

D axis motor position.
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» SL axis_d_position_error
D axis position error.
» SL axis_d_aux_position
D axis auxiliary position.
» SL axis_d_velocity
D axis velocity.
* SW axis_d_torque
D axis torque.
+ UW axis_d_analog_in
D axis analog input.
« UW axis_e_status
E axis status.
+ UB axis_e switches
E axis switches.
+ UB axis_e_stop_code
E axis stop code.
» Sl axis_e_reference_position
E axis reference position.
+ SL axis_e_motor_position
E axis motor position.
» SL axis_e_position_error
E axis position error.
» SL axis_e_aux_position
E axis auxiliary position.
» SL axis_e_velocity
E axis velocity.
* SW axis_e_torque
E axis torque.
+ UW axis_e_analog_in
E axis analog input.
« UW axis_f status
F axis status.
+ UB axis_f_switches
F axis switches.
+ UB axis_f_stop_code
F axis stop code.
+ SL axis_f_reference_position
F axis reference position.
» SL axis_f_motor_position
F axis motor position.
» SL axis_f_position_error
F axis position error.
» SL axis_f_aux_position
F axis auxiliary position.
» SL axis_f_velocity
F axis velocity.
» SW axis_f_torque
F axis torque.
+ UW axis_f_analog_in
F axis analog input.
+ UW axis_g_status
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7.4.1

Data record struct for DMC-2103 controllers.
Definition at line 585 of file gclib_record.h.

The documentation for this struct was generated from the following file:

G axis status.
UB axis_g_switches

G axis switches.
UB axis_g_stop_code

G axis stop code.
SL axis_g_reference_position

G axis reference position.
SL axis_g_motor_position

G axis motor position.
SL axis_g_position_error

G axis position error.
SL axis_g_aux_position

G axis auxiliary position.
SL axis_g_velocity

G axis velocity.
SW axis_g_torque

G axis torque.
UW axis_g_analog_in

G axis analog input.
UW axis_h_status

H axis status.
UB axis_h_switches

H axis switches.
UB axis_h_stop_code

H axis stop code.
SL axis_h_reference_position

H axis reference position.
SL axis_h_motor_position

H axis motor position.
SL axis_h_position_error
H axis position error.

SL axis_h_aux_position
H axis auxiliary position.
SL axis_h_velocity
H axis velocity.
SW axis_h_torque
H axis torque.
UW axis_h_analog_in

H axis analog input.

Detailed Description

* gclib_record.h
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7.5 GDataRecord30000 Struct Reference

Data record struct for DMC-30010 controllers.
#include <gclib_record.h>

Data Fields

« UB header 0
1st Byte of Header.
* UB header_1
2nd Byte of Header.
* UB header 2
3rd Byte of Header.
« UB header_3
4th Byte of Header.
* UW sample_number
sample number.
+ UB input_bank_0
general input bank 0 (inputs 1-8).
» UB input_bank_1
general input bank 1 (inputs 9-16).
+ UB output_bank_0
general output bank 0 (outputs 1-8).
» UB output_bank_1
general output bank 1 (outputs 9-16).
* UB error_code
error code.
» UB thread_status
thread status.
* UW input_analog_2
Analog input 2. 1 is in axis data, see axis_a_analog_in.
* UW output_analog_1
Analog output 1.
* UW output_analog_2
Analog output 2.
» UL amplifier_status
Amplifier Status.
» UL contour_segment_count
Segment Count for Contour Mode.
* UW contour_buffer_available
Buffer space remaining, Contour Mode.
+ UW s_plane_segment_count
segment count of coordinated move for S plane.
+ UW s_plane_move_status
coordinated move status for S plane.
« SL s _distance
distance traveled in coordinated move for S plane.
+ UW s_plane_buffer_available
Buffer space remaining, S Plane.
+ UW axis_a_status
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A axis status.
+ UB axis_a_switches

A axis switches.
+ UB axis_a_stop_code

A axis stop code.
» SL axis_a_reference_position

A axis reference position.
» SL axis_a_motor_position
A axis motor position.
» SL axis_a_position_error
A axis position error.
» SL axis_a_aux_position
A axis auxiliary position.
» SL axis_a_velocity
A axis velocity.
+ Sl axis_a_torque
A axis torque.
+ UW axis_a_analog_in
A axis analog input.
« UB axis_a_halls

A Hall Input Status.
* UB axis_a_reserved

Reserved.
» Sl axis_a_variable

A User-defined variable (ZA).

7.5.1 Detailed Description

Data record struct for DMC-30010 controllers.
Definition at line 817 of file gclib_record.h.

The documentation for this struct was generated from the following file:

* gclib_record.h

7.6 GDataRecord4000 Struct Reference

Data record struct for DMC-4000 controllers, including 4000, 4200, 4103, and 500x0.

#include <gclib_record.h>

Data Fields

* UB header 0

1st Byte of Header.
* UB header_1

2nd Byte of Header.
* UB header 2

3rd Byte of Header.
« UB header_3

gclib 423



7.6 GDataRecord4000 Struct Reference

87

4th Byte of Header.
* UW sample_number

sample number.
» UBinput_bank_0

general input bank 0 (inputs 1-8).
* UB input_bank_1

general input bank 1 (inputs 9-16).
» UBinput_bank_2

general input bank 2 (inputs 17-24).
* UBinput_bank_3

general input bank 3 (inputs 25-32).
» UBinput_bank_4

general input bank 4 (inputs 33-40).
+ UBinput_bank_5

general input bank 5 (inputs 41-48).
» UB input_bank_6

general input bank 6 (inputs 49-56).
* UBinput_bank_7

general input bank 7 (inputs 57-64).
+ UB input_bank_8

general input bank 8 (inputs 65-72).
+ UB input_bank_9

general input bank 9 (inputs 73-80).
» UB output_bank_0

general output bank 0 (outputs 1-8).
» UB output_bank_1

general output bank 1 (outputs 9-16).
+ UB output_bank_2

general output bank 2 (outputs 17-24).

» UB output_bank_3

general output bank 3 (outputs 25-32).

» UB output_bank_4

general output bank 4 (outputs 33-40).

» UB output_bank_5

general output bank 5 (outputs 41-48).

» UB output_bank_6

general output bank 6 (outputs 49-56).

» UB output_bank_7

general output bank 7 (outputs 57-64).

» UB output_bank_8

general output bank 8 (outputs 65-72).

» UB output_bank_9

general output bank 9 (outputs 73-80).

« SWreserved 0

Reserved.
« SWreserved 2

Reserved.
« SWreserved 4

Reserved.
« SWreserved 6

Reserved.
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SW reserved_8
Reserved.
SW reserved_10
Reserved.
SW reserved_12
Reserved.
SW reserved_14
Reserved.
UB ethernet_status_a
Ethernet Handle A Status.
UB ethernet_status b
Ethernet Handle B Status.
UB ethernet_status ¢
Ethernet Handle C Status.
UB ethernet_status_d
Ethernet Handle D Status.
UB ethernet_status e
Ethernet Handle E Status.
UB ethernet_status_f
Ethernet Handle F Status.
UB ethernet_status_g
Ethernet Handle G Status.
UB ethernet_status_h
Ethernet Handle H Status.
UB error_code
error code.
UB thread_status
thread status
UL amplifier_status
Amplifier Status.
UL contour_segment_count
Segment Count for Contour Mode.
UW contour_buffer_available
Buffer space remaining, Contour Mode.
UW s_plane_segment_count
segment count of coordinated move for S plane.
UW s_plane_move_status

coordinated move status for S plane.
SL s_distance

distance traveled in coordinated move for S plane.

UW s_plane_buffer_available
Buffer space remaining, S Plane.
UW t_plane_segment_count
segment count of coordinated move for T plane.
UW t_plane_move_status
Coordinated move status for T plane.
SL t_distance

distance traveled in coordinated move for T plane.

UW t_plane_buffer_available

Buffer space remaining, T Plane.
UW axis_a_status
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A axis status.
» UB axis_a_switches
A axis switches.
» UB axis_a_stop_code
A axis stop code.
» SL axis_a_reference_position
A axis reference position.
» SL axis_a_motor_position
A axis motor position.
» SL axis_a_position_error
A axis position error.
» SL axis_a_aux_position
A axis auxiliary position.
» SL axis_a_velocity
A axis velocity.
+ SL axis_a_torque
A axis torque.
+ UW axis_a_analog_in
A axis analog input.
+ UB axis_a_halls
A Hall Input Status.
* UB axis_a_reserved
Reserved.
« SL axis_a_variable
A User-defined variable (ZA).
« UW axis_b_status
B axis status.
* UB axis_b_switches
B axis switches.
» UB axis_b_stop_code
B axis stop code.
» SL axis_b_reference_position
B axis reference position.
» SL axis_b_motor_position
B axis motor position.
» SL axis_b_position_error
B axis position error.
» SL axis_b_aux_position
B axis auxiliary position.
« SL axis_b_velocity
B axis velocity.
« SL axis_b_torque
B axis torque.
* UW axis_b_analog_in
B axis analog input.
+ UB axis_b_halls
B Hall Input Status.
+ UB axis_b_reserved
Reserved.
« SL axis_b_variable
B User-defined variable (ZA).
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UW axis_c_status
C axis status.
UB axis_c_switches
C axis switches.
UB axis_c_stop_code
C axis stop code.
SL axis_c_reference_position
C axis reference position.
SL axis_c_motor_position
C axis motor position.
SL axis_c_position_error
C axis position error.
SL axis_c_aux_position
C axis auxiliary position.
SL axis_c_velocity
C axis velocity.
SL axis_c_torque
C axis torque.
UW axis_c_analog_in
C axis analog input.
UB axis_c_halls
C Hall Input Status.
UB axis_c_reserved
Reserved.
SL axis_c_variable
C User-defined variable (ZA).
UW axis_d_status
D axis status.
UB axis_d_switches
D axis switches.
UB axis_d_stop_code
D axis stop code.
SL axis_d_reference_position
D axis reference position.
SL axis_d_motor_position
D axis motor position.
SL axis_d_position_error
D axis position error.
SL axis_d_aux_position
D axis auxiliary position.
SL axis_d_velocity
D axis velocity.
SL axis_d_torque
D axis torque.
UW axis_d_analog_in
D axis analog input.
UB axis_d_halls
D Hall Input Status.
UB axis_d_reserved
Reserved.
SL axis_d_variable
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D User-defined variable (ZA).
+ UW axis_e_status
E axis status.
* UB axis_e_ switches
E axis switches.
» UB axis_e_stop_code
E axis stop code.
» SL axis_e_reference_position
E axis reference position.
» SL axis_e_motor_position
E axis motor position.
» SL axis_e_position_error
E axis position error.
» SL axis_e_aux_position
E axis auxiliary position.
» SL axis_e_velocity
E axis velocity.
» SL axis_e_torque
E axis torque.
+ UW axis_e_analog_in
E axis analog input.
+ UB axis_e_halls
E Hall Input Status.
» UB axis_e_reserved
Reserved.
» SL axis_e_variable
E User-defined variable (ZA).
* UW axis_f_status
F axis status.
+ UB axis_f_switches
F axis switches.
+ UB axis_f_stop_code
F axis stop code.
» SL axis_f_reference_position
F axis reference position.
» SL axis_f_motor_position
F axis motor position.
» SL axis_f_position_error
F axis position error.
» SL axis_f_aux_position
F axis auxiliary position.
» SL axis_f_velocity
F axis velocity.
» SL axis_f_torque
F axis torque.
+ UW axis_f_analog_in
F axis analog input.
* UB axis_f halls
F Hall Input Status.
« UB axis_f reserved

Reserved.
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SL axis_f variable
F User-defined variable (ZA).
UW axis_g_status
G axis status.
UB axis_g_switches
G axis switches.
UB axis_g_stop_code
G axis stop code.
SL axis_g_reference_position
G axis reference position.
SL axis_g_motor_position
G axis motor position.
SL axis_g_position_error
G axis position error.
SL axis_g_aux_position
G axis auxiliary position.
SL axis_g_velocity
G axis velocity.
SL axis_g_torque
G axis torque.
UW axis_g_analog_in
G axis analog input.
UB axis_g_halls
G Hall Input Status.
UB axis_g_reserved
Reserved.
SL axis_g_variable
G User-defined variable (ZA).
UW axis_h_status
H axis status.
UB axis_h_switches
H axis switches.
UB axis_h_stop_code
H axis stop code.
SL axis_h_reference_position
H axis reference position.
SL axis_h_motor_position
H axis motor position.
SL axis_h_position_error
H axis position error.
SL axis_h_aux_position
H axis auxiliary position.
SL axis_h_velocity
H axis velocity.
SL axis_h_torque
H axis torque.
UW axis_h_analog_in
H axis analog input.
UB axis_h_halls
H Hall Input Status.
UB axis_h_reserved
Reserved.
SL axis_h_variable
H User-defined variable (ZA).
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7.6.1 Detailed Description

Data record struct for DMC-4000 controllers, including 4000, 4200, 4103, and 500x0.
Definition at line 34 of file gclib_record.h.

The documentation for this struct was generated from the following file:

* gclib_record.h

7.7 GDataRecord47000_ENC Struct Reference

Data record struct for RIO-471xx and RIO-472xx PLCs. Includes encoder fields.

#include <gclib_record.h>

Data Fields

* UB header_0

1st Byte of Header.
* UB header_1

2nd Byte of Header.
* UB header 2

3rd Byte of Header.
* UB header_3

4th Byte of Header.
* UW sample_number

Sample number.
« UB error_code

Error code.
+ UB general_status

General status.
* UW output_analog_0

Analog output 0.
* UW output_analog_1

Analog output 1.
* UW output_analog_2

Analog output 2.
» UW output_analog_3

Analog output 3.
* UW output_analog_4

Analog output 4.
* UW output_analog_5

Analog output 5.
* UW output_analog_6

Analog output 6.
* UW output_analog_7

Analog output 7.

* UW input_analog_0
Analog input 0.

* UW input_analog_1
Analog input 1.
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* UW input_analog_2
Analog input 2.

* UW input_analog_3
Analog input 3.

* UW input_analog_4
Analog input 4.

* UW input_analog_5
Analog input 5.

* UW input_analog_6
Analog input 6.

* UW input_analog_7
Analog input 7.

* UW output_bank_0
Digital outputs 0-15;.

* UW input_bank_0
Digital inputs 0-15;.

* UL pulse_count_0

Pulse counter (see PC).

» SL zc_variable

ZC User-defined variable (see ZC).
* SL zd_variable

ZD User-defined variable (see ZD).
« SL encoder 0

Encoder channel 0. Data only valid for parts with -BISS, -QUAD, or -SSI.
« SL encoder_1

Encoder channel 1. Data only valid for parts with -BISS, -QUAD, or -SSI.
« SL encoder 2

Encoder channel 2. Data only valid for parts with -BISS, -QUAD, or -SSI.
* SL encoder 3

Encoder channel 3. Data only valid for parts with -BISS, -QUAD, or -SSI.

7.7.1 Detailed Description

Data record struct for RIO-471xx and RIO-472xx PLCs. Includes encoder fields.
Definition at line 869 of file gclib_record.h.

The documentation for this struct was generated from the following file:

 gclib_record.h

7.8 GDataRecord47300 24EX Struct Reference

Data record struct for RIO-47300 with 24EX 1/O daughter board.
#include <gclib_record.h>
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Data Fields

* UB header 0
1st Byte of Header.

* UB header_1
2nd Byte of Header.

* UB header_2
3rd Byte of Header.

* UB header_3
4th Byte of Header.

* UW sample_number
Sample number.

+ UB error_code
Error code.

* UB general_status
General status.

* UW output_analog_0
Analog output 0.

* UW output_analog_1
Analog output 1.

* UW output_analog_2
Analog output 2.

+ UW output_analog_3
Analog output 3.

+ UW output_analog_4
Analog output 4.

+ UW output_analog_5
Analog output 5.

+ UW output_analog_6
Analog output 6.

* UW output_analog_7
Analog output 7.

* UW input_analog_0
Analog input 0.

* UW input_analog_1
Analog input 1.

* UW input_analog_2
Analog input 2.

* UW input_analog_3
Analog input 3.

* UW input_analog_4
Analog input 4.

* UW input_analog_5
Analog input 5.

+ UW input_analog_6
Analog input 6.

* UW input_analog_7
Analog input 7.

» UW output_bank_0

Digital outputs 0-15.
* UW output_bank_1
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Digital outputs 16-23.
* UW input_bank_0
Digital inputs 0-15.
* UW input_bank_1
Digital inputs 16-23.
* UL pulse_count_0

Pulse counter (see PC)8.
» SL zc_variable

ZC User-defined variable (see ZC).
* SL zd_variable

ZD User-defined variable (see ZD).
* UW output_bank_2

Digital outputs 24-39. Data only valid for parts with 24EXOUT.
* UW output_back_3

Digital outputs 40-47. Data only valid for parts with 24EXOUT.
* UW input_bank_2

Digital inputs 24-39. Data only valid for parts with 24EXIN.
* UW input_bank_3

Digital inputs 40-47. Data only valid for parts with 24EXIN.

7.8.1 Detailed Description

Data record struct for RIO-47300 with 24EX 1/O daughter board.
Definition at line 967 of file gclib_record.h.

The documentation for this struct was generated from the following file:

 gclib_record.h

7.9 GDataRecord47300 ENC Struct Reference

Data record struct for RIO-47300. Includes encoder fields.

#include <gclib_record.h>

Data Fields

» UB header_0

1st Byte of Header.
* UB header_1

2nd Byte of Header.
* UB header 2

3rd Byte of Header.
* UB header_3

4th Byte of Header.
* UW sample_number

Sample number.
« UB error_code

Error code.
» UB general_status
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General status.

* UW output_analog_0
Analog output 0.

* UW output_analog_1
Analog output 1.

+ UW output_analog_2
Analog output 2.

+ UW output_analog_3
Analog output 3.

+ UW output_analog_4
Analog output 4.

+ UW output_analog_5
Analog output 5.

+ UW output_analog_6
Analog output 6.

+ UW output_analog_7
Analog output 7.

* UW input_analog_0
Analog input 0.

* UW input_analog_1
Analog input 1.

* UW input_analog_2
Analog input 2.

* UW input_analog_3
Analog input 3.

* UW input_analog_4
Analog input 4.

* UW input_analog_5
Analog input 5.

* UW input_analog_6
Analog input 6.

* UW input_analog_7
Analog input 7.

* UW output_bank_0
Digital outputs 0-15;.

* UW output_bank_1
Digital outputs 16-23;.

* UW input_bank_0
Digital inputs 0-15;.

* UW input_bank_1
Digital inputs 16-23;.

* UL pulse_count_0
Pulse counter (see PC).

« SL zc_variable
ZC User-defined variable (see ZC).

+ SL zd variable
ZD User-defined variable (see ZD).

« SL encoder_0
Encoder channel 0. Data only valid for parts with -BISS, -QUAD, or -SSI.

+ SL encoder_1
Encoder channel 1. Data only valid for parts with -BISS, -QUAD, or -SSI.
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« SL encoder 2

Encoder channel 2. Data only valid for parts with -BISS, -QUAD, or -SSI.
« SL encoder 3

Encoder channel 3. Data only valid for parts with -BISS, -QUAD, or -SSI.

7.9.1 Detailed Description

Data record struct for RIO-47300. Includes encoder fields.
Definition at line 917 of file gclib_record.h.

The documentation for this struct was generated from the following file:

+ gclib_record.h

7.10 GDataRecord52000 Struct Reference

Data record struct for DMC-52000 controller. Same as DMC-4000, with bank indicator added at byte 40.

#include <gclib_record.h>

Data Fields

* UB header 0

1st Byte of Header.
* UB header_1

2nd Byte of Header.
* UB header 2

3rd Byte of Header.
* UB header_3

4th Byte of Header.
+ UW sample_number

sample number.
+ UB input_bank_0

general input bank 0 (inputs 1-8).
+ UB input_bank_1

general input bank 1 (inputs 9-16).
+ UB input_bank_2

general input bank 2 (inputs 17-24).
+ UB input_bank_3

general input bank 3 (inputs 25-32).
* UB input_bank_4

general input bank 4 (inputs 33-40).
+ UB input_bank_5

general input bank 5 (inputs 41-48).
+ UB input_bank_6

general input bank 6 (inputs 49-56).
+ UB input_bank_7

general input bank 7 (inputs 57-64).
+ UB input_bank_8

general input bank 8 (inputs 65-72).
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« UB input_bank_9

general input bank 9 (inputs 73-80).
« UB output_bank_0

general output bank 0 (outputs 1-8).
* UB output_bank_1

general output bank 1 (outputs 9-16).
* UB output_bank_2

general output bank 2 (outputs 17-24).
« UB output_bank_3

general output bank 3 (outputs 25-32).
» UB output_bank_4

general output bank 4 (outputs 33-40).
* UB output_bank_5

general output bank 5 (outputs 41-48).
+ UB output_bank_6

general output bank 6 (outputs 49-56).
» UB output_bank_7

general output bank 7 (outputs 57-64).
+ UB output_bank_8

general output bank 8 (outputs 65-72).
+ UB output_bank_9

general output bank 9 (outputs 73-80).
 SWreserved 0

Reserved.
» SWreserved 2

Reserved.
+ SWreserved_4

Reserved.
*+ SWreserved_6

Reserved.
* SWreserved_8

Reserved.
« SWreserved 10

Reserved.
* SWreserved_12

Reserved.
» UB ethercat_bank

EtherCAT Bank Indicator.
* UBreserved 14

Reserved.
* UB ethernet_status_a

Ethernet Handle A Status.
* UB ethernet_status b

Ethernet Handle B Status.
» UB ethernet_status_c

Ethernet Handle C Status.
» UB ethernet_status_d

Ethernet Handle D Status.
» UB ethernet_status_e

Ethernet Handle E Status.
« UB ethernet_status_f

gclib 423



100

Data Structure Documentation

Ethernet Handle F Status.
UB ethernet_status_g
Ethernet Handle G Status.
UB ethernet_status_h
Ethernet Handle H Status.
UB error_code
error code.
UB thread_status
thread status
UL amplifier_status
Amplifier Status.
UL contour_segment_count

Segment Count for Contour Mode.

UW contour_buffer_available

Buffer space remaining, Contour Mode.

UW s_plane_segment_count

segment count of coordinated move for S plane.

UW s_plane_move_status

coordinated move status for S plane.

SL s_distance

distance traveled in coordinated move for S plane.

UW s_plane_buffer_available

Buffer space remaining, S Plane.

UW t_plane_segment_count

segment count of coordinated move for T plane.

UW t_plane_move_status

Coordinated move status for T plane.

SL t_distance

distance traveled in coordinated move for T plane.

UW t_plane_buffer_available

Buffer space remaining, T Plane.

UW axis_a_status

A axis status.
UB axis_a_switches

A axis switches.
UB axis_a_stop_code

A axis stop code.
SL axis_a_reference_position

A axis reference position.
SL axis_a_motor_position
A axis motor position.
SL axis_a_position_error
A axis position error.
SL axis_a_aux_position

A axis auxiliary position.
SL axis_a_velocity

A axis velocity.
SL axis_a_torque

A axis torque.
UW axis_a_analog_in

A axis analog input.
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« UB axis_a_halls
A Hall Input Status.
« UB axis_a_reserved
Reserved.
« SL axis_a_variable
A User-defined variable (ZA).
« UW axis_b_status
B axis status.
* UB axis_b_switches
B axis switches.
» UB axis_b_stop_code
B axis stop code.
» SL axis_b_reference_position
B axis reference position.
» SL axis_b_motor_position
B axis motor position.
» SL axis_b_position_error
B axis position error.
» SL axis_b_aux_position
B axis auxiliary position.
» SL axis_b_velocity
B axis velocity.
» SL axis_b_torque
B axis torque.
+ UW axis_b_analog_in
B axis analog input.
+ UB axis_b_halls
B Hall Input Status.
» UB axis_b_reserved
Reserved.
» SL axis_b_variable
B User-defined variable (ZA).
 UW axis_c_status
C axis status.
» UB axis_c_switches
C axis switches.
+ UB axis_c_stop_code
C axis stop code.
» SL axis_c_reference_position
C axis reference position.
» SL axis_c_motor_position
C axis motor position.
» SL axis_c_position_error
C axis position error.
» SL axis_c_aux_position
C axis auxiliary position.
» SL axis_c_velocity
C axis velocity.
» SL axis_c_torque
C axis torque.
+ UW axis_c_analog_in
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C axis analog input.
UB axis_c_halls
C Hall Input Status.
UB axis_c_reserved
Reserved.
SL axis_c_variable
C User-defined variable (ZA).
UW axis_d_status
D axis status.
UB axis_d_switches
D axis switches.
UB axis_d_stop_code
D axis stop code.
SL axis_d_reference_position
D axis reference position.
SL axis_d_motor_position
D axis motor position.
SL axis_d_position_error
D axis position error.
SL axis_d_aux_position
D axis auxiliary position.
SL axis_d_velocity
D axis velocity.
SL axis_d_torque
D axis torque.
UW axis_d_analog_in
D axis analog input.
UB axis_d_halls
D Hall Input Status.
UB axis_d_reserved
Reserved.
SL axis_d_variable
D User-defined variable (ZA).
UW axis_e_status
E axis status.
UB axis_e_switches
E axis switches.
UB axis_e_stop_code
E axis stop code.
SL axis_e_reference_position
E axis reference position.
SL axis_e_motor_position
E axis motor position.
SL axis_e_position_error
E axis position error.
SL axis_e_aux_position
E axis auxiliary position.
SL axis_e_velocity
E axis velocity.
SL axis_e_torque

E axis torque.
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+ UW axis_e_analog_in
E axis analog input.
« UB axis_e halls
E Hall Input Status.
« UB axis_e reserved
Reserved.
« SL axis_e variable
E User-defined variable (ZA).
« UW axis_f status
F axis status.
» UB axis_f switches
F axis switches.
+ UB axis_f_stop_code
F axis stop code.
+ SL axis_f_reference_position
F axis reference position.
+ SL axis_f_motor_position
F axis motor position.
» SL axis_f _position_error
F axis position error.
+ SL axis_f_aux_position
F axis auxiliary position.
+ SL axis_f_velocity
F axis velocity.
+ SL axis_f_torque
F axis torque.
+ UW axis_f _analog_in
F axis analog input.
» UB axis_f_halls
F Hall Input Status.
+ UB axis_f_reserved
Reserved.
» SL axis_f_variable
F User-defined variable (ZA).
+ UW axis_g_status
G axis status.
+ UB axis_g_switches
G axis switches.
+ UB axis_g_stop_code
G axis stop code.
» SL axis_g_reference_position
G axis reference position.
» SL axis_g_motor_position
G axis motor position.
» SL axis_g_position_error
G axis position error.
» SL axis_g_aux_position
G axis auxiliary position.
» SL axis_g_velocity
G axis velocity.
» SL axis_g_torque
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7.10.1

G axis torque.
UW axis_g_analog_in
G axis analog input.
UB axis_g_halls
G Hall Input Status.
UB axis_g_reserved
Reserved.
SL axis_g_variable
G User-defined variable (ZA).
UW axis_h_status
H axis status.
UB axis_h_switches
H axis switches.
UB axis_h_stop_code
H axis stop code.
SL axis_h_reference_position
H axis reference position.
SL axis_h_motor_position
H axis motor position.
SL axis_h_position_error
H axis position error.
SL axis_h_aux_position
H axis auxiliary position.
SL axis_h_velocity
H axis velocity.
SL axis_h_torque
H axis torque.
UW axis_h_analog_in
H axis analog input.
UB axis_h_halls
H Hall Input Status.
UB axis_h_reserved
Reserved.
SL axis_h_variable
H User-defined variable (ZA).

Detailed Description

Data record struct for DMC-52000 controller. Same as DMC-4000, with bank indicator added at byte 40.

Definition at line 217 of file gclib_record.h.

The documentation for this struct was generated from the following file:

* gclib_record.h

71

Structure to create a linked list for array data.

H_ArrayData Struct Reference
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Data Fields

71141

Structure to create a linked list for array data.

char name [16]

char x data

int len

int elements

int index

struct H_ArrayData * next
struct H_ArrayData x tail
int count

Detailed Description

Definition at line 18 of file arrays.c.

The documentation for this struct was generated from the following file:

- arrays.c
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Chapter 8

File Documentation

8.1 arrays.c File Reference

#include "gclibo.h"
#include <stdlib.h>
#include <string.h>
#include <stdio.h>
#include <math.h>
#include <zlib.h>

Data Structures

+ struct H_ArrayData

Structure to create a linked list for array data.

Typedefs

+ typedef struct H_ArrayData ArrayNode

Functions

void H_InitArrayNode (ArrayNode *node)
Function to initialize the memory of a new node.
* GReturn H_AddArray (ArrayNode xhead, char xname, char xdata)
Add an ArrayData node to the linked list.
» void H_FreeArrays (ArrayNode xnode)

Frees all memory downstream of node. After passing list head to this function, all memory is freed and the head node
is invalid.
* GReturn H_UploadArrayToList (GCon g, ArrayNode *head, char xname)
Uploads a particular array and adds it to the linked list.
* GReturn H_CreateArrayNode (ArrayNode xhead, char xname)
Creates a buffer on the heap to write data, and adds it to the linked list.
» GReturn H_ArrayAddElement (ArrayNode *xnode, GCStringIn element)
Adds an array element to an array node.
» GReturn H_DownloadArraysFromList (GCon g, ArrayNode *head, int fail)
Walks through the array linked list, downloading each.
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» GReturn H_WriteArrayCsv (ArrayNode xhead, GCStringln file_path)

After filling the array list, this function is called to write out the CSV.
* GReturn H_ArrayDownloadFromMemory (GCon g, const char *array_data, int fail)

Helper function to download a block of arrays to the controller.
» GReturn H_DownloadData (GCon g, const char xdata, int fail)

Helper function to send a string of commands to the controller, one at at time.
» char x H_FindSector (char *arr, int arr_size, int index)

Function that returns a pointer to the start of the specified sector in the GCB data.
» GReturn GCALL GArrayDownloadFile (GCon g, GCStringln file_path)

Array download from file.
» GReturn GCALL GArrayUploadFile (GCon g, GCStringIn file_path, GCStringln names)

Array upload to file.
* GReturn GCALL GSetupDownloadFile (GCon g, GCStringln file_path, GOption options, GCStringOut info,
GSize info_len)

Download a saved controller configuration from a file.

8.1.1 Detailed Description

Function calls for uploading and downloading arrays with CSV files. Also contains functions for support of
GSetupDownloadFile().

Warning

All helper functions (names beginning with H_) are subject to change without notice

8.1.2 Function Documentation

8.1.2.1 GArrayDownloadFile()

GReturn GCALL GArrayDownloadFile (
GCon g,
GCStringIn file path )

Array download from file.

Downloads a csv file containing array data at £ile_path. If the arrays don't exist, they will be dimensioned.

Parameters

g Connection's handle.

file_path | Null-terminated string containing the path to the array file.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_arrays.cpp for an example.
Definition at line 370 of file arrays.c.

References G_BAD_FILE, G_NO_ERROR, and H_ArrayDownloadFromMemory().
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8.1.2.2 GArrayUploadFile()

GReturn GCALL GArrayUploadFile (
GCon g,
GCStringIn file path,

GCStringIn names )
Array upload to file.

Uploads the entire controller array table or a subset and saves the data as a csv file specified by file_path.

Parameters

g Connection's handle.

file_path | Null-terminated string containing the path to the array file, file will be overwritten if it exists.

names Null-terminated string containing the arrays to upload, delimited with space. "" or null uploads all
arrays listed in LA.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_arrays.cpp for an example.
Definition at line 398 of file arrays.c.

References G_NO_ERROR, GCmdT(), H_FreeArrays(), H_InitArrayNode(), H_UploadArrayToList(), and H_Write«
ArrayCsv().

8.1.2.3 GSetupDownloadFile()

GReturn GCALL GSetupDownloadFile (
GCon g,
GCStringIn file path,
GOption options,
GCStringOut info,

GSize info len )

Download a saved controller configuration from a file.

Parameters

g Connection's handle.

file_path | Null-terminated string containing the path to the program file.

options Bit mask to determine what configuration data to download. See below for all options.

info Optional pointer to a buffer to store the controller info. If no info is needed, specify as NULL.
info_len | Length of optional info buffer. If no info is needed, specify as NULL.

Returns

The success status or error code of the function. If the options parameter is set to 0, the return value will
be a bit mask indicating which sectors in the specified GCB are not empty. Otherwise, see gclib_errors.h for
possible error values.

gclib 423



110 File Documentation

Note

By default, GSetupDownloadFile() will stop immediately if an error is encountered downloading data. This

can be overridden in the options parameter. An example of when you might override this setting: You

have a

backup from an 8-axis controller and want to restore the parameters for the first 4 axes to a 4-axis controller.

If both info and info_len are not NULL, the controller information will be provided regardless of the options parameter.

The options parameter is a bit mask. If options is set to 0, GSetupDownloadFile() will return a bit mask indicating
which sectors in the specified GCB are not empty. The following contains a list of all currently available options:

Bit | Value Function Description
1 0x0002 | Restore parameters | KPA, KIA, KDA, etc...
3 0x0008 | Restore variables Variables are listed by the LV command
4 0x0010 | Restore arrays Arrays are listed by the LA command
5 0x0020 | Restore program The program is listed by the LS command
31 0x8000 | Ignore errors Ignore invalid parameter errors and continue restoring data.
GSetupDownloadFile() will still stop immediately if a connection issue
or other fatal error is encountered
Usage example:
GCon g;
GOption opt = 0;
GCStringOut info;
GSize info_len = 4096;
GReturn rc = GOpen("192.168.0.50", &9g);
if (rc) return rc;
// Call GSetupDownloadFile() with options set to 0 so we can get the non-empty sector bit mask
opt = GSetupDownloadFile(g, "C:\\path\\to\\gcb\\file.gcb", 0, NULL, NULL);
info = (GCStringOut)malloc (sizeof (GCStringOut) = info_len);
// Call GSetupDownloadFile() with the bit mask returned in the previous function call
rc = GSetupDownloadFile (g, "C:\\path\\to\\gcb\\file.gcb", opt, info, info_len);
printf("Info:\n\n%s", info);
GClose (g);
free(info);
return rc;
Definition at line 465 of file arrays.c.
References G_BAD_FILE, G_NO_ERROR, GProgramDownload(), H_ArrayDownloadFromMemory(), H_ «

DownloadData(), and H_FindSector().

8.1.2.4 H_DownloadArraysFromList()

GReturn H_DownloadArraysFromList (
GCon g,
ArrayNode #* head,
int fail )

Walks through the array linked list, downloading each.
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Warning

This function will call DA and DM which modifies the controllers' array table. This should NOT be done while
running record array (see RA/RC/RD) or while using the MODBUS array sharing feature (see ME). To prevent
any possibility of array table issues, dimension all the arrays used in the applications with the appropriate
lengths before use and comment out the array table modification section below.

Definition at line 134 of file arrays.c.

References G_BAD_RESPONSE_QUESTION_MARK, G_BOUNDS, G_NO_ERROR, GArrayDownload(), and G
cmd().

Referenced by H_ArrayDownloadFromMemory().

8.2 gclib.h File Reference

#include "gclib_record.h"
#include "gclib_errors.h"

Macros

» #define GCLIB_DLL_EXPORTED
« #define GCALL __stdcall

Specify calling convention for Windows.
« #define G_DR 1

Value for GRecord() met hod variable for acquiring a data record via DR mode.
» #define G_QR 0
Value for GRecord() met hod variable for acquiring a data record via QR mode.
» #define G_BOUNDS -1
For functions that take range options, e.g. GArrayUpload(), use this value for full range.
« #define G_CRO
For GArrayUpload(), use this value in the delim field to delimit with carriage returns.
+ #define G_COMMA 1

For GArrayUpload(), use this value in the delim field to delimit with commas.
« #define G_UTIL_TIMEOUT 1

GUtility(), Access to timeout.
« #define G_UTIL_TIMEOUT_OVERRIDE 2
GUtility(), read/write access to timeout override.
» #define G_USE_INITIAL_TIMEOUT -1
GUtility(), for timeout override. Set G_UTIL _TIMEOUT_OVERRIDE to this value to use initial GOpen() timeout
(-—timeout).
» #define G_UTIL_VERSION 128
GUtility(), get a library version string.
» #define G_UTIL_INFO 129
GUltility(), get a connection info string.
+ #define G_UTIL_SLEEP 130
GUtility(), specify an interval to sleep.
» #define G_UTIL_ADDRESSES 131
GUtility(), get a list of available connections.
» #define G_UTIL_IPREQUEST 132
GUtility(), get a list of hardware requesting IPs.
» #define G_UTIL_ASSIGN 133
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GUltility(), assign IP addresses via Boot-P reply.
#define G_UTIL_DEVICE_INITIALIZE 134

GUtility(), sends CF, CW, EQO etc. to initialize the connection. Useful after RS or other reset.
#define G_UTIL_PING 135

GUtility(), uses ICMP ping to determine if an IP address is reachable and assigned.
#define G_UTIL_ERROR_CONTEXT 136

GUtility(), provides additional error context, where available.
#define G_UTIL_GCAPS_HOST 256
#define G_UTIL_GCAPS_VERSION 257

GUtility(), get the version of the gcaps server.
#define G_UTIL_GCAPS_KEEPALIVE 258

GUTtility(), gcaps server keepalive.
#define G_UTIL_GCAPS_ADDRESSES 259

GUtility(), get a list of available connections from the gcaps server.
#define G_UTIL_GCAPS_IPREQUEST 260

GUHtility(), get a list of hardware requesting IPs from the gcaps server.
#define G_UTIL_GCAPS_ASSIGN 261

GUtility(), assign IP addresses via Boot-P reply from the gcaps server.
#define G_UTIL_GCAPS_PING 262

GUtility(), uses ICMP ping to determine if an IP address is reachable and assigned. Ping sent from the gcaps server.
#define G_SMALL_BUFFER 1024

Most reads/writes to Galil are small. This value will easily hold most, e.g. TH, TZ, etc.
#define G_HUGE_BUFFER 524288

Most reads/writes to Galil hardware are small. This value will hold the largest array or program upload/download
possible.

Typedefs

typedef int GReturn
Every function returns a value of type GReturn. See gclib_errors.h for possible values.
typedef void * GCon
Connection handle. Unique for each connection in process. Assigned a non-zero value in GOpen().
typedef unsigned int GSize
Size of buffers, etc.
typedef int GOption
Option integer for various formatting, etc.
typedef char « GCStringOut
C-string output from the library. Implies null-termination.
typedef const char x GCStringln
C-string input to the library. Implies null-termination.
typedef char « GBufOut

Data output from the library. No null-termination implied. Returned values may be null-terminated, see function
documentation for details.

typedef const char x GBufln

Data input to the library. No null-termination, function will have a GSize to indicate bytes to write .
typedef unsigned char GStatus

Interrupt status byte.
typedef void * GMemory

Pointer to untyped memory for use in GUItility().
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Functions

8.2.1

GCLIB_DLL_EXPORTED GReturn GCALL GOpen (GCStringln address, GCon Q)

Open a connection to a Galil Controller.
GCLIB_DLL_EXPORTED GReturn GCALL GClose (GCon Q)

Closes a connection to a Galil Controller.
GCLIB_DLL_EXPORTED GReturn GCALL GRead (GCon g, GBufOut buffer, GSize buffer_len, GSize
xbytes_read)

Performs a read on the connection.
GCLIB_DLL_EXPORTED GReturn GCALL GWrite (GCon g, GBufIn buffer, GSize buffer_len)

Performs a write on the connection.

GCLIB_DLL_EXPORTED GReturn GCALL GCommand (GCon g, GCStringln command, GBufOut buffer,
GSize buffer_len, GSize xbytes_returned)

Performs a command-and-response transaction on the connection.

GCLIB_DLL_EXPORTED GReturn GCALL GProgramDownload (GCon g, GCStringIn program, GCStringln
preprocessor)

Downloads a program to the controller's program buffer.
GCLIB_DLL_EXPORTED GReturn GCALL GProgramUpload (GCon g, GBufOut buffer, GSize buffer_len)

Uploads a program from the controller's program buffer.

GCLIB_DLL_EXPORTED GReturn GCALL GArrayDownload (GCon g, const GCStringln array_name,
GOption first, GOption last, GCStringIn buffer)

Downloads array data to a pre-dimensioned array in the controller's array table.

GCLIB_DLL_EXPORTED GReturn GCALL GArrayUpload (GCon g, const GCStringIn array_name, GOption
first, GOption last, GOption delim, GBufOut buffer, GSize buffer_len)

Uploads array data from the controller's array table.

GCLIB_DLL_EXPORTED GReturn GCALL GRecord (GCon g, union GDataRecord xrecord, GOption
method)

Provides a fresh copy of the controller's data record. Data is cast into a union, GDataRecord.
GCLIB_DLL_EXPORTED GReturn GCALL GMessage (GCon g, GCStringOut buffer, GSize buffer_len)

Provides access to unsolicited messages from the controller.
GCLIB_DLL_EXPORTED GReturn GCALL Ginterrupt (GCon g, GStatus *status_byte)

Provides access to PCIl and UDP interrupts from the controller.
GCLIB_DLL_EXPORTED GReturn GCALL GFirmwareDownload (GCon g, GCStringln filepath)

Upgrade firmware.

GCLIB_DLL_EXPORTED GReturn GCALL GuUtility (GCon g, GOption request, GMemory memory1,
GMemory memory?2)

Provides read/write access to driver settings and convenience features based on the request variable.

Detailed Description

Defines the interface for the Galil C Library (GCLIB).

8.2.2 Function Documentation
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8.2.2.1 GArrayDownload()

GCLIB_DLL_EXPORTED GReturn GCALL GArrayDownload (
GCon g,
const GCStringIn array_name,
GOption first,
GOption last,
GCStringIn buffer )

Downloads array data to a pre-dimensioned array in the controller's array table.

Warning
The array must already exist on the controller and be sufficient dimension to hold the desired array data, e.g.
via DM.
Parameters
g Connection's handle.
array_name | Null-terminated string containing the name of the array to download. Must match the array name
used in DM.
first The first element of the array for sub-array downloads. G_BOUNDS to omit.
last The last element of the array for sub-array downloads. G_BOUNDS to omit.
buffer Buffer containing the null-terminated data to be sent to the controller. The array data may be

separated with carriage return, carriage return + line feed, or a comma. No spaces.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_arrays.cpp for an example.

Referenced by H_DownloadArraysFromList().

8.2.2.2 GArrayUpload()

GCLIB_DLL_EXPORTED GReturn GCALL GArrayUpload (
GCon g,
const GCStringIn array_name,
GOption first,
GOption last,
GOption delim,
GBufOut buffer,
GSize buffer_len )

Uploads array data from the controller's array table.

Parameters
g Connection's handle.
array_name | Null-terminated string containing the name of the array to upload.
first The first element of the array for sub-array uploads. G_BOUNDS to omit.
last The last element of the array for sub-array uploads. G_BOUNDS to omit.
delim Sets the delimeter between array elements in the returned data, G_CR specifies carriage return,

G_COMMA specifies comma.
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Parameters

buffer Buffer to receive the uploaded data. The data will be null terminated unless function returns
G_BAD_LOST_DATA due to the buffer being too small to hold the data.

buffer _len The length of the receive buffer.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_arrays.cpp for an example.

Referenced by H_UploadArrayToList().

8.2.2.3 GClose()

GCLIB_DLL_EXPORTED GReturn GCALL GClose (
GCon g )

Closes a connection to a Galil Controller.

Attention

gclib requires that GClose () be called whenever a program is finished with a controller. This includes when
a program closes. A rule of thumb is that for every GOpen () call on a given connection, a GClose () call
should be found on every code path. Failing to call GClose() may cause controller resources to not be released
or can hang the process if there are outstanding asynchronous operations. The latter can occur, for example,
if a call to GRead() times out and the process exits without calling GClose(). In this case, GRead() still has an
outstanding asynchronous read pending. GClose() will terminate this operation allowing the process to exit
correctly.

Parameters

‘ g ‘ Connection's handle.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_examples.cpp for an example.

8.2.2.4 GCommand()

GCLIB_DLL_EXPORTED GReturn GCALL GCommand (
GCon g,
GCStringIn command,
GBufOut buffer,
GSize buffer_len,

GSize * bytes_returned )

Performs a command-and-response transaction on the connection.

Parameters

g Connection's handle.

gclib 423



116 File Documentation
Parameters
command Null-terminated command string to send to the controller. The library will append a carriage
return to the command string.
buffer Buffer for the response. Will be filled with the response from the controller. The data will be
null terminated unless function returns G_BAD_TLOST_DATA due to the buffer being too
small to hold the data.
buffer _len The size of the response buffer.
bytes_returned | The size of the data returned from the controller. This does not include null termination. This
argument may be null if the value is not desired.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gcommand.cpp for an example.

Referenced by GCmd(), GCmdD(), GCmdI(), GCmdT(), and GMotionComplete().

8.2.2.5 GFirmwareDownload()

GCLIB_DLL_EXPORTED GReturn GCALL GFirmwareDownload (
GCon g,
GCStringIn filepath )

Upgrade firmware.

Parameters

g Connection's handle.

filepath | The full file path to the Galil-supplied firmware hex file. See
http://www.galil.com/downloads/firmware

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

ec(GInfo(g, buf, sizeof(buf))); //get conntroller info
cout << buf << ’\n’; //print the info

ec (GFirmwareDownload (g, "F:/1806.dmc/dmc-1806-rlla.hex"));
ec (GInfo(g, buf, sizeof(buf))); //get the info again

cout << buf << "\n’;

// example output:

// GALILPCI1, DMC1846 Rev 1.la-CM, 4232

// GALILPCI1, DMC1846 Rev 1.la, 4232

8.2.2.6 Ginterrupt()

GCLIB_DLL_EXPORTED GReturn GCALL GInterrupt (
GCon g,
GStatus x status_byte )

Provides access to PCl and UDP interrupts from the controller.
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Interrupts can be generated automatically by the firmware on important events via ET (Enable Interrupt) or by the
user in embedded DMC code via UT (User Interrupt). To use this function, —s EI must be used in the GOpen()
address string to subscribe to interrupts.

Parameters

g Connection's handle.

status_byte | A pointer to a GStatus to receive the status byte.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

Ginterrupt() will block until an interrupt is received, or the function times out.

Note

If this function is called with a timeout of zero, a non-blocking read is performed. If interrupt data is waiting in
the interrupt queue, the oldest byte will be popped off the queue. If there is no interrupt data queued, but there
is data waiting in the socket or PCI FIFO, one read will be performed to process the waiting data. If new data
is still not found after these two attempts, G_GCLIB_NON_BLOCKING_READ_EMPTY will be returned.

See x_ginterrupt.cpp for an example. See x_nonblocking.cpp for an example of non-blocking usage.

8.2.2.7 GMessage()

GCLIB_DLL_EXPORTED GReturn GCALL GMessage (
GCon g,
GCStringOut buffer,
GSize buffer_len )

Provides access to unsolicited messages from the controller.

To use this function, —s MG must be used in the GOpen() address string to subscribe to messages. Unsolicited
bytes must be flagged by the high-bit setting, CWw 1. The driver will automatically set this when subscribing to
messages. The user should not overwrite this setting.

Unsolicited messages are data generated by the controller that are not in response to a command, a data record,
or an interrupt. Examples follow.

1. Data generated by the MG command from embedded code. MG sent from the host is solicited.
2. Any command in an embedded program that returns data, e.g. TP, RP, var="

3. Arun time error in an embedded program, e.g. ?55 i=var

Note

Messages are unframed byte streams. There is no guarantee that the user will get complete messages or
single messages in a call to GMessage().

Parameters
g Connection's handle.
buffer The buffer to write the message data. The buffer will be null terminated.

buffer_len | The length of the user's buffer.
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Returns

The success status or error code of the function. See gclib_errors.h for possible values.

GMessage() will block until a message is received, or the function times out.

Note

If this function is called with a timeout of zero, a non-blocking read is performed. If message data has been
processed since the last time the function was called, this data will be returned. If there is no processed
message data, but there is data waiting in the socket or PCI FIFO, one read will be performed to process the
waiting data. If new data is still not found after these two attempts, G_GCLIB_NON_BLOCKING_READ_E«
MPTY will be returned.

Warning

When sending message streams through gcaps, the following non-printable bytes are illegal, $00-$07 and
$10-$17. These bytes may be routed to a third party device such as am HMI or display panel. See MG and

CF.

See x_gmessage.cpp for an example. See x_nonblocking.cpp for an example of non-blocking usage.

8.2.2.8 GOpen()

GCLIB_DLL_EXPORTED GReturn GCALL GOpen (

GCStringIn address,

GCon * g )

Open a connection to a Galil Controller.

Parameters
address | Null-terminated address string. See table below.
g Pointer to user's GCon variable. On success, the library will fill the user's variable with the handle to
use for the rest of the connection. A valid g value is nonzero.
Returns

The success status or error code of the function.

See gclib_errors.h for possible values.

address switch Meaning Arguments | Examples ----—
(default), other
options
——address Simple address to hard- | /P address, PCl, COM port | ——address COM1
ware
-a shorthand for -—address | See Address Ranges be- | —a GALILPCI1
low
{no switch} —-address is implicit for 192.168.0.42
any lone token
——baud Baud rate (115200), valid baud... COM2 —--baud 19200
-b shorthand for ——baud COM3 -b 38400
——command Command-and-response | (TCP), UDP 192.168.0.42
socket protocol ——command TCP
-c shorthand for ——command 192.168.0.42 -c
UDP

gclib 423



8.2 gclib.h File Reference

119

address switch Meaning Arguments | Examples ----—
(default), other
options
--direct Connect directly to hard- -a GALILPCIZ2
ware instead of via gcaps ——direct
-d shorthand for ——direct GALILPCI2 -d
——handshake Serial Handshake mode (HARDWARE), NONE COM1 —--handshake
NONE
-—pl Primary port for | (23), valid port number 192.168.0.42 —--pl
command-and-response 5000
traffic
--p2 Secondary port for unso- | (60007), validportnumber | 192.168.0.42 --p2
licited traffic 5000
——subscribe Subscribe to messages, | (NONE), MG, DR, EI, ALL 192.168.0.42
data records, and/or in- —-—-subscribe MG
terrupts
-s shorthand for 192.168.0.42 -s DR
——subscribe -s EI
——timeout timeout in ms (5000), 0-65535 192.168.0.42
—-—timeout 5000
-t shorthand for -——t imeout GALILPCIZ2 -t 500
—--unsolicited | Unsolicited socket proto- | (UDP), TCP, NONE 192.168.0.42
col —-—unsolicited TCP
-u shorthand for 192.168.1.42 -u
——unsolicited NONE

Operating System | Address Range Notes ------------------ —
Windows COM1 - COM256 RS232 and USB-to-serial
Linux /dev/ttyS0-/dev/ttyS255 RS232

Linux /dev/ttyUSBO - /dev/ttyUSB255 USB-to-serial, e.g. DMC-4103
Windows GALILPCI1 - GALILPCIS PCI

Linux /dev/galilpciO- /dev/galilpci?7 | PCI

See x_examples.cpp for an example.

When connecting to a network device, if the command-and-response socket is opened successfully but the unso-
licited socket fails, GOpen() will still complete successfully. This allows connection to a Galil controller when only

one Ethernet handle is available. Unsolicited traffic will not be accessible in this case.

8.2.2.9 GProgramDownload()

GCLIB_DLL_EXPORTED GReturn GCALL GProgramDownload (
GCon g,
GCStringIn program,

GCStringIn preprocessor )

Downloads a program to the controller's program buffer.

Parameters
g Connection's handle.
program Null-terminated program for download.
preprocessor | Options string for preprocessing the program before sending it to the controller. Null allows the
library to use defaults for the download. See the Program Preprocessor documentation for
options.
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Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_programs.cpp for an example.

Referenced by GProgramDownloadFile(), and GSetupDownloadFile().

8.2.2.10 GProgramUpload()

GCLIB_DLL_EXPORTED GReturn GCALL GProgramUpload (
GCon g,
GBufOut buffer,
GSize buffer_len )

Uploads a program from the controller's program buffer.

Parameters
g Connection's handle.
buffer Buffer to receive the controller's program. The data will be null terminated unless function returns

G_BAD_LOST_DATA due to the buffer being too small to hold the data.
buffer_len | The length of the receive buffer.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_programs.cpp for an example.

Referenced by GProgramUploadFile().

8.2.2.11 GRead()

GCLIB_DLL_EXPORTED GReturn GCALL GRead (
GCon g,
GBufOut buffer,
GSize buffer_ len,
GSize *x bytes_read )

Performs a read on the connection.

Parameters
g Connection's handle.
buffer The user's read buffer.

buffer_len | The length of the user's read buffer.

bytes read | Pointer to a GSize which will be filled with the number of bytes read upon return.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.
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Warning

This function is deprecated and will be removed in a future gclib version. Please contact Galil for needs not
covered by the other gclib functions.

Unsolicited messages may be returned in the read data. The high bit of each message byte will be set unless the
user changes the CW setting. Interrupts and Data Records are always filtered from a read.

See x_gread_gwrite.cpp for an example.

8.2.2.12 GRecord()

GCLIB_DLL_EXPORTED GReturn GCALL GRecord (
GCon g,
union GDataRecord % record,

GOption method )

Provides a fresh copy of the controller's data record. Data is cast into a union, GDataRecord.

Parameters

g Connection's handle.

record | A pointer to the user's DataRecord union to hold the copy.

method | Determines the method for acquiring the data.
* G_OR: QR is used via command-and-response.

* G_DR: DR is used for asynchronous acquisition.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

When using G_DR, the asynchronous data record must already be set up.
* —s DR must be used in the GOpen() address string to subscribe to records. The driver will automatically
set the second argument of DR, where applicable.
* GRecordRate () should be issued to set DR to an appropriate interval, n. The interval must be no faster
than the rate at which GRecord() is called.

GRecord() will block until the data record is received, or the transaction times out.

Note

If this function is called with a timeout of zero and the G_DR method, a non-blocking read is performed. If
a data record has been processed since the last time the function was called, this data will be returned. If
there is not a processed data reecord, but there is data waiting in the socket or PCI FIFO, one read will be
performed to process the waiting data. If new data is still not found after these two attempts, G_GCLIB_NO«-
N_BLOCKING_READ_EMPTY will be returned.

See x_grecord.cpp for an example. See x_nonblocking.cpp for an example of non-blocking usage.

8.2.2.13 GUtility()

GCLIB_DLL_EXPORTED GReturn GCALL GUtility (
GCon g,
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GOption request,
GMemory memoryl,

GMemory memoryZ2 )

Provides read/write access to driver settings and convenience features based on the request variable.

Note

The open source library, gclibo.h, has wrappers for most of these utilities.

Parameters

g Connection's handle.

request | Defines the request. Input/Output and type of memory are implicit in the value of request. The
following lists the supported request values.

G_UTIL_TIMEOUT Read initial timeout value, as specified in GOpen() via ——t imeout switch.

— memoryl is output and must be an unsigned shortx.

— memory? is ignored, use null.

G_UTIL_TIMEOUT_OVERRIDE See GTimeout(). Write/Read override timeout value.
— memoryl is input. If nonnull, value must be a shortx* holding the override, in milliseconds, for the
timeout. Write G_USE_ INITIAL_TIMEOUT to use initial timeout. If null, no write occurs.

— memory?2 is output. If nonnul, value must be a short* which will be filled with the current override.
G_USE_INITIAL_TIMEOUT indicates initial timeout used. If null, no read occurs. memory?2 is
processed before 'memory1°.

+ G_UTIL_VERSION See GVersion(). Returns the library version. A valid connection (g) is not necessary, i.e.
g may be null.

— memoryl is output, and must be a charx. Data will be null terminated, even if the data must be
truncated to do so.

— memory?2 is input and must be an unsigned intx* holding the length of the buffer in memory1l.

G_UTIL_INFO See Ginfo(). Returns information about the connection.
— memoryl is output and must be a charx. Data will be null terminated, even if the data must be
truncated to do so.
— memory?2 is input and must be an unsigned intx* holding the length of the buffer in memory1l.
* G_UTIL_SLEEP See GSleep(). Platform-independent, non-busy, sleep. A valid connection (g) is not neces-
sary, i.e. g may be null.
— memoryl is input and must be an unsigned intx*, units are milliseconds.
— memory?2 is ignored, use null.
* G_UTIL_ADDRESSES see GAddresses(). Provides a \n delimited listing of all available IP addresses, PCI
addresses, and COM ports. A valid connection (g) is not necessary, i.e. g may be null. The suffix —d will be

appended to each address to indicate these addresses are available via direct connection. See G_UTIL_«
GCAPS_ADDRESSES for addresses through gcaps.

— memoryl is output and must be a charx. Data will be null terminated, even if the data must be
truncated to do so.
— memory?2 is input and must be an unsigned intx* holding the length of the buffer in memory1.
+ G_UTIL_IPREQUEST see GlpRequests(). Listens and returns a \n delimited listing of Galil MAC addresses

sending BOOT-P or DHCP requests. The function will listen, and block, for roughly 5 seconds. A valid
connection (g) is not necessary, i.e. g may be null.
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— memoryl is output and must be a char*. Data will be null terminated, even if the data must be
truncated to do so.

— memory?2 is input and must be an unsigned intx holding the length of the buffer in memory1.

* G_UTIL_ASSIGN see GAssign(). Provides a method to assign an IP address given a Galil MAC address. A
valid connection (g) is not necessary, i.e. g may be null.

— memoryl is input and must be a char* containing the null terminated address that is to be assigned.
eg."192.168.0.43".

— memory? is input and must be a charx* containing the null terminated controller MAC address. e.g.
"00:50:4C:20:01:23".

+ G_UTIL_DEVICE_INITIALIZE Provides a method to reinitialize a connection after a reset, e.g. an RS com-
mand. Depending on the device type, the appropriate commands will be sent to configure the communication
bus for optimal performance.

— memoryl is ignored, use null.

— memory?2 is ignored, use null.

G_UTIL_PING Uses ICMP ping to determine if an IP address is reachable and assigned. A valid connection
(9) is not necessary, i.e. g may be null.

— memoryl is input and must be a charx* containing the null terminated address that is to be pinged.
eg. "192.168.0.43".

— memory?2 is output and must be an int*. The value will be set to zero if the ping times out, and
nonzero if a ping reply is returned.

G_UTIL_ERROR_CONTEXT More error detail for the last error on GCon, where available. The internal error
message is cleared upon read.

— memoryl is output and must be a charx. Data will be null terminated, even if the data must be
truncated to do so.

— memory?2 is input and must be an unsigned intx* holding the length of the buffer in memory1.

The following request values are for use with a gcaps server.

* G_UTIL_GCAPS_VERSION see GVersion(). Returns the gcaps server version. A valid connection (g) is not
necessary, i.e. g may be null. This operation will connect to the server to determine the version.

— memoryl is output and must be a charx. Data will be null terminated, even if the data must be
truncated to do so.

— memory?2 is input and must be an unsigned intx* holding the length of the buffer in memory1l.

+ G_UTIL_GCAPS_KEEPALIVE Provides a method for kicking the gcaps server. After a default period of 10
minutes of inactivity, gcaps will disconnect the gclib client. To prevent a disconnect, communicate with the
hardware or call G_UTIL_GCAPS_KEEPALIVE within the timeout period to reset the timer. The current
interval can be optionally read and overwritten, however, the keep alive signal is only sent if memory1 and
memory2 are both null.

— memoryl is output. If nonnull, value must be an unsigned int* which will be filled with the current
gcaps timeout, in ms.

— memory?2 is input. If nonnull, value must be an unsigned intx* holding the new gcaps timeout, in
ms, for connection g.

* G_UTIL_GCAPS_ADDRESSES see GAddresses(). Provides a \n delimited listing of all available IP ad-
dresses, PCI addresses, and COM ports as available from the gcaps server. A valid connection (g) is not
necessary, i.e. g may be null.

— memoryl is output and must be a char*. Data will be null terminated, even if the data must be
truncated to do so.

— memory? is input and must be an unsigned intx* holding the length of the buffer in memory1l.
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* G_UTIL_GCAPS_IPREQUEST see GlpRequests(). Connects to gcaps and returns a \n delimited listing of
Galil MAC addresses sending BOOT-P or DHCP requests. The function will block for roughly 5 seconds. A
valid connection (g) is not necessary, i.e. g may be null.

— memoryl is output and must be a charx. Data will be null terminated, even if the data must be
truncated to do so.

— memory?2 is input and must be an unsigned intx* holding the length of the buffer in memory1.

+ G_UTIL_GCAPS_ASSIGN see GAssign(). Provides a method to assign an IP address through gcaps given
a Galil MAC address. A valid connection (g) is not necessary, i.e. g may be null.

— memoryl is input and must be a charx* containing the null terminated address that is to be assigned.
eg. "192.168.0.43".

— memory?2 is input and must be a charx* containing the null terminated controller MAC address. e.g.
"00:50:4C:20:01:23".

* G_UTIL_GCAPS_PING Uses ICMP ping to determine if an IP address is reachable and assigned. Ping sent
from the gcaps server. A valid connection (g) is not necessary, i.e. g may be null.

— memoryl is input and must be a charx* containing the null terminated address that is to be pinged.
eg. "192.168.0.43".

— memory?2 is output and must be an intx*. The value will be set to zero if the ping times out, and
nonzero if a ping reply is returned.

Parameters

memory1 | An untyped pointer to data required for request. The data type is defined by the request variable.
memory2 | An untyped pointer to data required for request. The data type is defined by the request variable.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See the following functions from gclibo, the open source portion, for implementation of several GUtility() requests.:

» GAddresses()
» GAssign()

+ Ginfo()

» GlpRequests()
+ GSleep()

» GTimeout()

+ GVersion()

Referenced by GAddresses(), GAssign(), Ginfo(), GlpRequests(), GSleep(), GTimeout(), and GVersion().

8.2.2.14 GWrite()

GCLIB_DLL_EXPORTED GReturn GCALL GWrite (
GCon g,
GBufIn buffer,
GSize buffer_len )

Performs a write on the connection.
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Parameters
g Connection's handle.
buffer The user's write buffer. To send a Galil command, a terminating carriage return is usually required.

buffer_len | The length of the data in the buffer.

Returns

The success status or error code of the function. See gclib_errors.h for possible values. If G_NO_ERROR is
returned, all bytes were written.

Warning

This function is deprecated and will be removed in a future gclib version. Please contact Galil for needs not
covered by the other gclib functions.

See x_gread_gwrite.cpp for an example.

8.3 gclib_errors.h File Reference

Macros

» #define G_NO_ERROR 0

Return value if function succeeded.
» #define G_NO_ERROR_S "no error"
» #define G_GCLIB_ERROR -1

General library error. Indicates internal APl caught an unexpected error. Contact Galil support if this error is returned,
softwaresupport@galil.com.

» #define G_GCLIB_ERROR_S "gclib unexpected error"
e #define G_GCLIB_UTILITY_ERROR -2

An invalid request value was specified to GUtility.
» #define G_GCLIB_UTILITY_ERROR_S "invalid request value or bad arguments were specified to GUTtility()"
» #define G_GCLIB_UTILITY_IP_TAKEN -3

The IP cannot be assigned because ping returned a reply.

» #define G_GCLIB_UTILITY_IP_TAKEN_S "ip address is already taken by a device on the network"

» #define G_GCLIB_NON_BLOCKING_READ_EMPTY -4
GMessage, Ginterrupt, and GRecord can be called with a zero timeout. If there wasn't data waiting in memory, this
error is returned.

» #define G_GCLIB_NON_BLOCKING_READ_EMPTY_S "data was not waiting for a zero-timeout read"

» #define G_TIMEOUT -1100

Operation timed out. Timeout is set by the —timeout option in GOpen() and can be overriden by GSetting().
» #define G_TIMEOUT _S "device timed out"
» #define G_OPEN_ERROR -1101

Device could not be opened. E.G. Serial port or PCI device already open.
» #define G_OPEN_ERROR_S "device failed to open"
» #define G_READ_ERROR -1103

Device read failed. E.G. Socket was closed by remote host. See G_UTIL_GCAPS_KEEPALIVE.
» #define G_READ_ERROR_S "device read error"
» #define G_WRITE_ERROR -1104

Device write failed. E.G. Socket was closed by remote host. See G_UTIL_GCAPS_KEEPALIVE.
» #define G_WRITE_ERROR_S "device write error"
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#define G_INVALID_PREPROCESSOR_OPTIONS -1204

GProgramDownload was called with a bad preprocessor directive.
#define G_INVALID_PREPROCESSOR_OPTIONS_S "preprocessor did not recognize options”
#define G_COMMAND_CALLED_WITH_ILLEGAL_COMMAND -1106

GCommand() was called with an illegal command, e.g. ED, DL or QD.
#define G_COMMAND_CALLED_WITH_ILLEGAL_COMMAND_S "illegal command passed to command
call"
#define G_DATA_RECORD_ERROR -1107

Data record error, e.g. DR attempted on serial connection.
#define G_DATA_RECORD_ERROR_S "data record error"
#define G_UNSUPPORTED_FUNCTION -1109

Function cannot be called on this bus. E.G. GInterrupt() on serial.
#define G_UNSUPPORTED_FUNCTION_S "function not supported on this communication bus"
#define G_FIRMWARE_LOAD_NOT_SUPPORTED -1110

Firmware is not supported on this bus, e.g. Ethernet for the DMC-21x3 series.
#define G_FIRMWARE_LOAD_NOT_SUPPORTED _S "firmware cannot be loaded on this communication
bus to this hardware"
#define G_ARRAY_NOT_DIMENSIONED -1200

Array operation was called on an array that was not in the controller's array table, see LA command.
#define G_ARRAY_NOT_DIMENSIONED _S "array not dimensioned on controller or wrong size"
#define G_ILLEGAL_DATA_IN_PROGRAM -1202

Data to download not valid, e.g. \ in data.
#define G_ILLEGAL_DATA_IN_PROGRAM_S "illegal ASCII character in program"
#define G_UNABLE_TO_COMPRESS_PROGRAM_TO_FIT -1203

Program preprocessor could not compress the program within the user's constraints.
#define G_UNABLE_TO_COMPRESS_PROGRAM_TO_FIT_S "program cannot be compressed to fit on
the controller"
#define G_BAD_RESPONSE_QUESTION_MARK -10000

Operation received a ?, indicating controller has a TC error.
#define G_BAD_RESPONSE_QUESTION_MARK_S "question mark returned by controller"
#define G_BAD_VALUE_RANGE -10002

Bad value or range, e.g. GCon g variable passed to function was bad.
#define G_BAD_VALUE_RANGE_S "value passed to function was bad or out of range"
#define G_BAD_FULL_MEMORY -10003

Not enough memory for an operation, e.g. all connections allowed for a process already taken.
#define G_BAD_FULL_MEMORY_S "operation could not complete because of a memory error"
#define G_BAD_LOST_DATA -10004

Lost data, e.g. GCommand() response buffer was too small for the controller's response.
#define G_BAD_LOST_DATA_S "data was lost due to buffer or fifo limitations"
#define G_BAD_FILE -10005

Bad file path, bad file contents, or bad write.
#define G_BAD_FILE_S "file was not found, contents are invalid, or write failed"
#define G_BAD_ADDRESS -10006
Bad address.
#define G_BAD_ADDRESS_S "a bad address was specified in open”
#define G_BAD_FIRMWARE_LOAD -10008

Bad firmware upgrade.
#define G_BAD_FIRMWARE_LOAD_S "Firmware upgrade failed"
#define G_GCAPS_OPEN_ERROR -20000
gcaps connection couldn't open. Server is not running or is not reachable.
#define G_GCAPS_OPEN_ERROR_S "gcaps connection could not be opened"
#define G_GCAPS_SUBSCRIPTION_ERROR -20002

GMessage(), GRecord(), Ginterrupt() called on a connection without —subscribe switch.
#define G_GCAPS_SUBSCRIPTION_ERROR_S "function requires subscription not specified in GOpen()"
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8.3.1 Detailed Description

Defines values for the Galil C Library return codes and error strings.

8.4 gclib_record.h File Reference

Data Structures

« struct GDataRecord4000

Data record struct for DMC-4000 controllers, including 4000, 4200, 4103, and 500x0.
+ struct GDataRecord52000

Data record struct for DMC-52000 controller. Same as DMC-4000, with bank indicator added at byte 40.
« struct GDataRecord1806

Data record struct for DMC-1806 controller.
« struct GDataRecord2103

Data record struct for DMC-2103 controllers.
« struct GDataRecord1802
« struct GDataRecord30000

Data record struct for DMC-30010 controllers.
« struct GDataRecord47000_ENC

Data record struct for RIO-471xx and RIO-472xx PLCs. Includes encoder fields.
« struct GDataRecord47300_ENC

Data record struct for RIO-47300. Includes encoder fields.
« struct GDataRecord47300_24EX

Data record struct for RIO-47300 with 24EX I/O daughter board.
+ union GDataRecord

Data record union, containing all structs and a generic byte array accessor.

Macros

+ #define GALILDATARECORDMAXLENGTH 512

Max size for any Galil data record, equal to dual port ram size of PCI.

Typedefs

» typedef unsigned char UB
» typedef unsigned short UW
+ typedef short SW
 typedef int SL

» typedef unsigned int UL

8.4.1 Detailed Description

Defines a union for data records. Each supported controller has a struct member in the union with named record
types. Offsets into the data record can also be used by referencing the member byte_array.
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8.5 gclibo.c File Reference

#include
#include
#include
#include
#include

Functions

"gclibo.h"
<stdlib.h>
<string.h>
<stdio.h>
<math.h>

 void GCALL GSleep (unsigned int timeout_ms)
Uses GUItility() and G_UTIL_SLEEP to provide a blocking sleep call which can be useful for timing-based chores.
» GReturn GCALL GVersion (GCStringOut ver, GSize ver_len)
Uses GUTtility(), G_UTIL_VERSION and G_UTIL_GCAPS_VERSION to provide the library and gcaps version num-
bers.
* GReturn GCALL Ginfo (GCon g, GCStringOut info, GSize info_len)
Uses GUItility() and G_UTIL_INFO to provide a useful connection string.
» GReturn GCALL GAddresses (GCStringOut addresses, GSize addresses_len)
Uses GUItility(), G_UTIL_GCAPS_ADDRESSES or G_UTIL_ADDRESSES to provide a listing of all available connec-
tion addresses.
* GReturn GCALL GTimeout (GCon g, short timeout_ms)
Uses GUtility() and G_UTIL_TIMEOUT_OVERRIDE to set the library timeout.
* GReturn GCALL GAssign (GCStringln ip, GCStringln mac)
Uses GUItility(), G_UTIL_GCAPS_ASSIGN or G_UTIL_ASSIGN to assign an IP address over the Ethernet to a con-
troller at a given MAC address.
+ GReturn GCALL GlpRequests (GCStringOut requests, GSize requests_len)
Uses GUItility(), G_UTIL_GCAPS_IPREQUEST or G_UTIL_IPREQUEST to provide a list of all Galil controllers re-
questing IP addresses via BOOT-P or DHCP.
* GReturn GCALL GCmd (GCon g, GCStringln command)
Wrapper around GCommand for use when the return value is not desired.
* GReturn GCALL GCmdT (GCon g, GCStringin command, GCStringOut trimmed_response, GSize
response_len, GCStringOut *front)
Wrapper around GCommand that trims the response.
* GReturn GCALL GCmdI (GCon g, GCStringIn command, int xvalue)
Wrapper around GCommand that provides the return value of a command parsed into an int.
* GReturn GCALL GCmdD (GCon g, GCStringln command, double *value)
Wrapper around GCommand that provides the return value of a command parsed into a double.
* GReturn GCALL GMotionComplete (GCon g, GCStringIn axes)
Blocking call that returns once all axes specified have completed their motion.
* GReturn GCALL GRecordRate (GCon g, double period_ms)
Sets the asynchronous data record to a user-specified period via DR.
» GReturn GCALL GProgramDownloadFile (GCon g, GCStringIn file_path, GCStringln preprocessor)
Program download from file.
* GReturn GCALL GProgramUploadFile (GCon g, GCStringln file_path)
Program upload to file.
+ void GCALL GError (GReturn rc, GCStringOut error, GSize error_len)

Provides a human-readable description string for return codes.

8.5.1 Detailed Description

Partial implementation of gclibo.h
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8.5.2 Function Documentation

8.5.2.1 GAddresses()

GReturn GCALL GAddresses (
GCStringOut addresses,

GSize addresses_len )

Uses GUTtility(), G_UTIL_GCAPS_ADDRESSES or G_UTIL_ADDRESSES to provide a listing of all available con-
nection addresses.

Note
Serial ports are listed, e.g. COM1. Upon open, it may be necessary to specify a baud rate for the controller,
e.g. ——baud 19200. Default baud is 115200. See GOpen().
Parameters
addresses Buffer to hold the output string. Buffer will be null terminated, even if the data must be

truncated to do so. See below for more information.
addresses_len | Length of buffer.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

If gcaps is available, the listing will come from the server via G_UTIL_GCAPS_ADDRESSES. In the absence of the
server, gclib will use G_UTIL_ADDRESSES to generate the list.

» Ethernet controllers will be listed as ip_address, revision_report, network_adaptor_name, network_adaptor
_lp_address. If an IP address is unreachable via ping, the address will be in parentheses.

+ PCI controllers will be listed by their identifier, e.g. GALILPCI1.

« Serial ports will be listed by their identifier, e.g. COM1.

10.1.3.91, DMC4020 Rev 1.2e, LAN, 10.1.3.10
192.168.0.63, DMC4040 Rev 1.2f, Static, 192.168.0.41
(192.0.0.42), RIO47102 Rev 1.13j, Static, 192.168.0.41
GALILPCI1

COM1

COM2

Note

GAddresses() will take up to 1 second to look for gcaps.

See x_examples.cpp for an example.
Definition at line 50 of file gclibo.c.

References G_NO_ERROR, G_UTIL_ADDRESSES, G_UTIL_GCAPS_ADDRESSES, and GUtility().
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8.5.2.2 GAssign()

GReturn GCALL GAssign (
GCStringIn ip,
GCStringIn mac )

Uses GUTtility(), G_UTIL_GCAPS_ASSIGN or G_UTIL_ASSIGN to assign an IP address over the Ethernet to a
controller at a given MAC address.

Parameters

ip The null-terminated ip address to assign. The hardware should not yet have an IP address.

mac | The null-terminated MAC address of the hardware.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

On Linux and Mac, the desired IP address will be pinged prior to the assignment. If the ping is returned, GAssign()
will return G_GCLIB_UTILITY_IP_TAKEN.

If gcaps is available, the assign will be performed from the server via G_UTIL_GCAPS_ASSIGN. In the absence of
the server, gclib will use G_UTIL_ASSIGN to assign.
Attention

When not using gcaps, Linux/OS X users must be root to use GAssign() and have UDP access to send on
port 68.

Note

GAssign() will take up to 1 second to look for gcaps.

See x_examples.cpp for an example.
Definition at line 66 of file gclibo.c.

References G_GCLIB_UTILITY_IP_TAKEN, G_NO_ERROR, G_UTIL_ASSIGN, G_UTIL_GCAPS_ASSIGN, G_+
UTIL_GCAPS_PING, G_UTIL_PING, and GUTtility().

8523 GCmd()

GReturn GCALL GCmd (
GCon g,

GCStringIn command )
Wrapper around GCommand for use when the return value is not desired.

The returned data is still checked for error, e.g. ? or timeout, but is not brought out through the prototype.

Parameters

g Connection's handle.

command | Null-terminated command string to send to the controller.
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Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gcommand.cpp for an example.

Definition at line 110 of file gclibo.c.

References G_SMALL_BUFFER, and GCommand().

Referenced by GRecordRate(), H_DownloadArraysFromList(), and H_DownloadData().

8524 GCmdD()

GReturn GCALL GCmdD (
GCon g,
GCStringIn command,

double * value )
Wrapper around GCommand that provides the return value of a command parsed into a double.

Use this function to retrieve the full Galil 4.2 range, e.g. for a variable value with fractional data, or the value of an
Analog input or Output.

Parameters
g Connection's handle.
command | Null-terminated command string to send to the controller.
value Pointer to a double that will be filled with the return value.
Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gcommand.cpp for an example.

Definition at line 162 of file gclibo.c.

References G_NO_ERROR, G_SMALL_BUFFER, and GCommand().
Referenced by GRecordRate().

8525 GCmdi()

GReturn GCALL GCmdI (
GCon g,
GCStringIn command,

int * value )
Wrapper around GCommand that provides the return value of a command parsed into an int.

Use this function to get most values including TP, RP, TE, Digital I/O states, etc.

Parameters

g Connection's handle.

command | Null-terminated command string to send to the controller.

value Pointer to an int that will be filled with the return value.
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Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gcommand.cpp for an example.
Definition at line 151 of file gclibo.c.

References G_NO_ERROR, G_SMALL_BUFFER, and GCommand().

8526 GCmdT()

GReturn GCALL GCmdT (
GCon g,
GCStringIn command,
GCStringOut trimmed_response,
GSize response_len,
GCStringOut #* front )

Wrapper around GCommand that trims the response.

For use when the return value is desired, is ASCII (not binary), and the response should be trimmed of trailing colon,
whitespace, and optionally leading space.

Parameters
g Connection's handle.
command Null-terminated command string to send to the controller.

trimmed_response | The trimmed response from the controller. Trailing space is trimmed by null terminating
any trailing spaces, carriage returns, or line feeds.

response_len The length of the trimmed_response buffer.

front If non-null, upon return xfront will point to the first non-space character in
trimmed_response. This allows trimming the front of the string without modifying the
user's buffer pointer, which may be allocated on the heap.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gcommand.cpp for an example.

Definition at line 116 of file gclibo.c.

References G_NO_ERROR, and GCommand().
Referenced by GArrayUploadFile(), and GRecordRate().

8.5.2.7 GError()

void GCALL GError (
GReturn rc,
GCStringOut error,

GSize error_len )

Provides a human-readable description string for return codes.
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Parameters
rc The return code to lookup.
error The buffer to fill with the error text. Buffer will be null terminated, even if the data must be truncated

to do so.
error_len | The length of the error buffer.

See x_examples.cpp for an example.
Definition at line 316 of file gclibo.c.

References G_NO_ERROR.

8.5.2.8 Glnfo()

GReturn GCALL GInfo (
GCon g,
GCStringOut info,

GSize info len )

Uses GUILtility() and G_UTIL_INFO to provide a useful connection string.

Parameters
g Connection's handle.
info Buffer to hold the output string. Buffer will be null terminated, even if the data must be truncated to

do so.
info_len | Length of buffer.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

The response is address, revision_report, serial_number. For example:

COM2, RIO47102 Rev 1.13, 37290

See x_examples.cpp for an example.
Definition at line 45 of file gclibo.c.

References G_UTIL_INFO, and GUTtility().

8.5.2.9 GlpRequests()

GReturn GCALL GIpRequests (
GCStringOut requests,

GSize requests_len )

Uses GUItility(), G_UTIL_GCAPS_IPREQUEST or G_UTIL_IPREQUEST to provide a list of all Galil controllers
requesting IP addresses via BOOT-P or DHCP.

Parameters

requests The buffer to hold the list of requesting controllers. Data will be null terminated, even if the data
must be truncated to do so. See below for more information.

r,eczuests_len The Tength of the requests buffer.
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Returns

The success status or error code of the function. See gclib_errors.h for possible values.

GlpRequests() will block about 5 seconds while listening for requests.
If gcaps is available, the listing will come from the server via G_UTIL_GCAPS_IPREQUEST. In the absence of the
server, gclib will use G_UTIL_IPREQUEST to generate the list.
Attention
When not using gcaps, Linux/OS X users must be root to use GlpRequests() and have UDP access to bind

and listen on port 67.

Each line of the returned data will be of the form model, serial_ number, MAC_address, network_adaptor_name,
network_adaptor_ip_address. For example:

DpMC4000, 291, 00:50:4C:20:01:23, LAN, 10.1.3.10
RIO47000, 37290, 00:50:4C:28:91:AA, Static, 192.168.0.41

Note

GlpRequests() will take up to 1 second to look for gcaps.

See x_examples.cpp for an example.
Definition at line 99 of file gclibo.c.

References G_NO_ERROR, G_UTIL_GCAPS_IPREQUEST, G_UTIL_IPREQUEST, and GUHtility().

8.5.2.10 GMotionComplete()

GReturn GCALL GMotionComplete (
GCon g,
GCStringIn axes )

Blocking call that returns once all axes specified have completed their motion.

Note

This function uses a profiled motion indicator, not the position of the encoder. E.G. see the difference between
AM (profiled) and MC (encoder-based).

Although using the _BGm operand is the most generally compatible method, there are higher-performance ways
to check for motion complete by using the data record, or interrupts. See examples x_dr_motioncomplete() and
x_ei_motioncomplete().

Parameters

g Connection's handle.

axes | A null-terminated string containing a multiple-axes mask. Every character in the string should be a valid
argument to MG_BGm, i.e. XYZWABCDEFGHST.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gmotioncomplete.cpp for an example.
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Definition at line 173 of file gclibo.c.

References G_NO_ERROR, G_SMALL_BUFFER, GCommand(), GSleep(), and POLLINGINTERVAL.

8.5.2.11 GProgramDownloadFile()

GReturn GCALL GProgramDownloadFile (
GCon g,
GCStringlIn file path,

GCStringIn preprocessor )

Program download from file.

Parameters
g Connection's handle.
file_path Null-terminated string containing the path to the program file.

preprocessor | Options string for preprocessing the program before sending it to the controller. See
GProgramDownload().

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_programs.cpp for an example.
Definition at line 244 of file gclibo.c.

References G_BAD_FILE, G_BAD_FULL_MEMORY, G_NO_ERROR, and GProgramDownload().

8.5.2.12 GProgramUploadFile()

GReturn GCALL GProgramUploadFile (
GCon g,
GCStringIn file path )

Program upload to file.

Parameters

g Connection's handle.

file_path | Null-terminated string containing the path to the program file, file will be overwritten if it exists.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_programs.cpp for an example.

Definition at line 287 of file gclibo.c.

References G_BAD_FILE, G_BAD_FULL_MEMORY, G_NO_ERROR, GProgramUpload(), and MAXPROG.
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8.5.2.13 GRecordRate()

GReturn GCALL GRecordRate (
GCon g,

double period_ms )
Sets the asynchronous data record to a user-specified period via DR.

Takes TM and product type into account and sets the DR period to the period requested by the user, if possible.

Parameters

g Connection's handle.

period_ms | Period, in milliseconds, to set up for the asynchronous data record.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_grecord.cpp for an example.
Definition at line 199 of file gclibo.c.

References G_NO_ERROR, G_SMALL_BUFFER, GCmd(), GCmdD(), and GCmdT().

8.5.2.14 GSleep()

void GCALL GSleep (

unsigned int timeout_ms )

Uses GUItility() and G_UTIL_SLEEP to provide a blocking sleep call which can be useful for timing-based chores.

Parameters

timeout_ms ‘ The timeout, in milliseconds, to block before returning.

See GMotionComplete() for an example.
Definition at line 20 of file gclibo.c.
References G_UTIL_SLEEP, and GUtility().
Referenced by GMotionComplete().

8.5.2.15 GTimeout()

GReturn GCALL GTimeout (
GCon g,

short timeout_ms )

Uses GULtility() and G_UTIL_TIMEOUT_OVERRIDE to set the library timeout.

Parameters

g Connection's handle.

timeout_ms | The value to be used for the timeout. Use G_USE_INITIAL_TIMEOUT to set the timeout
back to the initial GOpen() value, ——t imeout.
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Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gcommand.cpp and x_gread_gwrite.cpp for examples.
Definition at line 61 of file gclibo.c.

References G_UTIL_TIMEOUT_OVERRIDE, and GUTtility().

8.5.2.16 GVersion()

GReturn GCALL GVersion (
GCStringOut ver,

GSize ver_len )

Uses GUItility(), G_UTIL_VERSION and G_UTIL_GCAPS_VERSION to provide the library and gcaps version num-
bers.

Parameters

ver Buffer to hold the output string. Buffer will be null terminated, even if the data must be truncated to do
S0.

ver_len | Length of buffer.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

The version number of gclib is provided first. If the gcaps server can be found, its version will be provided after a
space.

Example with gcaps version.

154.190.329 1.0.0.82

Example with gclib version only.

154.190.329

Note

GVersion() will take up to 1 second to look for gcaps.

See x_examples.cpp for an example.
Definition at line 25 of file gclibo.c.

References G_NO_ERROR, G_UTIL_GCAPS_VERSION, G_UTIL_VERSION, and GUtility().

8.6 gclibo.h File Reference

#include "gclib.h"
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Macros

- #define GCLIB_DLL_EXPORTED
+ #define GCALL __stdcall
« #define MALLOCBUF G_HUGE_BUFFER

Malloc used for large program and array uploads.
» #define MAXPROG MALLOCBUF

Maximum size for a program.
» #define MAXARRAY MALLOCBUF

Maximum size for an array table upload.
+ #define POLLINGINTERVAL 100

Interval, in milliseconds, for polling commands, e.g. GMotionComplete().
« #define G_USE_GCAPS

Use the GCAPS server in GAddresses(), GAssign(), GlpRequests(), and GVersion(). To avoid GCAPS, comment out
this line and recompile, ht tp://galil.com/sw/pub/all/doc/gclib/html/gclibo.html.

Functions

+ GCLIB_DLL_EXPORTED void GCALL GSleep (unsigned int timeout_ms)

Uses GUtility() and G_UTIL_SLEEP to provide a blocking sleep call which can be useful for timing-based chores.

+ GCLIB_DLL_EXPORTED GReturn GCALL GVersion (GCStringOut ver, GSize ver_len)

Uses GUItility(), G_UTIL_VERSION and G_UTIL_GCAPS_VERSION to provide the library and gcaps version num-
bers.

» GCLIB_DLL_EXPORTED GReturn GCALL GAddresses (GCStringOut addresses, GSize addresses_len)
Uses GUtility(), G_UTIL_GCAPS_ADDRESSES or G_UTIL_ADDRESSES to provide a listing of all available connec-
tion addresses.

* GCLIB_DLL_EXPORTED GReturn GCALL Ginfo (GCon g, GCStringOut info, GSize info_len)

Uses GUItility() and G_UTIL_INFO to provide a useful connection string.

* GCLIB_DLL_EXPORTED GReturn GCALL GTimeout (GCon g, short timeout_ms)
Uses GUtility() and G_UTIL_TIMEOUT_OVERRIDE to set the library timeout.

+ GCLIB_DLL_EXPORTED GReturn GCALL GCmd (GCon g, GCStringln command)
Wrapper around GCommand for use when the return value is not desired.

* GCLIB_DLL_EXPORTED GReturn GCALL GCmdT (GCon g, GCStringln command, GCStringOut trimmed«
_response, GSize response_len, GCStringOut *front)

Wrapper around GCommand that trims the response.
* GCLIB_DLL_EXPORTED GReturn GCALL GCmdI (GCon g, GCStringln command, int xvalue)

Wrapper around GCommand that provides the return value of a command parsed into an int.

* GCLIB_DLL_EXPORTED GReturn GCALL GCmdD (GCon g, GCStringln command, double xvalue)
Wrapper around GCommand that provides the return value of a command parsed into a double.

+ GCLIB_DLL_EXPORTED GReturn GCALL GMotionComplete (GCon g, GCStringIn axes)

Blocking call that returns once all axes specified have completed their motion.
* GCLIB_DLL_EXPORTED GReturn GCALL GRecordRate (GCon g, double period_ms)

Sets the asynchronous data record to a user-specified period via DR.
+ GCLIB_DLL_EXPORTED GReturn GCALL GProgramDownloadFile (GCon g, GCStringIn file_path,
GCStringln preprocessor)
Program download from file.
+ GCLIB_DLL_EXPORTED GReturn GCALL GProgramUploadFile (GCon g, GCStringlIn file_path)
Program upload to file.
+ GCLIB_DLL_EXPORTED GReturn GCALL GArrayDownloadFile (GCon g, GCStringin file_path)
Array download from file.

+ GCLIB_DLL_EXPORTED GReturn GCALL GArrayUploadFile (GCon g, GCStringln file_path, GCStringln
names)
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Array upload to file.

GCLIB_DLL_EXPORTED GReturn GCALL GlpRequests (GCStringOut requests, GSize requests_len)
Uses GUtility(), G_UTIL_GCAPS_IPREQUEST or G_UTIL_IPREQUEST to provide a list of all Galil controllers re-
questing IP addresses via BOOT-P or DHCP.

GCLIB_DLL_EXPORTED GReturn GCALL GAssign (GCStringln ip, GCStringln mac)
Uses GUItility(), G_UTIL_GCAPS_ASSIGN or G_UTIL_ASSIGN to assign an IP address over the Ethernet to a con-
troller at a given MAC address.

GCLIB_DLL_EXPORTED void GCALL GError (GReturn rc, GCStringOut error, GSize error_len)

Provides a human-readable description string for return codes.
GCLIB_DLL_EXPORTED GReturn GCALL GSetupDownloadFile (GCon g, GCStringln file_path, GOption
options, GCStringOut info, GSize info_len)

Download a saved controller configuration from a file.

8.6.1 Detailed Description

Open-source convenience functions for Galil C Lib. Please email softwarefeedback@galil. com with sug-
gestions for useful/missing functions.

8.6.2 Function Documentation

8.6.2.1 GAddresses()

GCLIB_DLL_EXPORTED GReturn GCALL GAddresses (
GCStringOut addresses,

GSize addresses_len )

Uses GUTtility(), G_UTIL_GCAPS_ADDRESSES or G_UTIL_ADDRESSES to provide a listing of all available con-
nection addresses.

Note
Serial ports are listed, e.g. COM1. Upon open, it may be necessary to specify a baud rate for the controller,
e.g. ——baud 19200. Default baud is 115200. See GOpen().
Parameters
addresses Buffer to hold the output string. Buffer will be null terminated, even if the data must be

truncated to do so. See below for more information.
addresses_len | Length of buffer.

Returns
The success status or error code of the function. See gclib_errors.h for possible values.

If gcaps is available, the listing will come from the server via G_UTIL_GCAPS_ADDRESSES. In the absence of the
server, gclib will use G_UTIL_ADDRESSES to generate the list.

 Ethernet controllers will be listed as ip_address, revision_report, network_adaptor_name, network_adaptor
_lp_address. If an IP address is unreachable via ping, the address will be in parentheses.
+ PCI controllers will be listed by their identifier, e.g. GALILPCI1.

« Serial ports will be listed by their identifier, e.g. COM1.
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10.1.3.91, DMC4020 Rev 1.2e, LAN, 10.1.3.10
192.168.0.63, DMC4040 Rev 1.2f, Static, 192.168.0.41
(192.0.0.42), RIO47102 Rev 1.13, Static, 192.168.0.41
GALILPCI1

coM1

coM2

Note

GAddresses() will take up to 1 second to look for gcaps.

See x_examples.cpp for an example.
Definition at line 50 of file gclibo.c.

References G_NO_ERROR, G_UTIL_ADDRESSES, G_UTIL_GCAPS_ADDRESSES, and GUItility().

8.6.2.2 GArrayDownloadFile()

GCLIB_DLL_EXPORTED GReturn GCALL GArrayDownloadFile (
GCon g,
GCStringIn file path )

Array download from file.

Downloads a csv file containing array data at £ile_path. If the arrays don't exist, they will be dimensioned.

Parameters

g Connection's handle.

file_path | Null-terminated string containing the path to the array file.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_arrays.cpp for an example.
Definition at line 370 of file arrays.c.

References G_BAD_FILE, G_NO_ERROR, and H_ArrayDownloadFromMemory().

8.6.2.3 GArrayUploadFile()

GCLIB_DLL_EXPORTED GReturn GCALL GArrayUploadFile (
GCon g,
GCStringIn file path,

GCStringIn names )
Array upload to file.

Uploads the entire controller array table or a subset and saves the data as a csv file specified by file_path.

Parameters

g Connection's handle.

file_path | Null-terminated string containing the path to the array file, file will be overwritten if it exists.
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Parameters

names Null-terminated string containing the arrays to upload, delimited with space.
arrays listed in LA.

or null uploads all

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_arrays.cpp for an example.
Definition at line 398 of file arrays.c.

References G_NO_ERROR, GCmdT(), H_FreeArrays(), H_InitArrayNode(), H_UploadArrayToList(), and H_Write«
ArrayCsv().

8.6.2.4 GAssign()

GCLIB_DLL_EXPORTED GReturn GCALL GAssign (
GCStringIn ip,
GCStringIn mac )

Uses GULtility(), G_UTIL_GCAPS_ASSIGN or G_UTIL_ASSIGN to assign an IP address over the Ethernet to a
controller at a given MAC address.

Parameters

ip The null-terminated ip address to assign. The hardware should not yet have an IP address.

mac | The null-terminated MAC address of the hardware.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

On Linux and Mac, the desired IP address will be pinged prior to the assignment. If the ping is returned, GAssign()
will return G_GCLIB_UTILITY_IP_TAKEN.

If gcaps is available, the assign will be performed from the server via G_UTIL_GCAPS_ASSIGN. In the absence of
the server, gclib will use G_UTIL_ASSIGN to assign.

Attention

When not using gcaps, Linux/OS X users must be root to use GAssign() and have UDP access to send on
port 68.

Note

GAssign() will take up to 1 second to look for gcaps.

See x_examples.cpp for an example.
Definition at line 66 of file gclibo.c.

References G_GCLIB_UTILITY_IP_TAKEN, G_NO_ERROR, G_UTIL_ASSIGN, G_UTIL_GCAPS_ASSIGN, G_+«
UTIL_GCAPS_PING, G_UTIL_PING, and GUTtility().
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8625 GCmd()

GCLIB_DLL_EXPORTED GReturn GCALL GCmd (
GCon g,

GCStringIn command )
Wrapper around GCommand for use when the return value is not desired.

The returned data is still checked for error, e.g. ? or timeout, but is not brought out through the prototype.

Parameters

g Connection's handle.

command | Null-terminated command string to send to the controller.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gcommand.cpp for an example.

Definition at line 110 of file gclibo.c.

References G_SMALL_BUFFER, and GCommand().

Referenced by GRecordRate(), H_DownloadArraysFromList(), and H_DownloadData().

8626 GCmdD()

GCLIB_DLL_EXPORTED GReturn GCALL GCmdD (
GCon g,
GCStringIn command,

double * value )
Wrapper around GCommand that provides the return value of a command parsed into a double.

Use this function to retrieve the full Galil 4.2 range, e.g. for a variable value with fractional data, or the value of an
Analog input or Output.

Parameters
g Connection's handle.
command | Null-terminated command string to send to the controller.
value Pointer to a double that will be filled with the return value.
Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gcommand.cpp for an example.

Definition at line 162 of file gclibo.c.

References G_NO_ERROR, G_SMALL_BUFFER, and GCommand().
Referenced by GRecordRate().
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8.6.2.7 GCmdl()

GCLIB_DLL_EXPORTED GReturn GCALL GCmdI (
GCon g,
GCStringIn command,

int * value )
Wrapper around GCommand that provides the return value of a command parsed into an int.

Use this function to get most values including TP, RP, TE, Digital I/O states, etc.

Parameters
g Connection's handle.
command | Null-terminated command string to send to the controller.
value Pointer to an int that will be filled with the return value.
Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gcommand.cpp for an example.
Definition at line 151 of file gclibo.c.

References G_NO_ERROR, G_SMALL_BUFFER, and GCommand().

8.6.2.8 GCmdT()

GCLIB_DLL_EXPORTED GReturn GCALL GCmdT (
GCon g,
GCStringIn command,
GCStringOut trimmed_response,
GSize response_len,
GCStringOut * front )

Wrapper around GCommand that trims the response.

For use when the return value is desired, is ASCII (not binary), and the response should be trimmed of trailing colon,

whitespace, and optionally leading space.

Parameters
g Connection's handle.
command Null-terminated command string to send to the controller.

any trailing spaces, carriage returns, or line feeds.

trimmed_response | The trimmed response from the controller. Trailing space is trimmed by null terminating

response_len The length of the trimmed_response buffer.

user's buffer pointer, which may be allocated on the heap.

front If non-null, upon return *front will point to the first non-space character in
trimmed_response. This allows trimming the front of the string without modifying the
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Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gcommand.cpp for an example.

Definition at line 116 of file gclibo.c.

References G_NO_ERROR, and GCommand().
Referenced by GArrayUploadFile(), and GRecordRate().

8.6.2.9 GError()

GCLIB_DLL_EXPORTED void GCALL GError (
GReturn rc,
GCStringOut error,

GSize error_len )

Provides a human-readable description string for return codes.

Parameters
rc The return code to lookup.
error The buffer to fill with the error text. Buffer will be null terminated, even if the data must be truncated

to do so.
error_len | The length of the error buffer.

See x_examples.cpp for an example.
Definition at line 316 of file gclibo.c.

References G_NO_ERROR.

8.6.2.10 Glnfo()

GCLIB_DLL_EXPORTED GReturn GCALL GInfo (
GCon g,
GCStringOut info,

GSize info len )

Uses GUItility() and G_UTIL_INFO to provide a useful connection string.

Parameters
g Connection's handle.
info Buffer to hold the output string. Buffer will be null terminated, even if the data must be truncated to

do so.
info_len | Length of buffer.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.
The response is address, revision_report, serial_number. For example:

COM2, RIO47102 Rev 1.13, 37290
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See x_examples.cpp for an example.
Definition at line 45 of file gclibo.c.

References G_UTIL_INFO, and GUHtility().

8.6.2.11 GlpRequests()

GCLIB_DLL_EXPORTED GReturn GCALL GIpRequests (
GCStringOut requests,

GSize requests_len )

Uses GUItility(), G_UTIL_GCAPS_IPREQUEST or G_UTIL_IPREQUEST to provide a list of all Galil controllers
requesting IP addresses via BOOT-P or DHCP.

Parameters

requests The buffer to hold the list of requesting controllers. Data will be null terminated, even if the data
must be truncated to do so. See below for more information.
requests_len | The length of the requests buffer.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

GlpRequests() will block about 5 seconds while listening for requests.
If gcaps is available, the listing will come from the server via G_UTIL_GCAPS_IPREQUEST. In the absence of the
server, gclib will use G_UTIL_IPREQUEST to generate the list.
Attention
When not using gcaps, Linux/OS X users must be root to use GlpRequests() and have UDP access to bind

and listen on port 67.

Each line of the returned data will be of the form model, serial_ number, MAC_address, network_adaptor_name,
network_adaptor_ip_address. For example:

DMC4000, 291, 00:50:4C:20:01:23, LAN, 10.1.3.10
RI047000, 37290, 00:50:4C:28:91:AA, Static, 192.168.0.41

Note

GlpRequests() will take up to 1 second to look for gcaps.

See x_examples.cpp for an example.
Definition at line 99 of file gclibo.c.

References G_NO_ERROR, G_UTIL_GCAPS_IPREQUEST, G_UTIL_IPREQUEST, and GUHtility().

8.6.2.12 GMotionComplete()

GCLIB_DLL_EXPORTED GReturn GCALL GMotionComplete (
GCon g,
GCStringIn axes )

Blocking call that returns once all axes specified have completed their motion.
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Note

This function uses a profiled motion indicator, not the position of the encoder. E.G. see the difference between

AM (profiled) and MC (encoder-based).

Although using the _BGm operand is the most generally compatible method, there are higher-performance ways
to check for motion complete by using the data record, or interrupts. See examples x_dr_motioncomplete() and

X_ei_motioncomplete().

Parameters

g Connection's handle.

argument to MG_BGm, i.e. XYZWABCDEFGHST.

axes | A null-terminated string containing a multiple-axes mask. Every character in the string should be a valid

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gmotioncomplete.cpp for an example.

Definition at line 173 of file gclibo.c.

References G_NO_ERROR, G_SMALL_BUFFER, GCommand(), GSleep(), and POLLINGINTERVAL.

8.6.2.13 GProgramDownloadFile()

GCLIB_DLL_EXPORTED GReturn GCALL GProgramDownloadFile (
GCon g,
GCStringIn file path,

GCStringIn preprocessor )

Program download from file.

Parameters
g Connection's handle.
file_path Null-terminated string containing the path to the program file.

preprocessor | Options string for preprocessing the program before sending it to the controller. See
GProgramDownload().

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_programs.cpp for an example.
Definition at line 244 of file gclibo.c.

References G_BAD_FILE, G_BAD_FULL_MEMORY, G_NO_ERROR, and GProgramDownload().

8.6.2.14 GProgramUploadFile()

GCLIB_DLL_EXPORTED GReturn GCALL GProgramUploadFile (
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GCon g,
GCStringIn file path )

Program upload to file.

Parameters

g Connection's handle.

file_path | Null-terminated string containing the path to the program file, file will be overwritten if it exists.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_programs.cpp for an example.
Definition at line 287 of file gclibo.c.

References G_BAD_FILE, G_BAD_FULL_MEMORY, G_NO_ERROR, GProgramUpload(), and MAXPROG.

8.6.2.15 GRecordRate()

GCLIB_DLL_EXPORTED GReturn GCALL GRecordRate (
GCon g,

double period_ms )
Sets the asynchronous data record to a user-specified period via DR.

Takes TM and product type into account and sets the DR period to the period requested by the user, if possible.

Parameters

g Connection's handle.

period_ms | Period, in milliseconds, to set up for the asynchronous data record.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_grecord.cpp for an example.
Definition at line 199 of file gclibo.c.

References G_NO_ERROR, G_SMALL_BUFFER, GCmd(), GCmdD(), and GCmdT().

8.6.2.16 GSetupDownloadFile()

GCLIB_DLL_EXPORTED GReturn GCALL GSetupDownloadFile (
GCon g,
GCStringIn file path,
GOption options,
GCStringOut info,

GSize info len )

Download a saved controller configuration from a file.
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Parameters

g Connection's handle.

file_path | Null-terminated string containing the path to the program file.

options Bit mask to determine what configuration data to download. See below for all options.

info Optional pointer to a buffer to store the controller info. If no info is needed, specify as NULL.

info_len | Length of optional info buffer. If no info is needed, specify as NULL.

Returns

The success status or error code of the function. If the options parameter is set to 0, the return value will
be a bit mask indicating which sectors in the specified GCB are not empty. Otherwise, see gclib_errors.h for
possible error values.

Note

By default, GSetupDownloadFile() will stop immediately if an error is encountered downloading data. This
can be overridden in the options parameter. An example of when you might override this setting: You have a
backup from an 8-axis controller and want to restore the parameters for the first 4 axes to a 4-axis controller.

If both info and info_len are not NULL, the controller information will be provided regardless of the options parameter.

The options parameter is a bit mask. If options is set to 0, GSetupDownloadFile() will return a bit mask indicating
which sectors in the specified GCB are not empty. The following contains a list of all currently available options:

Bit | Value Function Description

1 0x0002 | Restore parameters | KPA, KIA, KDA, etc...

3 0x0008 | Restore variables Variables are listed by the LV command

4 0x0010 | Restore arrays Arrays are listed by the LA command

5 0x0020 | Restore program The program is listed by the LS command

31 0x8000 | Ignore errors Ignore invalid parameter errors and continue restoring data.
GSetupDownloadFile() will still stop immediately if a connection issue
or other fatal error is encountered

Usage example:

GCon g;
GOption opt = 0;

GCStringOut info;
GSize info_len = 4096;

GReturn rc = GOpen("192.168.0.50", &9g);
it (rc) retu rc;

// Call GSetupDownloadFile() with options set to 0 so we can get the non-empty sector bit mask
opt = GSetupDownloadFile(g, "C:\\path\\to\\gcb\\file.gcb", 0, NULL, NULL);

info = (GCStringOut)malloc (sizeof (GCStringOut) = info_len);

// Call GSetupDownloadFile() with the bit mask returned in the previous function call
rc = GSetupDownloadFile (g, "C:\\path\\to\\gcb\\file.gcb", opt, info, info_len);

printf("Info:\n\n%s", info);
GClose (g);

free(info);

return rc;

Definition at line 465 of file arrays.c.
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References G_BAD_FILE, G_NO_ERROR, GProgramDownload(), H_ArrayDownloadFromMemory(), H_«
DownloadData(), and H_FindSector().

8.6.2.17 GSleep()

GCLIB_DLL_EXPORTED void GCALL GSleep (

unsigned int timeout_ms )

Uses GUItility() and G_UTIL_SLEEP to provide a blocking sleep call which can be useful for timing-based chores.

Parameters

timeout_ms ‘ The timeout, in milliseconds, to block before returning.

See GMotionComplete() for an example.
Definition at line 20 of file gclibo.c.
References G_UTIL_SLEEP, and GUTtility().
Referenced by GMotionComplete().

8.6.2.18 GTimeout()

GCLIB_DLL_EXPORTED GReturn GCALL GTimeout (
GCon g,

short timeout_ms )

Uses GUILtility() and G_UTIL_TIMEOUT_OVERRIDE to set the library timeout.

Parameters

g Connection's handle.

timeout_ms | The value to be used for the timeout. Use G_USE_INITIAL_TIMEOUT to set the timeout
back to the initial GOpen() value, ——t imeout.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

See x_gcommand.cpp and x_gread_gwrite.cpp for examples.
Definition at line 61 of file gclibo.c.

References G_UTIL_TIMEOUT_OVERRIDE, and GUHtility().

8.6.2.19 GVersion()

GCLIB_DLL_EXPORTED GReturn GCALL GVersion (
GCStringOut ver,

GSize ver_len )

Uses GUItility(), G_UTIL_VERSION and G_UTIL_GCAPS_VERSION to provide the library and gcaps version num-
bers.
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Parameters

ver Buffer to hold the output string. Buffer will be null terminated, even if the data must be truncated to do
S0.
ver_len | Length of buffer.

Returns

The success status or error code of the function. See gclib_errors.h for possible values.

The version number of gclib is provided first. If the gcaps server can be found, its version will be provided after a
space.

Example with gcaps version.
154.190.329 1.0.0.82
Example with gclib version only.

154.190.329

Note

GVersion() will take up to 1 second to look for gcaps.

See x_examples.cpp for an example.
Definition at line 25 of file gclibo.c.

References G_NO_ERROR, G_UTIL_GCAPS_VERSION, G_UTIL_VERSION, and GUItility().
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